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Chapter 1 – Application Setup 
 

General Setups 
 

Category Group 
The category group is used to group similar cost categories, such as employee hours, materials 

and travel expenses. It is also used to setup accounts used when posting to general ledger. 
Where Used: Category Group is a field on the job category. 

 

To navigate to the Category Group Setup:  

Setup & Extensions→Manual Setup→Category Group 

 

 

 
 

Name: Name the category group. 

Description: Description of the category group. 

Valid for: Restricts your choices on the screens related to your selection. 

Options are: 
Labor: Allows postings to time entry. 

Expense: Allows postings to expense reports, purchase orders, and purchase invoices. 

Burden: Allows postings to indirect costs during allocation. 

Fee: Allows postings to sales orders and sales invoices. 

Cost Account: Identify the g/l account that the cost for this group should post to. 

Revenue Account: Identify the g/l account that the revenue for this group should post to. 
Where Used: This is used during invoice posting. 

Accrued Revenue: Identify the g/l account that is credited when recognizing revenue. 
Note: During the invoice posting process, the revenue accrued is reversed. 
WIP Sales Value: Identify the g/l account that is debited when recognizing revenue. 
Note: See job posting for more information on how the above g/l accounts post from jobs to general ledger 
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Category Group Resource Class 
The category group resource class setup table is used in conjunction with the category group and 

allows the user to override the g/l account based on a category group and the class code on a 

resource. This feature may be used to map resources to a client site g/l account or to cover 

scenarios where it is necessary to map resources to different labor accounts based on full, part-

time, or consultant and sub-contractor classification. The setup also allows you to map different 

g/l accounts based on pay type.  
Where Used: This is used when posting labor using the time journal, or subcontract labor using a purchase order. 

 

To navigate to the Category Group Setup:  

Setup & Extensions→Manual Setup→Category Group→Resource Class 

 

 

 
 

 

 
 

Resource Class Name: Identify the resource class that you are setting up.  

Pay Type: Identify the pay type that you are setting up.  

Cost Account: Identify the g/l account to use for the category group, resource class, and pay type 

selected. 
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Job Category  

The job category setup gives the user the ability to categorize costs across all cost elements by 

creating a job category and assigning a g/l account to it for the purpose of posting costs to the 

general ledger. Job categories without a g/l account will use the g/l account on the category 

group. This allows for scenarios where you may want to track and categorize job costs at a more 

granular level and yet let these costs post to one g/l account. 

 

Navigate to the Job Category List:  

Setup & Extensions→Manual Setup→Job Category 

 

 

 
 

Name: Identifies a category group using a unique name.  This is a required field.   
Where Used: Used when you post labor transactions to identify the cost account. 
Description: A short description of the job category.  
Where Used: The description appears in the resource journal, the Time Journal, or the sales lines. 
Category Group: Job categories are assigned to a category group.  (Ex. Category group “travel” 

with “lodging” and “mileage” as job categories. 

Valid for: This field defaults from the category group and cannot be changed. Restricts your 

choices on the screens related to your selection. 

Options are: 
Labor: Allows postings to time entry. 

Expense: Allows postings to expense reports, purchase orders, and purchase invoices. 

Burden: Allows postings to indirect costs during allocation. 

Fee: Allows postings to sales orders and sales invoices. 

Cost Account: Assign the g/l account used to post costs to the general ledger.  

Revenue Account: Assign the g/l account used to post revenue to the general ledger. 

Accrued Revenue: Assign the g/l account used to post accrued revenue to the general ledger. 

WIP Sales Value: Assign the g/l account used to post WIP Sales Value to the general ledger. 
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Click Edit in the ribbon to open the Job Category Card.  All fields setup on the Job Category list 

page will be prefilled when the job category card is opened.  
Note: The Job category g/l account may be left blank. The g/l account on the category group will be used instead. This 

allows for scenarios where you may want to track costs using job categorize job that post to the same g/l account. A 

typical example where this is desirable is labor categories. 

Note: See job posting for more information on how the above g/l accounts post from jobs to general ledger 

 

 

 
 

Expense Cost: This table is used to set up the unit costs for expense job categories.   

Highlight an expense job category and select Expense Cost in the ribbon of the job category list. 

 

This will open the Expense Category Cost Setup page. 

 

 

 
 

Starting Date: Identify the date that the unit cost will be effective for the job category. 

Unit Cost: Identify the Unit Cost amount. 

Government Contractor Setup 

The government Contractor Parameters setup is used to identify categories for fees, categorize 

jobs used for benefits tracking, global dimensions, and other overall setups that drive system 
behavior. 

 

To Navigate to GC Parameters:  

Setup & Extensions→Manual Setup →Government Contractor Setup→Government Contractor 

Parameters 
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General Tab 

Allocation Nos: The number series used for the document number for the allocation routine. 

Fee Category: Identify the job category for standard fees. 

Award Fee Category: Identify the job category for award fees. 

Incentive Fee Category: Identify the job category for incentive fees. 

Wages Payable Account No: Identify the g/l account that should be used for wages payable. 

Post to Wages Payable in Detail: If selected, the time journal posting will not be summarized.  

Withholding Account No: The G/L account used to track withholding. 

In Excess Category Name: The job category that will be used to track amounts in excess of 

funding limits. 

Un-Allowable Category Name: The job category that will be used to track unallowable costs.  

Booking unallowable costs to this category will prevent Job Planning Lines from being created. 

Override Blocked Jobs for User: This feature allows the allocation routine to allocate costs 

even if the job has been blocked for posting. 

Override Expiration Date: Set the expiration date for the blocked job override. 

 

Purchasing Tab 

Expense Report Advance Account No: The ledger account used when creating purchase orders 

from expense reports. 

P.O. Modification Tracking: If selected, the system will automatically archive PO’s in order to 

maintain a history of changes. 

Use Pay When Paid: When running the suggest vendor payment function in the payment journal 

the system will use this field to verify if payment from the customer has been received before 

suggesting the voucher for payment. 

Pay When Paid Pmt. Method: Identify the payment method code that should be assigned to the 

vendor card if the vendor should only be paid upon customer payment.  
Note: If the purchase order is created prior to the pay when paid payment method code is assigned to the vendor card 

the purchase order will not be processed as pay when paid. 

Delete Purchase Orders: If selected, purchase orders are removed once received and invoiced. 

Company Paid Reconcile Account: This ledger account is credited when a charge on an 

expense report is marked as company paid. 
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Timesheet Tab 
Timesheet Period Name: Identify the default timesheet period. 

Compensated Time Used: Identify the job that you will use to update with used comp time. 

Compensated Time Earned: Identify the job that you will use to accrue comp time. 

Un-Compensated Time:  Identify the job that will accrue the hours above the normal hours per 

pay period and the Comp Time Accrual At project setup selection. 
Where Used: These setups are used in the Calculate Comp Time function on the Time Journal. 

Rounding: Identify the job that you will use to accrue rounding entries. 

Cost Dimension Priority: The cost dimension on a transaction is determined by this setup. 

Options are: 
Job  

Resource 

 

Cost Pool Tab 

The system uses the following dimension codes to track costs attributable to a department, job, 

and task.  This allows the allocation routine to correctly compute the burdens allocated. 

Cost Dimension Code: Identifies the dimension used to track cost.  This is typically the 

department dimension. 

Job Dimension Code: Identifies the dimension used to track job costs in the general ledger.   

Task Dimension Code: Identifies the dimension used to track job task costs in the general 

ledger. 
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Report Layout 
 

The report layout page provides the user with the ability to create and save custom reports.  

 

To navigate to Report Layout: Setup & Extensions→Manual Setup→Report Layout Selection 

 

Name and provide a short description of your report on the report layout list page. 

 

 

 
 

While the report line is selected on the report layout list page select Edit Layout in the ribbon to 

customize the report. 

 

Column Layout: The column structure is setup via the Column Layout link at the top of the 

page.  The applicable column structure is then selected on the report layout list page in the 

Column Name field.   
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Job Queue Category List 
Enter a descriptive code that can be used to group the invoices.   
Ex. Project Invoices prepared by different employees can be grouped under a unique Job Queue Category.  

 

To navigate to the Job Queue Category List: 

Administration→Application Setup→Job Queue→Job Queue Category List 

 

 

 
 

Code: Enter a code that describes the job queue category. 

Description: Enter a short description of the job queue category. 
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Job Queue Scheduler 
The Job Queue Scheduler provides the ability to schedule the creation of invoices overnight and it 

allows you to automate the generation of report layout reports. 

 

Job Queue Category: Identify the Job Queue Category. 

Type: Select the type of function you are scheduling. 

Options are: 
Invoice Creation: This will create invoices for the job and schedule selected when the function is run. 

Report Layout: 

Billing Job No: Identify the job number that you are generating invoices for. 

Billing Group Name: Identify the billing group that you are generating invoices for. 

Billing Group Multi Select: This is selected if you are generating multiple invoices using the 

multi select option in the billing group setup. 

Report Layout Job Filter: This range of jobs is assigned if the type selected is report layout. 

Report Layout WBS Filter: This WBS Filter is assigned if the type selected is report layout. 

Report Layout Name: This report layout name is assigned if the type selected is report layout. 

Status: This field indicates whether the line is currently being processed or if it is waiting for 

further action. 

Period From: This is the start date for the report being generated. 

Period To: This is the end date for the report being generated. 

Recalculate Period: Once the report is generated the period from and to dates are recalculated 

using this setup. 

Recurring Frequency: Enter the frequency with which this report will be run. 

Next Run Date: This report will not be run prior to the date populated here.  This prevents 

incorrect generation of invoices. 

Expiration Date: Identify the date that the system should no longer submit the line to the job 

queue. 

 

Submit to Job Queue: This will queue the invoices for generation.  Set a filter on the job queue 

category code before using this function.  All lines within the filter will be submitted for invoice 

generation. 

 

Job Queue Entry: Use this function to see the jobs that are currently in the queue and to see if 

there were any errors. 

Job Queue 

The Job Queue page enables users to schedule and run specific reports and code units.  In the GC 

module it will be used to automate invoice creation.  

To navigate to the Job Queue:  

Administration→Application Setup→Job Queue→Job Queue Entries 
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Code: Enter a code that describes the job queue. 

Description: Enter a short description of the job queue. 
Note: For advance setup instructions including the use of the NAS (Navision Application Server) refer to the Dynamics 

NAV documentation. 
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Resource Setups 
 

Timesheet Period 

Timesheet period is a user configurable feature that gives the user the capability of having 

multiple timesheet periods and choosing which one to assign to a resource. This allows for 

scenarios where you may have employees on different pay cycles.  

 

To navigate to Timesheet Period:  

Setup & Extensions→Manual Setup→Timesheet Period 

 

 

 
 

Name: Name the timesheet period. 

Description: Description of the timesheet period. 

Period Frequency: Identify the frequency of the timesheet period. 

Options are: 
Week: A new period will begin every 7 days. 

Bi-Weekly: A new period will begin every 14 days. 

Semi-Monthly: There will be two pay periods per month. 

Monthly: A new period will begin on the 1st of every month. 

Fiscal Period: A new period will begin at the start of the next fiscal period. 

Other: The periods will be defined by the user. 

Auto Split Week: Auto split week will create a new timesheet if you are on a weekly or bi-

weekly cycle and calendar month end comes in the middle of the cycle. 

Week Starting Date: Identify the day that your pay period should begin. 

Weekday Start: Identify the first working day in the timesheet period. (Ex. 1 - Monday) 

Weekday End: Identify the last working day in the timesheet period. (Ex. 5 - Friday) 

Weekday Start Name: This will be populated by the system per your weekday start selection. 

Weekday End Name: This will be populated by the system per your weekday end selection. 

Hours per Pay Period: Enter the number of regular hours in the pay period. 

Compensated Time Accrual At: Once this number of hours worked is reached by a salary 

employee, they will start to accrue compensated time on the subsequent hours worked. 

 

After the structure of your timesheet period has been created the Periods function in the ribbon 

should be used to generate timesheet periods within the established guidelines.  
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Working Time Calendar 
The working time calendar allows you to determine regular working days, weekends, and 

holidays for a group of users. This calendar will be used to determine when missing time email 

notifications will be sent.  

 

To navigate to working time calendar:  

Setup & Extensions→Manual Setup→Working Time Calendar 

 

 

 
 

Name: Name the working calendar 

Description: Short description of the working calendar  

 

Select Working Times in the ribbon to open the working times edit screen.   

The working times edit screen is used to create/modify the schedule.  A new schedule is 

populated using the “Create Working Time” function found in the ribbon of this screen. 

 

 

 
 

Identify the starting week day and the ending week day and the table will be created for your 

working time group.  Update the table for any holidays or exceptions to the normal schedule.   
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Time Zones 
An employee is assigned a time zone. This time zone will be used to provide daily notifications 

and to determine time in advance rules.  The time zones are based off of the positive or negative 

offset from the Coordinated Universal Time (UTC) designations.  

 

To navigate to time zones: Setup & Extensions→Manual Setup→Time Zones 

 

 

 
 

Name: Name the time zone that you are setting up. 

Description: Description of the time zone. 

UTC Offset Hours: Enter the time zones offset hours from GMT (Greenwich Mean Time). 

UTC Offset Minutes: Enter the time zones offset minutes from GMT (Greenwich Mean Time). 
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Benefit Accrual 
 

The benefit accrual setup is used to setup the attributes of your PTO codes in NAV. 

 

Navigate to the time posting group setup:  

Setup & Extensions→Manual Setup→Benefit Accrual 

 

 

 

Code: Define the benefit accrual code 

Description: The description for the accrual code 

Accrues Benefits: Identifies hours associated with this code as earning variable benefits 

Exclude From Benefits Earned Calculation: Identifies codes that do not earn benefits 
Where Used: This setup is used when the benefit earned calc. method on resource setup is hours worked (e.g. PTO). 
Accrual Account No: Identifies the g/l account used to make the accrual entry 

Expense Account No: Identifies the g/l account used to expense the cost 

Exclude From Labor Statistical: Hours associated with this code are ignored and will not post 

to the labor statistical accounts selected on resource setup. 

Payroll Integration Code: Identifies the code used to get ADP, Pay-Chex, and NAV payroll 

setups. 
Where Used: These setups are used when time journal lines are posted.  Additional lines are posted to the general 

ledger. 
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Benefit Plan 
The benefit plan describes the benefits that are given to an employee. Benefit plans consist of 

benefit accrual codes. These codes describe how benefits accrue for a benefit plan. 
Note: You assign a plan to an employee on the resource card. 

Note: You can have an un-limited number of plans. If an employee has a special plan, you can create a setup specific to 

the employee.  
 

Navigate to the Benefit Plan Page:  

Setup & Extensions→Manual Setup→Benefit Plan 

 

This will open the Benefit Plan List Page.  Name and give a short description of the Benefit Plan 

you are setting up.  Select the line and click Edit in the ribbon.  The Benefit Plan Card will open. 
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No. of months: This field indicates the number of months that an employee should be employed 

before they begin accruing hours toward the selected PTO time posting group. 
Best Practice: This will be 0 for holiday pay if this is provided to employees from the first day of employment.  

Holiday pay may need to be manually adjusted each pay period before payroll is processed dependent on if there is a 

holiday or not.   

Code: The benefit accrual code that should be used for this accrual. 

Hours Earned: The hours the employee will accrue to the selected benefit accrual per pay 

period. 

Max Earned: The maximum number of hours that an employee can retain in this benefit accrual 

code.   
Note: The max amount includes all hours that have been carried over from a previous year. 
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Pay Type 
The pay type setup allows you to configure multiple pay rules for different overtime and shift 

time scenarios.  It is a user defined table that assigns a multiplier to each pay type code and 

determines if the code should be considered as regular time when used.  This setup will also 

determine how the system calculates for the effective rate during labor distribution. 
 

To navigate to pay type: Setup & Extensions→Manual Setup→Pay Type 
 

 

 
 

Name: Name the pay type. 

Description: Describe the pay type. 

Base Type: Identify the normal type of pay associated with the pay type. 

Options are: 
Regular: Hours that should be considered regular pay. 

Note: Pay types of base type regular are added to calculate an employee’s effective rate for labor distribution. 

Overtime: Hours that should be considered overtime pay. 

Overtime Multiplier Salaried: This is the field that the system uses for salaried computation. 

Regardless if the hourly field is populated. 
Best Practice: The regular value is 0. 

Multiplier Hourly: This is the field that the system uses for Hourly computation. Regardless if 

the salaried field is populated. 
Note: If overtime is setup for salaried employees, overtime is computed by salary divided by hours per pay period (GC 

setup) x the OT rate. 

Default: This is the pay type time entries are defaulted to. Typically this is a regular pay type. 

Payroll Integration Code: Identify the code for ADP, Pay-Chex, and Dynamics NAV payroll. 
 

Payroll Integration Setup 
The payroll integration setup is used to setup the fields needed for integration with ADP, 

Paychex, and the Dynamics NAV payroll modules. 

Code: Define a code for the setup. 

Description: A short description of the code. 

ADP Hours Code: For companies that use ADP, the hours Code Field Name is used to provide 

ADP the field names for special time types such as sick time or vacation. 

ADP Rate Code: If used in the time journal it will be exported with the timesheet lines. 

ADP Other Option:  

Options are: 
Blank 

Other 3 

Other 4 

PayChex Earning Code: Mapping to PayChex table  

Dynamics NAV Payroll Control (Used only if using Dynamics NAV Payroll)  

Where Used: When copying timesheet hours to the payroll module the defined earnings code will be used. 
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Resources Setup 
The resources setup page identifies global setup options for WTE and NAV to include: email 

domain selections, default WTE system settings, ADP import/export mapping tables, Rounding, 

and resource vendor sync setup. 

 

To navigate to Resources setup:  

Setup & Extensions→Manual Setup→Resources Setup 

 
 

 
 
Numbering Tab     

Use this tab to specify the default numbering series and other default setups for resources and 

timesheets. 

 

Resource Nos: Specifies the number series used for new resources. To see the number series that 

have been set up in the No. Series table.  This is a required field. 

 

Email Format 

Email Domain: This is the global setup used for company email domain names. 

Email Format: When a resource record is created the email address is generated. 

The options are:   
First Initial + Last Name  

Last initial + First name  

First Name dot Last Name 

Last Name dot First Name 
Where Used: The combination of these two fields generates the employee’s email address.  You can verify this setup 

via the web tab on the resource card.  If the resource card name is modified the email address will not be updated, 

however, you can edit the email address field directly and do not need to generate a new resource card or project user 

card. 

 

Windows Domain 

When using windows authentication this field has the windows domain name for your 

organization. 
Where Used: When a resource card is created a web user is also created. The login name field on the time and expense 

resource card will be prefixed with a unique domain name.  NAV does not allow duplicate names. 

Note: This field should be left blank when using forms authentication. 

 

  



27 
Revision 1.10 

Benefit Calculation Setups 

Benefit Earned Calc. Method: This selection will be the company default but can be 

overwritten by a resource level setup. 

The options are: 
Fixed Rate - Fixed amount of benefit hours are accrued per pay period.   

Hours Worked – Benefit is calculated based on the number of hours that are worked.   

Benefit Calc. Recurring Frequency: Identifies how often the Benefit balance should be 

updated. (Ex.1W)  
Where Used: These setups are used to populate the lines in the benefit batch when the “Calculate Benefits Accrual” 

function is run in the Benefit Journal.  Last accrual date on the resource card must be entered. 

W = Week 

D = Day 

M = Month 

 

Labor Calculation Setups 

Labor Dist. Calc. Method 

The options are: 
Effective Rate – This option calculates the employee unit cost as (Pay period salary) / (Total regular hours). 

For hourly employees overtime lines are calculated as (Hourly rate) X (OT multiplier)  

Weighted Average – This option calculates the employee unit cost as (Pay period salary) + (Overtime pay) / 

(Total hours) 

Where Used: This setup is used in the labor distribution calculation in the Time Journal. 

Labor Statistical Option  

The options are: 
Cost will post the cost for a department based on standard setups in combination with the timesheet  

Hours will post the hours for a department based on standard setups in combination with the timesheet.   

Cost home department will always use the department from the resource card. 

Hours home department will always use the department from the resource card. 

Labor Stat. Account No: G/L account number that should be used for labor distribution.  

Labor Stat. Contra Acct. No: G/L account number that should be used for labor distribution 

contra postings. 
Where Used: These setups are used when time journal lines are posted.  Additional lines are posted to the general 

ledger statistical accounts. 

 

ADP Mapping Setup 

This section of the window is a mapping table to setup codes that import and export payroll data 

to ADP.   

 

The fields are as follows: 

Company Code – This is the company code assigned in ADP. 

Regular Hrs Field Name – This is the name of the field that regular timesheet hours will be 

entered to.  This field is usually called “Regular”. 

O/T Hrs Field Name - This is the name of the field that overtime hours will be entered to.   

Import Row Start – This field is not normally used. 

Resource Col – This field is not normally used. 

Regular Earnings Col – This is the name of the field that regular timesheet earnings will be 

entered to.   

O/T Earning Col - This is the name of the field that overtime earnings will be entered to.   

Other Earnings Code Col – Codes for additional earnings should be posted here.  (Ex. Bonus) 

Other Earnings Col - Additional earnings for preceding other earnings codes should be posted 

here. 

Sequence Col – This field is not normally used. 

Deduction XI Row Start – This field is not normally used. 
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Rate Code Field Name – This field maps rate code field names to associated hourly rate.  When 

a rate code is selected, and an earnings amount isn’t selected, NAV will calculate the earnings by 

multiplying the hours entered by the rate code amount. 

 

Rounding 

Invoice Rounding Required: By default, invoices will have all lines from a timesheet.  

Checking this box summarizes the lines on the invoice per resource and task.  This may be 

required if you have a time entry policy where the default behavior may lead to invoice totals 

being rounded.   

Invoice Rounding Resource: You may want to use this feature if invoices are not rounding as 

needed.  This is typically used when invoices are printed by labor category. 
Where Used: These fields are used together to summarize invoices by labor category or task.  This is needed if time 

entry is in ¼ increments or less.   

Best Practice: If using ¼ hour time increments we recommend using the invoice rounding feature. 

 

Defaults for Resource Vendor Record 

Create Vendor: This is selected if you want the system to automatically create the vendor record 

when the resource is created.  If selected, the values in this vendor record will be updated with the 

information populated in the fields following:  

Vendor Nos: Supplies the number series that the system will use when generating vendor 

records.  If this field is left blank the system will use the next vendor number from the vendor 

number series. 

Vendor Posting Group: Allows you to identify the payable G/L account associated with the 

vendor record.   

Gen. Bus. Posting Group: Grouping or classification of employee vendor records.  This is 

usually defaulted to “Vendor”. 
Where Used: Used for expense report payables to create the vendor record to reduce duplication of data entry.  These 

fields are required for the vendor setup when creating vendor records. 
Best Practice: If the company does not have employees or has a low volume of expense reports turn off this feature. 
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Resource Class 
The resource class setup page identifies category classes that the company uses to classify 

resources and drive general ledger accounts used when labor or wage costs are posted for an 

employee.  Resources can be classified per client site or company site, full time or part time, and 

subcontractor labor.  Unlimited classifications can be established per company requirements.   

 

 

 
 

Name: Identify the name of the resource class. 

Description: Describe the resource class. 

 
Where Used: Once resource classifications are identified, they are used on the resource card, category group, and job 

group resource class setups.   
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Wage Determination Location 
Wage determination location standards, also known as prevailing wage, can be setup using the 

wage determination location setup page.  This allows the user to establish a minimum hourly rate 

for employees, based on their location and job category, for compliance per state or federal 

government regulations.  

 

To navigate to Wage Determination Location: 

Setup & Extensions→Manual Setup→Wage Determination 

 

 

 
 

Location Code: Identify the location code that you are setting up. 

Description: Identify the full description name of the location you are setting up. 

 

Once the location has been identified click the Actions tab and Details in the ribbon to set up the 

rates that will be used. 

 

 

Job Category Name: Identify the job category that you are setting up. 

Effective Date: Identify the date that this minimum rate will be effective.  This field is optional. 

Hourly Rate: Identify the minimum hourly rate per the job category and location. 
Where Used: Wage determination location is setup on the resource card.  
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Job Setups 
Contract Type 
The contract type table is used to create contract types for projects awarded.  Tasks created will 

default to the project’s contract type selected.     
Note: The contract type will print on reports including the sales invoice.  

 

To navigate to the Contract Type Setup:  

Setup & Extensions→Manual Setup→Contract Type 

 

Name: Name the contract type. 

Description: Description of the contract type. 

Include in Utilization: Specifies how the system treats time posted against different contract 

types as productive (utilized) or un-productive time for utilization reports and calculations. 
Where Used: Contract type is a field on the job card and the task card. 
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Job Group 
The Job group setup allows you to group jobs for the purpose of revenue recognition and 

reporting. The job group is also one of the sequences the system evaluates in the job posting 

process (see job posting).  

 

To navigate to the Job Group Setup:  

Setup & Extensions→Manual Setup→Job Group 

 

 

 
 

Name: Name the job group. 

Description: Description of the job group. 
Where Used: This is used on the job card. 

Cost Account: Identify the G/L account that the cost for this group should post to. 
Note: The cost account on Job Groups is used to record labor costs for IR&D and B&P projects. 

Allow Time in Advance: This allows employees to charge time in advance to jobs in this group. 

 

Select Edit in the ribbon to setup the additional g/l accounts associated to the job group: 

 

 
 

Revenue Account: Identify the G/L account that the revenue for this group should post to. 

Accrued Revenue: Identify the G/L account that is credited when using when using the revenue 

recognition routine. 

WIP Sales Value: Identify the G/L account debited during the revenue recognition routine. 

 

  



33 
Revision 1.10 

Job Group Resource Class 
The job group resource class setup table is used in conjunction with the job group and allows the 

user to override the g/l account based on a job group and the class code on a resource. This 

feature may be used to map labor to a G/L account based on the job group.  For example, B&P 

labor associated with subcontractors can be posted to the B&P subcontract labor account using 

the appropriate resource class. 
Where Used: This is used when posting labor using the time journal or subcontract labor using a purchase order. 

 

To navigate to the Job Group Resource Class Setup:  

Setup & Extensions→Manual Setup→Job Group 

 

 
 

 

 
 

Resource Class Name: Identify the resource class that you are setting up.  

Pay Type: Identify the pay type that you are setting up.  

Cost Account: Identify the g/l account to use for the job group, resource class, and pay type 

selected. 
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Job Account Group 
The job account group is used to override the g/l account assigned to a job category.  It also 

allows you to restrict a job to job categories selected. For example on B&P projects this feature is 

used to map the job category “Lodging” to the lodging account in the B&P section of your chart 

of accounts, overriding the direct cost account default setup on the job category.  

 

To navigate to the Job Account Group Setup:  

Setup & Extensions→Manual Setup→Job Account Group 

 

 

 
 

Name: Name the job account group. 

Description: Description of the job account group. 

Restrict to Labor Categories Listed: Restricts postings for the job account group to only the 

labor categories selected on the job account group detail screen. 

Restrict to Expense Categories Listed: Restricts postings for the job account group to only the 

expense categories selected on the job account group detail screen. 

 

Select Details to open the Job Account Group Detail Setup Screen: 

 

 

 
 

Job Category Name: Identify the job category from the job category list. 

Cost Account: Identify the G/L account that the cost for this group should post to. 

Revenue Account: Identify the G/L account that the revenue for this group should post to. 

Accrued Revenue: Identify the G/L account that is credited when using when using the revenue 

recognition routine. 

WIP Sales Value: Identify the G/L account that is debited when using the revenue recognition 

routine. 
Where Used: This is used on the job card and the task card. 

Note: See job posting for more information on how the above g/l accounts post from jobs to general ledger. 
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Job Posting 
 

This section describes how the g/l account is selected for each posted transaction (cost and 

revenue). Each transaction evaluates seven setups in the sequence below to identify a g/l account. 

The first setup with a g/l account populated is used. 

 

1 – Job – The job card is the first place the system will look for a g/l account selection for 

postings.  G/L selection on the job will override all other g/l selections. 

2 – Job account group selected on the job – The job account group can be used to override the g/l 

account selection on the job category.  Ex. Fringe costs for B&P projects. 

3 – Job group, resource class code - If there is a resource class code selected the cost account 

associated will be used. 

4 – Job group selected on the job – Groups jobs for revenue recognition and reporting. 

5 – Job category – The job category allows the user to categorize job costs within a category 

group.  Ex. Category group (travel) will have (lodging, per diem) as job categories. 

5 – Category group, resource class code and pay type – If there is a pay type selection on the 

resource class table the cost account associated will be used.  If pay type is not selected, but a 

resource class is assigned the cost g/l account assigned to the class code is used.   

Ex. Labor charges when an employee is at a client site vs. labor charges when an employee is at 

the company site should go to different g/l accounts. 

7 – Category group – The category group creates groups for common charges. Ex. Travel 

  

When posting cost (labor, expense or burdens) the “cost account” field is used. If a cost account 

is setup on the job it is used. If one is not supplied on the job, the job account group is searched 

for a cost account. This continues until a cost account is found. 

 

When posting an invoice the “revenue account” field is used. The same search is performed as 

with the cost account. There are additional fields for revenue accrual. 

 

 

 

 

Job Card

 2
Does the Job Account 

Group have a G/L 
account number 

selected?

1
Is the job card 

populated with a 
G/L Account?

3
Does the Job Group 
resource class code 

have a G/L?

4  
Does the Job Group 
have a G/L Account 

number?

5  
Does the Job Category 

have a G/L Account 
number?

6
Do the Category 

Group and resource class 
code/pay type have  a 

G/L?

7
Does the Category 

Group have  a 
G/L?

2
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Account Set 
 

The account set is used to set a range of accounts that is then assigned during allocation setup. 

 

To navigate to account set:  

Setup & Extensions→Manual Setup→Billing Account Set 

 

 

 
 

Name the account set that you are setting up and click Details in the ribbon. 

 

 

 
 

Effective Date: The date that the account set will be effective. 

From Account: Identify the starting g/l account number in the account set. 

To Account: Identify the ending g/l account number in the account set. 
Note: Multiple lines can be used for breaks in the account set. 
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Department Set 
The department set is used to set a range of departments that is then assigned during allocation 

setup. 

 

To navigate to department set:  

Setup & Extensions→Manual Setup →Billing Department Set 

 

 

 
 

Name the account set that you are setting up and click Details in the ribbon. 

 

 

 
 

Effective Date: The date that the department set will be effective. 

From Department: Identify the starting g/l account number in the department set. 

To Department: Identify the ending g/l account number in the department set. 
Note: Multiple lines can be used for breaks in the department set. 

Note: The Effective Date should always be in line with a company’s fiscal year. 
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Billing & Revenue Formulas 
The billing formula allows you to configure the elements that are charged on an invoice. With the 

billing formula setup you can configure how labor and non-labor is invoiced, if burdens are 

calculated and if fee is charged on the invoice. 

 

Similar to the billing formula, the revenue formula allows you to configure the elements that are 

considered in computing revenue. Where in most cases the billing and revenue formula will be 

the same, the configuration allows for scenarios where the billing might be milestone based yet 

revenue recognition uses a different formula. 

 

For labor and non-labor you can configure the formula to invoice based on cost or sales price. If 

sales price is selected the labor category rate will be used.  Burden and fee calculations are 

configurable themselves. See billing pool group and fee percent setup below.   

 

To navigate to the Formula List:  

Setup & Extensions→Manual Setup →Billing & Revenue Formula 

 

 

 
 

Name: Name the formula. 

Description: A short description of the formula. 

Control: This field controls what the revenue recognition routine will do with the formula setup. 

Options are: 
Disabled: Revenue recognition will skip this formula if selected. 

Formula: The system will use the subsequent fields to create a formula to calculate billings. 

Estimate to Complete: Will use the fixed price estimate to complete worksheet from the job card. 

Revenue Equals Billing: When used the revenue accruals are not calculated for the job. 

Revenue Equals Billing before Withholding: When used the revenue accruals are not calculated for the job 

before withholding. 

Labor: Select how you would like the formula to calculate labor postings. 

Options are: 
None: This is selected if labor transactions are not invoiced. 

Cost: This is selected if labor transactions are invoiced at cost. 

Sales Price: This is selected if labor transactions are invoiced at the sales price. 
Non-Labor: Select how you would like the formula to calculate non-labor postings. 

Options are: 
None: This is selected if non-labor postings should not be calculated in the formula. 

Cost: This is selected if non-labor should be calculated and invoiced at cost. 

Sales Price: This is selected if non-labor should be calculated and invoiced at sales price. 
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Burden On: Select how you would like the formula to calculate indirect costs. 

Options are: 
None: This is selected if indirect cost postings should not be calculated. 

Labor: This is selected if indirect costs should be calculated for labor postings only. 

Non-Labor: This is selected if indirect costs should be calculated for non-labor postings only. 

Both: This is selected if indirect costs should be calculated for labor and non-labor postings. 

 

Fee: Select how you would like the formula to calculate fees. 

Options are: 
None: This is selected if fees should not be calculated. 

Labor: This is selected if fees should be calculated for labor postings only. 

Non-Labor: This is selected if fees should be calculated for non-labor postings only. 

Both: This is selected if fees should be calculated for labor and non-labor postings. 

Amount on Hours: This uses the fee amount on hours setup on the job card. 

Amount MTD: This will only be used for firm fixed price billing calculations. 

Amount YTD: This will only be used for firm fixed price billing calculations. 

Amount ITD: This will only be used for firm fixed price billing calculations. 

Where Used: This is used on the job card and the task card. 

Note: The amount MTD/YTD/ITD fields require a fee amount setup on the job task card.  If the selection is zero on the 

job task card the invoice will create a negative line for the fees that should be invoiced. 
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Billing Pool Group 
The billing pool group allows you to configure how burdens are calculated for a job. This gives 

you flexibility to calculate invoice burdens differently for different jobs. 

  

To navigate to the Billing Pool Group Setup:  

Setup & Extensions→Manual Setup →Billing Pool Group 

 

 

 
 

Name: Name the billing pool group. 

Description: A description of the billing pool group. 

Setup equals cost pool: This is selected if the billing pool setup corresponds to the cost pool 

indirect calculation.  This is an information field only. 

 

Select Details to open the billing pool setup screen to setup your pools. 

 

 

 
 

Sequence: The next consecutive pool number available globally will be auto-generated.     

Name: Name the indirect cost type that you are setting up. 

Department Set Name: Identify the department set that the system should calculate these 

burdens for. 

Cost Pool for Provisional Rate: Identify the cost pool that the system should use to calculate the 

provisional rate for indirects. 

Job Category Name: Identify the job category that the system will use for the entry posted.  If 

this field is left blank, the job category from the cost pool provisional job category will be used. 
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Select an indirect pool and click Base Formula to create the formula that will be used. 

 

Name: This field selection determines if the line is being used to determine the account set or to 

identify other billing pools costs that should be included in the calculation and the sequence that 

should be used.  

Options are: 
Account Set: This is selected when you are defining the account set for the base. 

Billing Pool: This is selected when identifying another billing pool that has costs that should be included. 

Code: The drop down will be updated per your selection in the name field to display either your 

account sets or your billing pools.   
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Fee Percent 
The fee percent setup allows you to configure how fee is calculated for an invoice. You can have 

as many fee percent’s as you have g/l accounts. 

 

To navigate to fee percent: Setup & Extensions→Manual Setup→Fee Setup 

 

 

 
 

Select New to create a new fee percent: 

 

Name: Name the fee percent. 

Description: Description of the fee percent. 

 

While the line is selected select details in the ribbon to open the Fee Setup Detail Screen: 

 

 

 
 

Account Set Name: Identify the account set that should be included in the fee calculation. 

Fee Percent: Populate with the percentage that should be used for the fee calculation. 
Where Used: This is used on the job card and the task card. 
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Withholding 
The withholding setup table allows you to withhold billing on a specified percentage of revenue 

for services provided to the government per contract terms.  The amount withheld will be 

displayed on the monthly invoice as a withholding line and subtracted from the final invoice 

amount.   

 

Upon completion of the contract, the total withholding balance should be billed by manually 

adding a planning line to the job.  Once the line has been created, it should be billed through the 

invoice proposal functionality.          

 

To navigate to Withholding:  

Setup & Extensions→Manual Setup→Withholding Setup 

 

 

Name: Identify a name for the withholding setup. 

Withhold Percent on Job: Identify the percent that should be withheld on billing for a job.  

Withhold Percent on Labor: Identify the percent that should be withheld on all labor billings. 

Withhold Percent on Fee: Identify the percent that should be withheld on all fee billings. 

Note: Withholding setups for Job and Labor/Fee are not intended to be used in conjunction.  One or the other should be 

used per contract terms. 
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Jobs Setup 
 

The Jobs Setup page is used to identify job defaults and number series selections. 

 

To Navigate to Jobs Setup: Setup & Extensions→Manual Setup→Jobs Setup 

 

 

 
 

General Tab 

Automatic Update Job Item Cost: This field is not normally used. 

Apply Usage Link by Default: This field is not normally used. 

Default Job Posting Group: Identify the job posting group that jobs will default to. 

Default Template Name: Identify the default job journal template. 

Default Batch Name: Identify the default job journal batch. 

 

Numbering Tab 

Job Nos: Identify the number series that should be used for job creation. 

Subcontract Nos: Identify the number series that should be used for subcontract creation. 

FCCOM Nos: Identify the number series that should be used for FCCOM allocation. 
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Chapter 2 – Resource Card 
  

Resource List 
 

The resource list displays information from the resource cards in a list form for a quick view of 

resources.  Many of the fields in the Resource Card window are also in the Resource List 

window. If you set up a resource in the Resource List window a resource card will automatically 

be set up for that resource, however, the resource card is the primary data entry point.  The list 

view should only be used for viewing. 

 

Copy Down: This function is used to facilitate more efficient data entry.  The setups from the 

line created will be copied to all resources selected using a filter. 
Note: If the system finds posted ledger entries a warning is displayed before the copy down function continues.  

 

Resource Card 

 
The Resource Card window is used to enter information about resources, such as the resource 

number, resource name, unit price and cost. There is one card for each resource. Each card 

contains several tabs with different types of information about the resource.  Resources can be 

employees, machines (manufacturing module) or other company resources such as subcontractors 

who enter time.  

 

To Navigate to Resources: Role Center→Resources 

 

To Create a New Resource: 

 

1. The New icon in the top left of the resources list view is used to open a blank resource card. 

 

2. Fill in the fields on the card to create your resource. 
Note: There are additional fields on the resource card but they are not relevant to this module. 
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General Tab 

No: Specifies a number for the resource.  This is a required field.  You cannot fill in the other 

fields in the resource table until you have entered a number in the No. field.   
Best Practice: Match the resource number to the payroll system ID. (Emp No.) 
You can use one of the following methods: 

• If you have set up a default resource number series, press Enter to have this field filled in 

with the next number in the series. 

• If you have set up more than one number series for resources, choose the field and identify 

the series that you want to use. The field is filled in with the next number in that series. 

• If you have not set up a number series for resources, or if the Manual Nos. field is selected for 

the numbers series, you can enter a number manually.  
Best Practice: Subcontractors should have their own unique number series. 

 

Name: Specifies a description of the resource. You can enter a maximum of 30 characters, both 

numbers and letters.  The entry appears on the sales lines or the journal lines when you enter the 
number or the search name in the Name field. 
Best Practice: Be consistent in using first name, last name or vice versa. 

 

Type: Specifies whether the resource is a person or a machine.  This is a required field.   
Best Practice: This is always set to person in the project accounting module.  Machine is only used in the 

manufacturing module. 

 

Base Unit of Measure: Specifies the base unit that is used to measure the resource.  Employees 

and consultants will always use the base unit of “Hour”.  

 

Subcontract resource 

Vendor No: Specifies the vendor number associated with the resource and used for invoice 

creation from expense reports.   
Where Used: Departments→Project Accounting→General→Time Journal→Create Sub Cont Invoice 

When the create subcontractor invoice function is run, the system creates a purchase invoice. The G/L account it uses 

comes from the category group resource class. 

Best Practice: Use the resource number if possible. 

Subcontractor: This Check box is selected if the resource is a subcontractor so a subcontractor 

invoice can be created via the Time Journal.  This allows non-employees to use WTE. 

Consultant: This Check box is selected if the resource is a consultant so a consultant invoice can 

be created via the Time Journal.  This allows non-employees to use WTE. 

 

Labor Category Code: Specifies the resource group of the resource.  Select “Exempt from 

Service Contract Act” in the setup if SCA rules are not applicable to the labor category code. 

Class Code: This field provides the resource occupation class list per the SCA setup.  
Note: This is equivalent to the Area Wage Determination (AWD) location. 
Wage Determination Location: This field provides the location list per the SCA setup.   
Note: This is equivalent to the Area Wage Determination (AWD) location. 
Where Used: The class code is used with the wage determination location to fulfill SCA minimum wage requirements. 
NAV will use employee cost from the cost setup on the job card. 

 

Blocked: This is selected if the resource is blocked for posting.  Resources that are not usually 

posted can be blocked to avoid incorrect postings.  The check box is selected if you want to 

prevent the use or sale of the corresponding resource.   
Note: This does not disable WTE access. 
 

Last Date Modified: Specifies the date of the most recent change of information in the Resource 

Card window. This field is automatically updated. 
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Web Tab 

Web Login Name: This will be pre populated based on your resources setup.   

Web Login Password: Enter the default password. 

Email: The email address for the resource will be pre populated based on your setup.   

Time Zone: Identify the resources time zone.  (See Ch. 1 for setup information) 

Timesheet Period Name: Identify the resources timesheet period. (See Ch. 1 for setup) 

Working Time Calendar: Identify the resources working time calendar. (See Ch. 1 for setup) 

Daily Overtime: This allows a user to identify the overtime pay type on WTE even if the total 

hours are less than 40. 

Daily Notification Blocked: If selected, the resource and their approver will not receive daily 

missing time notification emails for this resource, even if the global setting is turned on. 

Delegate Entry Resource No: This field is used to designate a person that will enter time or 

expenses in your absence. 
Note: Final submission will still need to be from the resource who owns the timesheet. 

Delegate Approval Resource No: This field is used to designate a person that will approve time 

or expenses you are responsible for approving in your absence. 

 
Invoicing Tab 

Price/Profit Calculation: This field is not used and can be left at the default value. 

Gen. Prod. Posting Group: Identifies the general ledger accounts that are posted to in 

combination with the general business posting groups when sales or purchase transactions are 

posted. Choose the field to identify a posting group. 
Best Practice: Use default of service. 

Department Code Dimension: The resources department should be selected. This field is used 

in conjunction with the dimension priority on the GC Parameters table.   
Where Used: The department code is used on labor entries, if the priority for the department is by job.  If resource 

department is the priority then this field will be used on all labor transactions. 

 

Personal Data Tab (Optional) 

Job Title: Identify the employee job title.  

Address: Identifies the address or location of the resource, if applicable.  

Address 2: Identifies an additional address or location of the resource, if applicable.  

City: Identifies the city of the resource's address. 

State/ZIP Code: Identifies the resource’s state/zip, if applicable.   
Best Practice: Use a standard format for state names so that they have a uniform appearance on printouts. 

Post Code: Specifies the resource’s post code, if applicable. 

Social Security No: Specifies the resource’s social security number.  

Education: Specifies the training, education, or certification level of the person. You can enter a 

maximum of 20 characters, both numbers and letters. 

Contract Class: 

Employment Date: Identifies the employee start date or the date on which the machine was 

placed in service.  Used with PTO calculation. 

ADP/PayChex Employee No: This references the employee ADP/PayChex Employee No. 

Salaried Employee: This Check box is selected if this is a salary employee. 

Supervisor No: Identify the resource supervisor. 

Benefit Plan Name: Identify the benefit plan that corresponds with the benefits received by the 

resource. 

Last Benefit Accrual: Populate the starting date for benefit accrual. 
Note: This field will be updated by the calculate benefits accrual function on the benefits journal.   

 

  



49 
Revision 1.10 

Pay Rates 
 

Pay Rates assign a period salary or hourly rate for a resource based on an effective date.  

 

Role Center→Resources→Pay Rates 

 

The Pay Rates link can be found in the ribbon of any resource card: 

 

 

 
 

The Resource Pay Rates Edit Screen will open: 

 

Effective Date: The date that the labor rates setup will be effective for this resource. 

Salaried Pay Cycle Amount: This will be a pay period amount for salary employees. 

Hourly Amount: This should be an hourly rate for hourly employees.   
Note: Employees starting mid pay period are set to pro-rated salary.  Set next pay period to be their salary amount.   
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Chapter 3 – Job Card 
 

Job Card 
A Job Card is created to identify tasks, terms, resources, labor categories, and budget.  It can also 

be used for the creation of quotes, statistics, invoices, costing, and reports related to the project.   

 

General Tab 

Job 

No: The Job number will be auto-generated based on your No. Series List setup. 

Description: Enter a description of the project/contract that you are setting up.   

 

Client 

No: Identify the Client No. from the customer list.  

The following fields will be auto populated with the client information from the customer card 

when the client no is selected:   
Name 

Bill-to Address 

Bill-to City 

State/Zip Code 

Bill-to Post Code 

Contact No 

Bill-to Contact 

Client Type: Identify the client type from the options below. 

Options are: 
Commercial 

Federal Govt. 

State Govt. 

Local Govt. 

Where Used: This is used by the ICE Schedules. 

 

Job 

Status: Identify the current status of the job.  The default status is “Order”. 

Options are: 
Planning – This is a legacy field and should not be used. 

Quote - This is a legacy field and should not be used. 

Order - This is the default status and should be used until completion. 

Completed – This status is selected when the job has been completed. 

Project Manager No: The resource number of the project manager assigned to the project.  

Project Manager Name: This will be auto populated with the name on the resource card 

associated to the project manager no selected.   

Job Contract Type: Identify the contract type. 

Starting Date: Identify the starting date of the contract. 

Ending Date: Identify the ending date of the contract. 

Certification Code: Identify any standard text codes that apply.  This will insert the text selected 

in the description field in the bottom section of the invoice. 

Invoice Nos: Identify the default number series for your invoices.  This can be customized. 

Service Contract Act: This is selected if the SCA minimum wage requirements are applicable 

and require resource cost setup. 

Subcontractors Allowed: This is selected if subcontractors are allowed to charge to the job.  

This is an information field only. 
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Timesheet 

Allow Time in Advance: If selected, employees will be allowed to charge time in advance. 

Leave Without Pay: If selected, this signifies that the project is leave without pay like FMLA or 

Military leave. 
Where Used: During labor distribution, the time is reversed. 

 

Posting Tab 

Blocked: Posted transactions only or all modifications will be blocked to this job. 

Options are: 
Posting – Block posted transactions only. 

All – Block all modifications. 
Last Date Modified:  Display field only.  Tracks the last time the job record was changed. 

Department Code Dimension: The resources department should be selected. This field is used 

in conjunction with the dimension priority on the GC Parameters table.   
Where Used: The department code is used on labor entries, if the priority for the department is by job.  If the job 

department is the priority then this field will be used on all labor transactions. 
Job Posting Group: Identify the Job Posting Group that the job belongs to. 

Benefit Accrual Code: Identify the benefit accrual code that this job represents. 

Ex. Indirect PTO project would use a PTO code.  

Cost Account: Identify the G/L account that the cost for this job should post to. 
Note: See Job Posting section for how a g/l account is selected. 
Revenue Account: Identify the G/L account that the revenue for this job should post to. 
Where Used: This is used during invoice creation. 

Note: See Job Posting section for how a g/l account is selected. 
Accrued Revenue: Identify the G/L account that is credited when using when using the revenue 

recognition routine. 

WIP Sales Value: Identify the G/L account that is debited when using the revenue recognition 

routine. 

 

Accounts 

Job Group: Identify the job group that the job belongs to. 

Job Account Group: Identify the job account group that the job belongs to. 

 

Revenue Recognition and Billing 

Revenue Recognition Formula: Identify the revenue recognition formula that should be used. 

Billing Formula: Identify the billing formula that should be used. 

Billing Pool Group: Identify the billing pool group that the job belongs to. 

Fee Percent: Identify the fee setup used when calculating an invoice for this job.   
Note: Typically used for cost plus type projects.  This field is used if the fee column in the billing formula is set to 

labor, non-labor, or both.  

Fee Amount: Identify the percentage when calculating an invoice for this job. 
Note: Typically used for cost plus type projects. This field is used if the fee column in the billing formula is set to 

amount on hours, amount MTD, amount YTD, and amount ITD.  

Withholding Setup Name: Withholding is used when the client (government) wants to hold a 

percentage of payment at the beginning or at the end of a project.  Identify the appropriate job 

withholding setup for the job, labor, and fee.        
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Contract Tab 

Contracting 

Primary Contract No: The contract number from the contract card.  This will print on the 

invoice. 
Where Used: The contract card has additional information related to the contract that can be entered. 
Other Contract No: Secondary contract number.  (If applicable) 

Office No: Identify the client’s contracting office.  

Office Name: This field will populate with the name associated with the office no selection. 

 

Paying 

Office No: Identify the customer’s paying office.  

Office Name: This field will populate with the name associated with the office no selection. 
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Work Breakdown Structure 
A work breakdown structure is created for each job and can be accessed from the job card.  The 

work breakdown structure defines the structure of the tasks and is where cost will be charged.  

 

To Navigate to Jobs: Role Center→Job 

Open a job card and the Work Breakdown Structure link can be found in the ribbon: 

 

 

 
 

 

 
 

Job WBS Code: Enter the WBS code for the task you are setting up. 

Job Task No: The system will create the job task number and populate this field. 

Description: Enter a description of the task. 

Visible on Timesheet: Resources assigned to this job will have this task available on timesheets 

to charge applicable labor. 

Visible on Expense and Requisition: Resources assigned to this job will have this task available 

on expense reports and requisitions in order to charge/request for applicable direct expenses. 

Membership: Identify the membership group for this task for time and expense entry. 

Time Approval Hierarchy: Identify the timesheet approval hierarchy for this task. 

Expense Approval Hierarchy: Identify the expense approval hierarchy for this task. 

Requisition Approval Hierarchy: Identify the requisition approval hierarchy for this task. 

Time Approval Starts With: Identify the timesheet approval level that is responsible for 

approving this task.  Some tasks may skip lower levels of approval per the nature of the task. 

Expense Approval Starts With: Identify the expense level that is responsible for approving this 

task.  Some tasks may skip lower levels of approval per the nature of the task. 

Requisition Approval Starts With: Identify the requisition level that is responsible for 

approving this task.  Some tasks may skip lower levels of approval per the nature of the task. 

Contract Amount: This field will display the contract amount setup in the system. 

Funded Amount: This field will display the funded amount setup in the system. 

 

Copy Down: This function is used to facilitate more efficient data entry.  The setups from the 

line created will be copied to all sub tasks within a work breakdown structure. 
Note: If the system finds posted ledger entries a warning is displayed before the copy down function continues.  

Job Task Card 
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Select a line in the Work Breakdown Structure and select Task Detail in the ribbon.  This will 

open the Job Task Card.  The setups on the task card are used to calculate invoices, revenue, and 

labor.  Additional task specific overrides are also setup here.  

 

 

 
 

General Tab 

Job Task 

Job No: The job number will be pre-populated. 

Job Task No: The job task number will be pre-populated from the WBS setup. 

Job WBS Code: The job WBS code will be pre-populated from the WBS setup. 

Description: The description will be pre-populated from the WBS setup. 

Blocked: Posted transactions only or all modifications will be blocked to this task. 

Options are: 
Posting – Block posted transactions only. 

All – Block all modifications. 
 

Client 

Override Client No: Identify the Client No. that should be used for this task and override the 

selection on the job.    

 

Job Task 

Manager: The resource number of the project manager assigned to the task.  

Manager Name: This will be auto populated with the name on the resource card associated to the 

manager no selected.   

Task Contract Type: Identify the contract type for the task if different from the job. 

Starting Date: Identify the starting date of the task. 

Ending Date: Identify the ending date of the task. 

 

Posting Tab 

Department Code Dimension: The resources department should be selected. This field is used 

in conjunction with the dimension priority on the GC Parameters table.   
Where Used: The department code is used on labor entries, if the priority for the department is by job.  If the job 

department is the priority then this field will be used on all labor transactions. 
 

Revenue Recognition and Billing 

Revenue Recognition Formula: Identify the revenue recognition formula that should be used. 

Billing Formula: Identify the billing formula that should be used. 

Billing Pool Group: Identify the billing pool group that the job belongs to. 
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Fee Percent: Identify the fee setup used when calculating an invoice for this task.   
Note: Typically used for cost plus type projects.  This field is used if the fee column in the billing formula is set to 

labor, non-labor, or both.  

Fee Amount: Identify the percentage when calculating an invoice for this task. 
Note: Typically used for cost plus type projects. This field is used if the fee column in the billing formula is set to 

amount on hours, amount MTD, amount YTD, and amount ITD.  

Note: Setups from the task are always used.  The corresponding fields on the job are defaulted to the task upon creation 

but may be changed. 

 

Contract Tab 

Contracting 

Other Contract No: The task contract number.  (If applicable) 

 

Paying 

Override Paying Office No: Identify the customer’s paying office if different then the job.  
Paying Office Name: This field will populate with the name associated with the office no 

selection. 

 

Job Task 

Contract Amount: This will be pre-populated from your modification detail setup. 

Funded Amount: This will be pre-populated from your modification detail setup. NAV will not 

allow job billings to exceed funding amount. 

Funded Fee Amount: This will be pre-populated from your modification detail setup. 
Note: More information on the Modification Detail setup can be found below. 
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Modification Detail 
Modification Detail is used to set up your project’s funding by task order.   

 

This can be found via the Work Breakdown Structure link in the ribbon of the job card:  

 

 

 
 

Identify the task you are setting up and click task detail in the ribbon.   

 

Select Modification Detail in the ribbon of the task card: 

 

 

 
 

This will open the Job Funding Change Tracking Screen: 

 

 

Job WBS Code: The Job WBS Code will be auto-generated but can be modified. 

Description: Describe the task. 

Starting Date: Identify the effective date of the funding change. 

Contract Amount: The total contract amount allocated for this task. 

Funded Amount: The amount that has been funded for this task. 

Funded Fee Amount: The fee amount that has been funded for this task. 
Note: When zeroing out funding amounts go to the Funding Limit screen and delete the zero amount line. 
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Funding Limits 
Funding Limits define the maximum amount that can be invoiced.  Limits can be defined at the 

project, task, job category, or the category group level.  This allows the user to setup limits for a 

specific labor category or burden category like G&A.  Conditions for type, category group, job 

category, or resource can also be selected.    
Note: Modification detail creates funding limit lines for fee and task level funding amounts. 

 

The funding limits function can be found in the ribbon of any job card: 

Role Center→Job→Open a job card→Funding Limits 

 

 

 

Job No: Identify the job that you are establishing funding for. 

Job WBS Code: Identify the task that you are establishing funding for. 

Type: Identify the type of funding. 

Options are: 
Labor 

Expense 

Burden 

Fee 

All 

Category Group Name: Identify the category group that you are establishing funding for. 

Job Category Name: Identify the job category that you are establishing funding for. 

Resource No: Identify the resource that you are establishing funding for. 

Funding Limit Amount: Identify the funding limit amount. 

 

Change Tracking: This link opens to the Job Funding Change Tracking Screen.  See 

Modification Detail for more information. 
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Membership 
Membership is the assignment of resources to projects for time and expense entry.  This can be 

setup differently for different tasks on the same job.  Once created, the membership hierarchy can 

be leveraged against multiple jobs, or used for one job only.  

 

To navigate to Membership Setup:  

Setup & Extensions→Manual Setup→Membership 

 

 

 
 

Select “New” to create a new membership group.  This will insert a blank line so you can name 

your group.  To select resources to add to the group click “Details” in the ribbon. 

 

 

 
 

Effective on Calendar Date: This field determines when the membership setup is effective for 

the job.   
Note: Any previous versions of the membership detail setup will no longer be valid to include the visible from/to 

setups. 

Job No: Identify the job that you are setting up membership for. 

Job WBS Code: Identify the task that you are setting up membership for. 

Resource No: Add a resource to give them access to the task in time and expense entry. 

Resource Name: Displays the resource name associated with the resource number selected.  

Visible From: Identify the date that this task should be available to the resource selected. 

Visible To: Identify the date that this task should no longer be available to the resource selected. 
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Approval Hierarchy 
The approval hierarchy setup allows the user to configure different approvers for different tasks, 

even within the same job. This can be setup differently for time, expense and requisitions. Once 

created, the approval hierarchy can be leveraged against multiple jobs. You can use the same 

hierarchy but change the number of approvers and levels that need to be met per job/task.   
 

To navigate to approval hierarchy:  

Setup & Extensions→Manual Setup→Approval Hierarchy 
 

This will open the approval hierarchy list.  Select “New” to add a new group. 
 

 

 
 

Name: Name the approval hierarchy that you are setting up. 

Number of Approval Levels: Identify the number of approval levels in the hierarchy needed. 

Hierarchy Type: Determines how the system looks for approvers.  

Options are: 
Organizational: All employees in the organization can be selected. 

Note: This is used for indirect charges that need to be approved by the employee supervisor. 

Project: The system will look at the membership and hierarchy selections on the WBS table of the job card. 

Note: This is used for direct charges to a project.  Approval should go through the project manager. 

 

Select the group that you are setting up and click Details in the ribbon to open the approval 

hierarchy edit page. This screen assigns approvers to resources and assign a level in hierarchy.   

Note: 0 is the highest level and does not require an approval. 
 

 

 
 

Resource No: Identify the resource that you are setting up approval for. 

Approver No: Identify an approver for the resource. 

Level in hierarchy: This column will populate when the build hierarchy function is run. 

 

Build Hierarchy: This function assigns a level in hierarchy for a resource using the approver 

selections in the table.  The hierarchical view structure is also updated when this is run. 
Note: The resource at the highest level must have a line inserted with a blank approver. 
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Budgeting & Forecasting 
More information on Budgeting & Forecasting setup can be found in the Budgeting & 

Forecasting chapter. 

 

Billing Group 
Billing groups allow you to define tasks that should be invoiced together. The setup is saved and 

can be re used to create invoices.  

 

To Navigate to Billing Group:  

Role Center→Job→Open a job card→Billing Group 

 

The billing group link can be found on the action tab in the ribbon of any Job Card: 

 
 

 
 

 

 
 

Billing Group: Identify the billing group that you are setting up. 

Job WBS Code: Identify the Job WBS Code that you would like to add to the billing group. 

Job Task No: This will be populated per your WBS Code selection on the Job WBS List. 

Job Task Description: This will be populated per your WBS Code selection on the Job WBS 

List. 

Range: A range of WBS codes can be entered here.  When the Add Range function is run in the 

ribbon the billing group screen will be updated with all the tasks in that range. 
Where Used: This is used during sales invoice creation. 
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Chapter 4 – Labor Processing 
 

Resource Card 
See the Resource Card chapter for more information on resource labor related setups. 

 

Benefit Accrual 
See the Application Setup chapter for more information on benefit accrual labor related setups. 

 

Government Contractor Parameters 
See the Application Setup chapter for more information on government contractor parameters 

labor related setups. 

 

Allowances 
Allowances are designed to provide additional compensation above basic compensation.   

 

Code: Enter your allowance type code. 

Description: Enter the description of your allowance. 

G/L Account: Identify the G/L account that should be used for these entries. 
Best Practice: Allowances normally post to an ODC account. 
Bal. G/L Account: Identify the balancing G/L account that should be used for these entries. 

Type: Identify the allowance type.  

Options are: 
Blank – This is the default and should be used if the allowance is not Post Differential or Danger pay. (Ex. 

Hola, Cola) 

Danger Pay – This allowance type is used when an employee is working in foreign areas where conditions 

exist that threaten physical harm or imminent danger to the health or well-being of an employee.   
Post Differential – This allowance type is used when an employee has been working on an eligible post 

during one continuous period of absence away (42 days) from the employee’s post of assignment, to one or 

more differential posts. 

 

Allowance Detail 
 

Code: Enter your allowance type code. 

Destination Code: Identify a destination code if applicable.   
Note: The destination code setup can be found: Departments→Project Accounting→Setup→Destination 

Starting Date: Identify the date that this allowance type should be available. 

Description: Enter the description of your allowance. 

Percent: This is selected if the value field should be calculated at a percentage instead of a 

multiplier. 

Value: This is a dollar value unless the percent checkbox is selected then it is a percentage value.   

The system will calculate the (flat amount x hours) or if % (total cost x % amount). 

 

Pay Rates 
See the Resource Card chapter for more information on how to set up pay rates. 
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Service Contract Act (SCA) 
SCA Rate functionality assists government contractors to comply by the minimum wage 

determination requirements established by the Service Contract Act (SCA) from the U.S 

Department of Labor.  These rates set forth the wages and fringe benefits that prime contractors 

and subcontractors must pay service employees working on covered contracts. 

 

To Setup a Job to enforce SCA wages the following setups are required. 

Navigate to the job card: Role Center→Job→Open the job card 

 

Service Contract Act: This field must be selected on the General Tab on the Job Card.  
Where Used: Enforces SCA rules during the labor distribution calculation in the Time Journal. 

 

When SCA is selected on the job card the system will cross reference the wage determination 

selection on the resource card in order to validate the resource cost for the labor category. 
Note: See the Resource Card chapter for more information. 

 

Job Category 
See the Application Setup chapter for more information on how to setup a Job Category. 
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Time Journal 
The Time Journal is used to import employee timesheets and process labor into NAV.  Timesheet 

lines are imported, comp time and labor distribution functions are run, and unit cost will be 

calculated per employee.  A review of the journal for each employee calculation is then 

performed to ensure that wages have been distributed correctly before posting. 

 

Processing Labor 

Navigate to the Time Journal: Role Center→Journals→Time Journal 

 

Missing Time Report 

The Missing Time report alerts the user if any employees have timesheets that have not been 

started, not submitted, or are Submitted and waiting on approval.  The report will also alert the 

user if any employees have not entered any time on a day that his part of the employee’s 
Timesheet Period Start and End, as defined on the resource card.  This report should be run and 

verified before timesheets are imported. 
 

Import Timesheet  

Select the icon for Import Timesheet on the ribbon.  This will bring in the timesheet lines that are 

submitted and approved for a given timesheet period.  

 

The following filter options are provided for bringing in time.  The default batch will be 

populated with the approved timesheet lines within the filter selection. 

 

 

Timesheet Period: Identify the timesheet period that you are processing.   
Best Practice: Process timesheets with one timesheet period before importing timesheets for the next timesheet period.  

Start Date: This field will be populated based on your timesheet period selection and setup. 

Resource Filter: This filter is for the Resource Number.   
Note:  Use the | or .. filter expression to include multiple resource numbers.  (See page XX for list of all filter 

expressions) 

Department Filter: This filter is for the Department Dimension Value on the resource. 

Timesheet Correction: This is selected if you want to import corrected timesheets. 

 

A separate batch will display for each timesheet.  Select the batch line you are processing and 

click “Edit Journal” in the ribbon to view the timesheet lines submitted. 
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Calculate Compensated Time (Optional)  
Compensated time is an optional benefit that an employer can offer to their salaried employees.  

This allows salary employees to begin accruing any hours worked over a pre-determined global 

accrual selection so they can be used at a later time.  Companies can use the Comp Time function 

to record Standard Time Accounting practices, as opposed to the default of Total Time 

Accounting/Effective Rate calculation. 

 

To use Calculate Compensated Time select the Calc. Comp Time Entries function from the 

ribbon of the Time Journal. 
Note: See Calculate Compensated Time Setup section. 

 

 

 
 

 

Compensated Time Accrued At: Identify the number of hours an employee must work before 

they start to accrue comp time. 

Hours in Pay cycle: Adjust this number to the number of hours in the pay cycle you are 

processing.   
Note: The system will default the number of hours in the pay period from the timesheet period.  If this is an auto-split 

week scenario the hours in the pay cycle will be prorated. 

Note: The Time Journal will populate with up to two negative line entries.  A negative line for the amount accrued 

using the Comp Time Earned job and a negative line for the uncompensated time if applicable.   
Note: This is a global setting NOT by employee.  
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Calculate Labor Distribution 
This function will distribute employee’s salary across the total number of hours worked and be 

applied to each line on their timesheet.   
Note: Labor distribution is calculated per the Labor Dist. Calc. Method selection. (See Resources Setup for more detail) 
 

Role Center→Journals→Time Journal→Import Timesheet 

Select the Calc. Labor Distribution icon in the ribbon of the employee time journal.   

 

 

  

 

The cost and price columns in the Time Journal will be updated accordingly.  Verify that they are 

being populated accurately.  Total cost for a salary employee should be equal to their pay amount 

on the resource card. 
 

Leave without Pay (LWOP): You may use LWOP hour entries to reverse hour entries by inserting a new line to 

reduce the net pay by the hours not worked. 

Rounding: A rounding entry will be created when the employee salary is not distributed evenly over the hours worked.   

Note: See to job card chapter for more detail. 

Common Errors:  

Unit Cost: If this field does not populate, verify the quantity of hours column is populated and that the resource has a 

rate entered. 

Unit Price: If this field does not populate, verify that the Labor Category Code is populated on the job setup.  

Unit Price: If this field does not populate as expected, verify the SCA flag and resource prices on the job. 

 

ADP Export Hours Only   

Creates a file that is used to export hour data to ADP.  Enter the Batch ID that you use in ADP. 
Best Practice: Batch ID should be 001. 
 

ADP Export Hours and Earnings 

Creates a file that is used to export hour and dollar data to ADP.  Enter the Batch ID that you use 

in ADP. 
Note: For more detail review the “ADP Export File for an hourly and salary employee” testing scenario. 
 

PayChex Export 

Creates a file that is used to export hour and dollar data to PayChex. 

Create Sub Cont. Invoice 

This function is used when subcontractors enter time using the NAV WTE system.  This time 

must be processed through the purchasing module in order for it to appear as expenses against the 

job.  The G/L account it uses comes from the Job Category Resource Class.  The resource card 

must have the correct class code setup. 
Note: This function will create one purchase invoice per sub-contractor across all batches.  
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Calc. Allowance Entries 

This is used to calculate additional allowances such as hazard pay.  The selection screen will open 

to identify the Job G/L Journal Batch that you would like the allowance entries to populate to 

once the function is run.   
Note: See Allowance Setup for more detail. 

 

Time Journal Errors Report 

The Time Journal Errors report alerts the user of any errors that will prevent any time journal 

lines from posting.  It will also identify errors that will not be caught by posting validation such 

as if any lines do not have a unit cost, or whether lines charged to a T&M job are missing a unit 

price.  This report should be run and verified before the time journal is posted. 

 

Corrections to Labor  
Navigate to the Time Journal: Role Center→Journals→Time Journal→Import Timesheet 

 

 

 

 

Importing Timesheet Corrections and Reversing Prior Timesheets 

Correction timesheets which have been submitted and approved are brought into the Job Time 

Journal by running the “Import Timesheet” function and placing a checkmark next to “Correction 

Timesheet.”  Once the correction lines are in the Job Time Journal, run the labor distribution from 

the ribbon of the Job Time Journal in order to calculate unit cost and price.  Afterwards, 

individually open each correction batch and run the “Reverse Timesheet” function in order to 

back out the original timesheet by creating negative line entries.  After “Reverse Timesheet” is 

run for each batch, post the Correction entries.     
Note: Corrections post in the current time period. 

 

 

TM Retro Billing Adjustment 

This is used for T&M projects that have timesheets that were processed in a prior pay period 

using an old rate and are now approved for a retroactive rate increase.  Upon approval, this 

function can be run to create adjustment journal entries for the difference.  Once the entries are 

posted a new invoice can be generated to bill the additional amount. 

 

The filtering options are: 
Job No. 

Job WBS Filter 

Date Filter Start 

Date Filter End 
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Note: Make sure the new Labor Category rate is updated on the Job Card.  Resource Price and Resource Labor 

Category links in the ribbon should be updated with the new code, rate, and starting date.  
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Verification 
The Time Journal has links to reports that will assist with verification to help prevent errors from 

being posted.  

 

 

 
  

Time Journal Summary  

The Time Journal Summary report provides a summary view of the employee timesheets.  The 

information is summarized in four different ways to include: Employee Summary, Project 

Summary, Time Posting Group Summary, and G/L Account Summary.  When generated, the 

report is displayed in a Print Preview format that allows the user to print or save in various file 

formats. 

 

Time Journal Errors 

The Time Journal Errors report displays any common setup or data errors that may affect posting 

or labor distribution.  These errors should be corrected before timesheet lines are posted. 
Common Errors: No cost, no price, or blocked task code. 

 

Missing Time 

The Missing Time report is used prior to the import of your timesheet lines.  All time must be 

submitted and approved before the Import Timesheet function is run. 

Options are: 

Time Starting Date: Identify the first day of the time period  

The purpose of the next two fields are for DCAA auditor requests for a floor check of entered time.     

Floor Check Date: Identify the date that you are checking for completed timesheets   

Floor Check: This is selected when a floor check is needed 

Include Waiting For Approval: This is selected to include timesheets that are waiting for approval 

Ignore Sub-Contractors: This is selected to filter out subcontractors if they are not using WTE in NAV 

 

Posting 

Once all processing and verification has been completed the timesheet lines can be posted.   

 

The Post link is located on the ribbon of the Time Journal: 

 

 
 

The system will prompt with the message asking the user if they are ready to post.  Click Yes and 

your timesheet lines will be posted to the general ledger, the job ledger, and the resource ledger. 

Labor Reports 
The following labor reports provide an analysis on labor transactions and utilization.  
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To navigate to the labor Reports: Role Center→Reports 

 

Labor Utilization 
Report Type: Identify the labor utilization report you would like to view. 

Options are: 
Utilization By Employee: This report displays unposted & posted labor entry amounts/utilization 

percentages for the current period (selected on the report selection page using the posting date filter) and 

YTD utilization for posted time. 

Summary By Category: This report displays current/YTD posted labor entries, utilization percentage, 

budgeted amounts, and variance percentages by labor category.   
Utilization Trend: This report displays the labor utilization percentage by employee and by month. 

Starting Period: Identify the starting period for your report. 

Ending Period: Identify the ending period for your report. 

Summary Only: This will summarize the report. 

Resource No. Filter: Filter for specific resources. 

Labor Category Filter: Filter for specific labor categories. 

 

Labor Analysis 
Trend: This allows you to choose to view this report by week or by month. 

Column Info. To Print: Choose how you would like the report measured. 

Options are: 
Hours  

Cost 

Spent  

Billed 

Period: Identify the accounting period for your report. 

Starting Date: Identify the starting date for your report. Defaults from period selected. 

Ending Date: Identify the ending date for your report. Defaults from period selected. 

Job Group Filter: This allows you to filter the report by Job Group. 

Department Filter Resource: This allows you to filter the report by department. 

Include Un-posted Time: If selected, un-posted time will display on the report. 

Group By 

Layout: Choose your report layout.   

Options are: 
Individual by Job: Provides a summary of hours sorted by each employee and then project by period. 
Job by Individual: Provides a summary of hours sorted by each project and then employee by period. 
Job Task by Individual: Provides a summary of hours sorted by each task and then employee by period. 

Department by Individual: Provides a summary hours sorted by each department and then employee by 

period. 

Columns 1-5: The report columns can be displayed on the report in any order based on your 

column selections 1-5. 
Note: A selection in the layout field will populate related columns.  They can then be modified per the user’s needs. 

Options are: 
Resource 

Job Contract Type 

Job 

Job Task 

Resource Department 
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Timesheet History 
This report provides a summary of direct hours by employee sorted by pay type. 

Print Transaction Detail: If selected, the employee daily timesheet line details will display. 

Print Transaction Summary: This will roll the hours up to the project and then employee. 

Project Filter: Filter the report for a specific project. 

Wbs Filter: When a project filter is selected you can also select a WBS filter for the report. 

Labor Posting Group Filter: Filter the report for a specific labor posting group. 

Hide Cost: Will hide cost from this report. 
Note: DCAA will request this report to show labor distribution for employees.  



71 
Revision 1.10 

Chapter 5 – Purchasing 
 

Purchase Orders 
Purchase Orders are used to quote, order, receive, and invoice orders.  This includes purchase 

orders for subcontractor labor.  
 

To navigate to Purchase Orders: Role Center→Purchase Orders 

 

 

 
 

General Tab 

No: Create the purchase order no. by tabbing through the field by referencing the no. series setup. 

Buy-from Vendor No: Identify the Vendor No. from the vendor list.  

Buy-from Contact No: This field is not normally used.  Requires additional setups in the 

marketing module.  The contact name text field is used on the vendor card instead. 

 

The following fields will be auto populated with the vendor information from the vendor card 

when the vendor no is selected:   
Buy-from Vendor Name 

Buy-from City 

Buy-from State/Zip Code 

 

Posting Description: This field will pre-populate and references the purchase order number. 

Posting Date: This is the transaction date.  It is updated before receiving and before invoicing.    

Order Date: The date that the order is placed with the vendor. 

Document Date: The date on the vendor invoice. 
Where Used: This date is used to calculate the invoice due date. 

Vendor Invoice No: Identify the vendor invoice number. 

Requisition No: Populated by web requisitions. 

Status: The status of the purchase order is displayed. 

Options are: 
Open  

Released 

Pending Approval 

Pending Prepayment 
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Lines 

Type: Identify the type of transaction you are posting. 

Options are: 
G/L Account 

Item 

Fixed Asset 

Charge (Item) 

No: The G/L account number will be populated and displayed here after job category and 

resource has been selected on the line.  Tab through this field. 

Job No: Identify the Job number. 
Note: The selection here will determine the list that displays in the Job WBS Code field. 

Job WBS Code: Identify the task number. 

Job Category Name: Identify the category name. 

Subcontract No: Identify the subcontractor number.  (If applicable) 

Resource No: Identify the resource number.   

Timesheet Date: Identify the date that the expense occurred. 

Description: The description will pre populate based on your Job Category selection. 

Quantity: Identify the quantity. 

Unit of Measure: Identify the unit of measure.  (Ex. Hour) 

Direct Unit Cost Excl. VAT: Identify the unit cost without tax. 

Line Amount Excl. VAT: This number will be calculated and populated from your quantity and 

unit cost entries. 

Qty. to Receive: Identify the quantity that you are receiving. 

Qty. to Invoice: Identify the quantity that you are invoicing. 

Department Code Dimension: The dimension code will pre-populate from the job card selected. 

Quantity Received: This field will display the total quantity that has been received.  

Quantity Invoiced: This field will display the total quantity that has been invoiced. 

 

Invoicing 

Pay-to Vendor No: Identify the Vendor No. from the vendor list. 

The following fields will be auto populated with the vendor information from the vendor card 

when the vendor no is selected:   
Pay-to Name 

Pay-to City 

State/Zip Code 

 

IRS 1099 Code: This is defaulted from the vendor card. 

Department Code Dimension: This defaults from the vendor card.  The account payable entry 

created will use the dimension code selected in this field. 

Payment Terms Code: This defaults the payment terms from the vendor. 

Due Date: Due date is calculated using the payment terms code and the document date selections. 

Buyer Code: Populated by the web requisition. 

 

 

 

 

 

 

 

 

 

 

Release: Once your purchase order has been 

created, the release function finalizes the request.   

Post: When the items are received the post function 

can be used to record that it has been received and 

an invoice can be created.  These functions can be 

done independently or at the same time. 
Note: The Qty. to Receive and Qty. to Invoice columns should 

be updated on the lines before running the function. 
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Purchase Credit Memos 
 

Purchase credit memos are used to provide a credit back to a vendor on a posted purchase order. 

 

To navigate to Purchase Credit Memo:  

Role Center→Purchase Credit Memos 

 

This will bring you to the purchase credit memo list.  Select New in the ribbon to open a new 

purchase credit memo card. 

 

 

The fields on the purchase credit memo are the same as the purchase order.  See the purchase 

order section for a description of the fields.   

 

Subcontracts 
Subcontracts are created in NAV and can be approved by project manager’s using the Microsoft 

SharePoint integration.  Once approved, a purchase order can be generated from the subcontract 

using the Make Order function in the ribbon of the Subcontract Card. 

To navigate to Subcontracts: Role Center→Subcontracts 
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General 

No: Identify the subcontractor number. 

Job No: Identify the job number. 

Job Task No: Identify the job task number. 

Buy-from Vendor No: Identify the vendor number. 

Description: This field will populate per your vendor number selection. 

Subcontract Type: 

Options are: 
Time & Material 

Firm Fixed Price 

Cost Plus Fixed Fee 

Starting Date: Identify the starting date of the job/task. 

Ending Date: Identify the ending date of the job/task. 

Contract is for: 

Options are: 
Job 

Job Task 

Funding By Category Group: This is selected if the funding should be from the category group. 

Status: 

Options are: 
Open 

Pending Approval 

Approved 

Rejected 
Funded Amount:  

Obligated: 

Expended:  

 

Subcontract Line 

Category Group: Identify the Category Group for the line. 

Job Category Name: Identify the Job Category for the line. 

G/L Account No: The G/L Account No will populate per the Job Category Name selection. 

Description: The description will populate per the Job Category Name selection. 

Enforce Hours: 

Funded Hours: Identify the funded hours for the line. 

Funded Amount: Identify the funded amount for the line.  
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Chapter 6 – Billing 
 

Job Card 
See the Job Card chapter for more information on how to set up a job. 

 

Billing Group 
See the Job Card chapter for more information on how to set up a billing group. 

 

Billing Formula 
See the Application Setup chapter for more information on how to set up a billing Formula. 

 

Invoicing 
Create Planning Lines 

Job planning lines are used to plan and invoice job expenses.  As expenses are incurred, the 

system will create planning lines automatically for T&M and cost plus jobs.  

 

Planning line and invoice creation for Firm Fixed price type contracts is a manual process.  The 

system will need to be told when to create them and what they should be.  The planning lines will 

then be populated and waiting for verification when the planning line table is opened.  

 

To navigate to the job planning lines table:  

Role Center→Job→Select a job→Job Planning Lines 

 

The Job Planning lines link can be found in the ribbon of any job card: 
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Planning Date: This is the date the transaction/expense was incurred. 

Document No: The document number from the expense transaction. 

Job No: Identify the job that the task is related to.  This field will default from the job selected. 

Job WBS Code: Identify the related task. 

Job Category Name: Identify the job category. 

Type: Identify the type of cost being billed. 

Options are: 

Resource: Used for labor billing. 

Item: Used for item billing.  Not normally used for government contracting. 

G/L Account: Used to invoice non-labor, burdens, and fee. 

Text: Used to print additional verbiage on the invoice. 

No: The no. field will open to the corresponding list to your type selection. 

Description: Enter a description. 

Department Code: Identify the department code. 

Unit of Measure Code: Identify the unit of measure. 

Quantity: Enter the quantity. 

Unit Price: Enter the price. 

Line Amount: The system will calculate the line amount from the quantity and unit price 

entered. 

Qty. Transferred to Invoice: Enter the quantity that you are invoicing. 

Qty. Invoiced: This field will update after you transfer your lines to the invoice.  

Invoiced Amount (LCY): The total amount of the items invoiced. 

Invoiced Cost Amount (LCY): The total cost of the items invoiced. 

Job Contract Entry No: This is a display field only.  It is used internally to track the planning 

line if the line type is resource. 

Pay Type: Enter the pay type.  

Vendor No: Identify the vendor. 

Ignore for Billing: This should be checked when the item has not been used yet and cannot be 

invoiced to the client this period.  This line will be saved and can be invoiced at a later time by 

unchecking. 
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Copy Planning Lines 

The copy planning line function is used to create recurring planning lines for firm fixed price 

billings for future periods.  The link is in the ribbon on the Navigate tab of the planning line table.   

 

No of Copies: The number of times the line will be copied. 

Starting Planning Date: The date that will be used for the first line inserted.  The date of the 

subsequent lines will be adjusted by the selection in the increment by field. 

Increment By: Identify a date formula for the system to use for multiple line creation. 

 

Create, Post, and Print Invoices  

The create invoice function is found in the ribbon of the job.   
Note: Invoicing is a manual process for FFP contracts.  The system will need to be told when to create invoices. 

 

 

 
 

 

 
 

Job No: Identify the job that you are invoicing.  This field will default from the job selected. 

Billing Group Name: Identify the billing group that you are creating an invoice for.  It should be 

noted that when multiple billing groups exist, the Task, Funding and Contract type information 

will display from the Task Card of the first task in the billing group. 

Multi-Select: This is used when generating multiple invoices for the same job.  The multi-select 

field on the billing group table must be selected. 

Period From: The starting date of the billing period you are invoicing.   
Note: Prior period lines not invoiced will be included.  Use ignore for billing to exclude from the current invoice. 

Period To: The ending date of the billing period you are invoicing. 

Invoice Proposals 
Once the invoice has been created you can view the proposed invoices from the invoice proposals 

function on the ribbon of the job card to verify the information before posting and printing. 
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Select Invoice Proposals to open a list of proposed invoices.  Select an invoice and click Edit. 

 

 

 
 

This will open the proposed sales invoice page for review, edits, posting, and printing.  

Note: Preview mode is used to preview the invoice before posting. Do not print from this screen as it will print text on 

the invoice indicating that it is the preview version. 

 

Invoice Printing Options 
When an invoice is opened, several printing options are made available by selecting “Print GC 

Invoice” from the ribbon. 

Group By: Determines how items are grouped on the invoice:  

• “Category Group” displays items by Category Group, but will not segregate employee 

and subcontractor / consultant labor.  

• “Category Group + Labor Type” will segregate employee and subcontractor / consultant 

labor.  

• “Cost / Fee” places all cost items at the top of the invoice, and all fee items below it. 

Summarize: Allows you to either summarize labor costs by Resource or Labor Category. 

Inception To Date: Select if you want Inception To Date billings to appear on the invoice. 

Roll-Up: Select to specify the WBS level to roll the billings up. 

Subtotal By Task: Select if subtotal is to display by task. 

Print Contract Line Item: Select if CLIN needs to print on invoice. 

Print Company Address: Displays the company address in the invoice header. 

Print Pmt Office Address: Displays the payment office address in the invoice header. 

Show Billing Period: Displays the Billing Period in the invoice header. 

Show Period of Performance: Displays the Period of Performance on the invoice header. 
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Show Cert Lines: Displays the certification code lines on the bottom of the invoice. 

Document Type: “Posted Invoice” should be selected. 

Document No: The invoice number to be displayed should be selected. 

Credit Memos 

 

Credit memos can be created using the Create Sales Credit Memo function in the ribbon of the 

job planning line table. 

 

To navigate to Credit Memos: Role Center→Jobs→Open a job card→Job planning 

Lines→Create Sales Credit Memo 

 

 

 
 

 

Create New Credit Memo: This field will be checked by default.  Uncheck if appending only. 

Posting Date: The date the transaction will be recorded in the general ledger. 

Applies-to Invoice No: Identify the invoice to reverse. 

Append to Credit Memo No: Will add lines to an existing credit memo. 

Cr. Memo Posting Date: Identify the date that you are posting the credit memo. 
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Chapter 7 – Cost Allocation 
 

Allocation functionality is used to move indirect costs to intermediate pools and finally to 

projects.  This functionality is very flexible, designed to meet demanding requirements of 

growing companies.  The allocation setup drives cost allocations and billing of indirect costs.  

The monthly allocation process does not impact billing of cost plus projects.  The allocate costs 

routine can use provisional or final rates and is found in the periodic activity menu.   

 

Allocation setup involves creating a line (called a pool) for each group of costs (Ex. Overhead) 

and defining the G/L account range for such costs.  A pool must also have a range of G/L 

accounts that the cost is related to (base).  (Ex. The base for fringe would be labor g/l accounts.) 

 

When defining a pool, there are three setups that are required.   

1. Define the G/L account range(s) that represent the Pool and Base. 

2. Define the department(s) that belong to the pool. 

3. Calculate the actual rate and distribute cost from the pool to the job. 

 

Account Setups 
Cost Pool Account Set 
The cost pool account set defines a range of accounts for the base & pool.  (Step 1 above) 

 

To navigate to cost pool account set:  

Setup & Extensions→Manual Setup→Cost Pool→Account Set 

 

 
 

 

 
 

 

Name the cost pool account set that you are setting up and click Details in the ribbon. 

 

 

 
 



81 
Revision 1.10 

Effective Date: The date that the cost pool account set will be effective. 

From Account: Identify the starting g/l account number in the cost pool account set. 

To Account: Identify the ending g/l account number in the cost pool account set. 
Note: Multiple lines can be used for breaks in the cost pool account set. 

Cost Pool Department Set 
The cost pool department set assigns a range of departments when defining the pool & base.  The 

department range further restricts the costs that are part of the pool calculation. 

 

To navigate to cost pool department set:  

Setup & Extensions→Manual Setup→Cost Pool→Department Set 

 

 

 
 

 

 
 

Name the cost pool account set that you are setting up and click Details in the ribbon. 

 

 

 
 

Effective Date: The date that the cost pool department set will be effective. 

From Department: Identify the starting department for the cost pool department set. 

To Department: Identify the ending department for the cost pool department set. 
Note: Multiple lines can be used for breaks in the cost pool department set. 
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Pool Setups 
The Cost Pool Setup table is used to define the various cost pools and the sequence for allocating 

cost.  This table also defines which pools will allocate to projects.   

 

To navigate to cost pool:  

Setup & Extensions→Manual Setup→Cost Pool 

 

 
 

Sequence: This field provides the order in which cost pools will generate allocations. 

Name: This field is used to identify the type of indirect cost you are setting up. 

Job Category Actual: Identifies the account used to allocate actual cost to jobs per job category. 

Job Category Actual Offset: Identifies the account number used to record the contra amount for 

actual cost to jobs.  This ensures the allocation has a zero impact on net income per job category. 

Job Category Provisional: This field is used to identify the account number used to allocate 

provisional cost to jobs per job category. 

Job Category Provisional Offset: This field is used to identify the default account number used 

to record the contra amount for provisional cost to jobs per job category. 

Department Set Name: Identify the department set that defines the base departments. 

Department Actual: This field is used to identify the account that cost is distributed to.  When 

setting up the distribution (See Allocation) you can override the G/L account.  For a fringe pool, 

you would select the G/L account in the direct account range.  This is where the fringe to direct 

distribution goes.  Same would be true for G&A and Overhead. 

Department Actual Offset: This field is used to identify the contra account used when cost is 

distributed to departments.  For example, the contra for a fringe pool would be an account directly 

below the last fringe account. 
Note: The cost account group of the job category can be overridden here for Fringe & OH for B&P/IR&D projects. 
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The following functions can be found in the ribbon of the cost pool setup screen. 

Pool Cost & Base: The pool cost and base table is used to define how the indirect rate will be 

calculated.  The denominator is often called the base in Government Contractor terminology. 

 

 
 

Pool: Check this column to indicate that this row is the numerator in the “Pool Cost & Base” 

setup screen. 

Account Set Name: This field is used to define the account set that defines the base or pool G/L 

accounts. 

Department Set Name: This field is used to define the department set that defines the 

departments in the pool. 

 

Allocation: The allocation setup table is used to define the distribution of cost to various pools 

and ultimately to projects.  It is extremely important that the range of account in the allocation 

setup match the accounts in the base denominator of the “Pool Cost & Base” Setup. 

 
 

Account Set Name: This field is used to identify the pool account set from the base. 
Note: Both actual & provisional rate based calculations are done and posted to the project and general ledger. 

Department Actual: This field is used to override the department actual account selected on the 

cost pool setup. 

Actual to Department: When selected, the distribution uses actual rates and is allocated to the 

departments in the pool. 

Actual to Project: The cost will be allocated to the project using the actual rate. 
Note: If actual to department and actual to project are both set up the allocation will be run through the department 

before being allocated to the project. 

Provisional to Project: If selected, the cost will be allocated to the project using the provisional 

rate. 

Provisional Rate: The cost pool provisional rate table is used to identify the provisional rate and 

the final rate that should be used in the cost pool calculation.   
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Starting Date: Identify the date that the rates are effective and should begin being used for cost 

pool calculations. 

Provisional Rate: Identify the provisional rate percentage. 
Where Used: The provisional rate will be used for billing pool calculations. 

Final Rate: Identify the final rate percentage. 

 

Actual Rate: The cost pool actual rate table displays the rate calculated and is updated each time 

allocations are run.  

 

 
 

Starting Date: This field identifies the effective date of the actual rate. 

Actual Rate: This field identifies the actual rate that should be used on the starting date selected. 

 

Copy Pool: The copy pool function is used for original setup to efficiently create multiple pools 

that have similar pool structure.  
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Allocate Costs 
The allocate costs function should be run once a month in order to allocate costs. 

 

To navigate to Allocate Costs:  

Role Center→Actions→Manage→Allocate Cost 

 

 
 

Accounting Period: Identify the accounting period that you are allocating costs for. 

Cost Pool Group: Identify the cost pool group that you are allocating costs for. 

Use Final Rate: If selected, the final rate will be used for the calculation.  
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Chapter 8 – Revenue Recognition 
Revenue recognition is the process of accruing revenue at the month end and reversing the 

accrual upon invoice posting.  When accruing revenue, the G/L account used is “Accrued 

Revenue” the offset is unbilled (WIP Sales Account).  Fixed price projects can recognize revenue 

using the estimate to complete worksheet.   

 

The following two periodic activity routines are used to recognize revenue. 

1. Calculate Revenue Accrual 

2. Post Revenue Accrual 

These routines will post a debit to your WIP Sales Value account (Unbilled receivable account on 

the balance sheet) and credit accrued revenue.   
Note: The G/L selection process for postings is explained in detail in the Job Posting Section of the user manual. 

 

Revenue Recognition Setups 
The setup fields for revenue recognition calculations are found on the job card and the task card.  
Note: See the Job Card chapter for additional information on the fields.  

Role Center→Job→Open a job card→Work Breakdown Structure→Open task card 

 

 

The Task Detail link on the Work Breakdown Structure setup page will open the task card. 

 

The revenue recognition formula selections must be populated on the task card.  If the formula 

selection is made on the job card before the creation of the tasks, the selections will be defaulted 

on the task card from the job card.  If the tasks are created prior to the selection on the job card, 

the task selections will be blank.  After task creation the job card selections are only there for 

reference and do not affect revenue recognition calculations or task card selections. 

Best Practice: If revenue recognition calculations should not be performed on the job leave the field selection blank or 

create a DNC revenue formula for “Do Not Calculate”.  Set the control field to “disabled”.  
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Periodic Activities 
Calculate Revenue Accrual 
This function will calculate the revenue accrual and used with the review and post revenue 

accrual function. (Step 1 above) 

Role Center→Actions→Manage→Revenue Accrual→Calculate Revenue Accrual 

 

 
 

Select the Accounting Period and click OK to run the calculation. 

 

Review and Post Revenue Accrual 

Role Center→Actions→Manage→Revenue Accrual→Review and Post Revenue Accrual 

 

 
 

This function should be run at least two times.  The first time should be a preview of the 

calculations without the Post checkbox selected.  Once the calculations have been reviewed and 

the user is ready to post, the function should be run a second time with the checkbox for Post 

selected.   (Step 2 above) 
Best Practice: Fixed price revenue recognition use the estimate to complete method. 
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Chapter 9 – Job Budgeting & Forecasting  
 

The budgeting and forecasting function is used to budget costs and calculate revenue related to a 

direct project.  It is also used to calculate costs related to non-direct projects.  For example, when 

planning a forecast of fringe costs you can create a budget that calculates your health insurance 

costs that can then be allocated to a fringe project.  This will give you a total fringe cost for 

forecasting purposes. 

 

The Budget & Forecasting link can be found in the ribbon of any job card:  

Role Center→Job→Open a job card→Budgeting Govt. Con. 

 

 
 

General Tab 

View by: Identify the increment of time that you creating a budget for. 

Options are: 
Day  

Week 

Month 

Quarter 

Year  

Accounting Period 

Job No: Identify the job number that you creating a budget for. 

Job Task No: Identify the task number that you creating a budget for. 
Note: This is not required when entering a job budget and this field acts as a filter for the job budget.  

Budget No: Identify the budget number. 
Note: Job Budget No. 1 is the baseline budget. 

Labor Entry: Identify how you would like labor to display.  
Options are: 

Hours 

Price Amount: Hours x Unit Price (Billing Rate)   

 

 

 

Budget Matrix 

The budget matrix is used for budget creation.  Lines are added to the matrix using the Add 

Resource and Add Other functions in the ribbon.  The Description and Job Category Name 
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fields in the lines will be prepopulated per the resource card selection and setup.  The rest of the 

fields on the lines are blank and should be updated to create the budget. 
Note: When viewing values on the job budget matrix page, the values are displaying the price value associated with the 

budget entry and not the cost value. 

 

 
 

Add Resource 
Lines are added to the Budget Matrix using the Add Resource function in the ribbon.  
Note: The system will verify that the labor category being budgeted against is assigned to the job account group (if 

restrict to labor categories listed is marked yes). 

 

 

 

Add Other 
The Add Other function in the ribbon is used to add other project costs like material or travel to 

the budget matrix.  The selection will be made from the Job Category List. 

 

 

 

Forecast Pool 
This table is used to select the billing group that will be used to calculate indirect costs to be 

allocated to direct job budgets. 
Note: A billing group that matches the company’s cost pool structure must be setup along with having the setup equals 

cost pools field marked yes.  
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Re-Calculate Totals 
This function is used to re-calculate totals in the budget matrix if there have been changes to the 

number inputted. 
Note: This function will allocate indirect costs based on the provisional rates and will allocate indirects related to 

revenue/billing based on the Job Billing Group assigned to the job card.  

 

 

Forecasting 
PVBS will release enhanced forecasting functionality into the Job Budget & Forecasting module 

at a later date.   

 

Allocate Forecast 
This function uses the allocations setup and the forecast rate to populate a new budget.   
Note: It will populate a budget with the same budget number. 

 

Forecast Rate 
The forecast rate is calculated by the “Calculate Rate” function. 

 

Billing Pool Formula & Group 
See the Application Setup chapter for more information. 
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Chapter 10 – Timesheets 
 

Web Setup  
This window defines how users enter time and expenses into WTE, sets up email notifications, 

and helps establish the business rules for the company in NAV. 

 

Navigate to Web Setup: Setup & Extensions→Manual Setup→Web Setup 

 

General Tab 

Email Notification: This is selected if any form of email notification will be used from WTE.   
Note: If this is not selected, all subsequent email setups will not function.  

Note: The IT department will need to complete the SMTP setup page: SMTP server, port, and account information 

needed. 

Reporting Services URL: This is populated with the URL for the company WTE reports.  This 

URL is setup using the SQL Reporting Service Site.   

Company Logo URL: This is populated with the URL for the company logo.  Will display the 

logo on your login screen. 

 

Business Rules Tab 

Minimum hours required for salaried employees per pay cycle: Enter minimum hours per pay 

period cycle.  This is only used with weekly or bi-weekly. 

No more than 24 hours in a day: This should be set to yes. 

No overtime if less than 40 hours per week: If selected, employees will not be able to add an 

OT timesheet line until they have 40 regular hours recorded. 

Sick leave balance cannot go negative: If selected, employees will not be able to use sick leave 

that has not been accrued yet.  This setting is only for sick time. 

Quarter hour increments only: If selected, employees can only charge time in quarter hour 

increments. 
Best Practice: It is recommended to not allow any less than ¼ hour increment.  ½ hour is preferred. 

 

Weekly Regular Hours: 

No more than 40 hours regular: If selected, employees will not be able to log more than 40 

regular hours per pay week.  This calculation is based on the “Base Pay Type”. 

Enforce for hourly employees only: If the above field is selected this field determines if the 

limit on hours is valid for hourly employees only. 

Email notification: This is selected if any form of email notification will be used from WTE.   
Note: If this is not selected, all subsequent email setups will not function.  

Send email on submitting timesheet: Email is sent to the time approver upon timesheet 

submission. 

Send Daily Reminder: Email is sent to an employee if time is missing from the previous day. 

Copy approver on daily reminder: If selected, the approver will be CC’d on the missing time 

reminder. 

Daily reminder at: Identify the time that the daily reminder email should be generated.  
Best Practice: This is normally set to 10 AM. 

Send period end timesheet reminder: A reminder email is sent at the end of a pay period. 

Period end reminder at: Identify the time that the period end reminder email should be 

generated. 

Copy approver on expense approval: If selected, the approver will be CC’d on expense report 

approval email notifications. 

Copy approver on requisition approval: If selected, the approver will be CC’d on requisition 

approval email notifications.  
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Additional Setup  
 

See the Application Setup chapter for more information on the following: 

Benefit Accrual Setup 
The benefit accrual setup is used to collect sick and vacation time.   

Two setups are needed:  

1. Benefit Accrual Code  

2. Job creation for the benefit 

Timesheet Period 

Time Zones 

Working Time Calendar 
 

See the Job Card chapter for more information on the following: 

Membership 

Approval 
 

Reports 
The resource card displays two reports that give a summary of PTO hours earned and used. 

 

To navigate to resources: Role Center→Resources→Open a Resource Card 

Open a resource card and the report links are displayed in the ribbon. 

 

 
 

PTO Balance Report 

The PTO Balance Report displays the breakdown of PTO hours a resource has earned and used 

per work week for the year within your “As of Date” selection. 

 

The filter options are as follows: 
As of Date: The report results will be filtered as of the date selected here for the year of the selection only. 

 

Leave Accrual Verification 

The Leave Accrual Verification report displays a summary of PTO hours earned and used for 

each resource. The report displays PTO Hours and Accrual Amounts per resource.  The amount is 

calculated as Accrual Hours multiplied by Standard Hourly Rate for employee.  Standard hourly 

rate is calculated as Employee Gross Wages in a timesheet period divided by the resource’s 

timesheet hours in that pay period.  This report should be periodically reconciled with the PTO 

Register, which calculates based on posted PTO accrual dollars. 

 

The filter options are as follows: 
As of Date: The report results will be filtered as of the date selected here for the year of the selection only. 
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Per Diem Setup 
A Per Diem is a specific amount of money that an employee can use and be reimbursed per day, 

to cover living and traveling expenses in connection with work.  Base Per Diem Rates are 

established by the DOD (Department of Defense) and GSA (General Services Administration) for 

government workers.  These are used as guidelines for the majority of government contractors but 

may be adjusted per company policy. 

 

The Per Diem Rate Table will be updated by your per diem rate imports but can be adjusted in the 

per diem rate table.  Additional lines can also be added if required by contracts or company 

policy. 
 

Navigate to the Per Diem Rate Table: Role Center→Actions→Manage→Per Diem Rate 

 

 

Line No: Enter the line no. for the per diem rate. 

State: Populate the state abbreviation (two letter code) that this per diem rate is effective for. 

Primary Destination: Populate the city that is per diem rate is effective for. 

County: Populate the county that this per diem rate is effective for. 

Starting Date: Identify the date that this rate should be made available. 

Ending Date: Identify the date that this rate should no longer be made available. 

Lodging Amount: Populate with the per diem lodging amount for this location. 

Default: This is selected if this is the default amount.  There must be one default selection in the 

table. 

MIE Code: This field maps to the meals and incidental expenses code/per diem amount for this 

location.  

 

Per Diem Rate Imports 

Per Diem Rates can be downloaded from the GSA or DOD websites.  Conus rates are usually 

updated every fiscal year, effective October 1 each year.  Oconus rates are updated monthly.  

NAV will need to be updated with the new rates via the per diem rate import function.   
Note: See appendix B and C for more information on creating the import files.  

 

Navigate to the Conus Per Diem Rate Import:  

Role Center→Actions→Manage→Conus Per Diem Rate Import 

Navigate to the Oconus Per Diem Rate Import:  

Role Center→Actions→Manage→Oconus Per Diem Rate Import 

 

Work Breakdown Structure 

See the Job Card Chapter for more information on the Work Breakdown Structure and setup.  
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Timesheet Entry 
 

Navigate to: Role Center→Self Service→Timesheets 

 

Click New Timesheet to select your timesheet period.  The timesheet entry screen will open with 

the timesheet lines for the period selected. 

 

  
 

Select New Line in the ribbon to and add a line to your timesheet. 

 

 
 

Make your selections and click Save to insert a timesheet line.   

Once the timesheet line has been created, the hours can be added directly to the applicable field 

on the timesheet line.  

 

 
 

Select Comment from the ribbon to add additional information about the timesheet line.  
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Once a comment has been entered, click close to close the comment box. 

 

Favorites 
Favorite job/wbs codes can be saved using this function for quick population to timesheets. 

Set Delegate 

Select a resource that is approved to enter time on your behalf. 

Enter On Behalf Of 
This dropdown will display all employees that have selected you in the Set Delegate field.  Select 

the user you are entering time for.  All normal functionality will be accessible.  

 

Save/Submit 
When the user has completed their timesheet they should click Save and/or Submit in the ribbon.   

Note: Timesheets need to be saved before opening a different timesheet period to ensure all lines created are saved.  

Correction 
Correction Timesheets are used to edit entries to approved timesheets.  When used, a blank 

correction timesheet will be created with the same functionality as a normal timesheet.  This 

timesheet is then submitted and approved like a standard timesheet.  Upon approval, the 

correction timesheet is processed by accounting.   
Note: See the labor processing chapter for more information on processing corrections. 

 

 

The Correction icon can be found in the ribbon of the timesheet tab.   
Note:  See the Labor Processing chapter for more information on how to process correction timesheets. 
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Approvals 
Navigate to: Role Center→Self Service→Approvals 

Select the item that you would like to review to open the details on the page. 

 

The Approve and Reject functions can be found in the ribbon.  

If approvals have been delegated to the user, select the Approve on Behalf Of link in the ribbon.  

This will open the Approve on Behalf Of selection box.  Select the user that has delegated 

approvals to you from the drop down and click Save.  This will open the submissions that are 

waiting for approval for the user selected. The user will have all standard functionality available. 

When you select the “Expense Report” icon, the Expense Report will display on the screen. 

Arrows on either side will allow you to navigate back and forth between all of your employee’s 

expense reports.   
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Chapter 11 – Expense Reports 
 

Expense Entry 
 

Navigate to: Role Center→Self Service→Expenses 

 

The home screen displays tabs.  Click New Expense for expense report creation. 

 

 
 

 

The Description entered will be the name of the expense report that will display. 

 

With the expense report open, use the New Line function in the ribbon to add expenses.  Make 

your selections and click Save.  When all lines have been added click Submit in the ribbon to 

submit the expene report for approval. 

 

 

 
 

 

 
 



99 
Revision 1.10 

Per Diem Entry 
The most recent CONUS and OCONUS Per Diem rates can be maintained in your production 

database (see section on Per Diem Set-Up).  WTE allows you to automatically enter Per Diem 

Lines via the Per Diem Wizard.  To access, select “Perdiem” from the ribbon of the Expense 

Report page.  This will open the Per Diem Wizard. 

 

 
 

The Per Diem wizard will prompt you to select State (or Country), Destination, and County.  

Afterwards select “Next” in order to move to the next phase of the wizard. 

 

The starting and ending dates of travel will be restricted to the starting and ending dates specified 

on the expense report.  You will be prompted to select the Job and WBS Codes pertinent to the 

travel.  You will also need to select which expense codes to route the lodging and MI&E portions 

of per diem to.  Select “Next” when all fields have been filled out. 

 

You will be prompted to uncheck meals and lodgings not taken. For example, because 

complimentary meals were provided during travel, the federal government often requires that 

claimed MI&E is adjusted accordingly.  MI&E lines will automatically adjust to 75% of claimed 

cost on the final day of travel based on the start/end dates of the expense report, so that does not 

need to be specified here.  If the last day of the expense report is also the last day of travel, it is 

also advisable to uncheck the final day of lodging.  Click “Next” when done. 

 

On the final page of the Per Diem Wizard, you will be required to enter actual lodging cost 

incurred under the “Daily Room Rate” field and your lodging tax in the Lodging Tax field.  The 

“Lodging Ceiling” field will populate with the maximum per diem rate for the dates / location of 

travel.  The Unallowable Amount will populate with the difference between the Daily Room Rate 

and the Lodging Ceiling, if the Room Rate exceeds the ceiling.  If an Unallowable Amount exists, 

you will be required to specify which expense category the amount goes to.  Click “Finish” when 

done. 

 

Favorites 
Favorite Job/WBS codes can be saved using this function for quick population to expense reports. 

Edit Header 

This function allows you to edit the header information for your expense report.  This includes 

the start and end date of the report, description, and advance. 
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Set Delegate 
Select a resource that is approved to enter expenses on your behalf. 

Enter On Behalf Of 

This dropdown will display all employees that have selected you in the Set Delegate field.  Select 

the user you are entering expenses for.  All normal functionality will be accessible.  

Expense Report 
This selection will display a printable PDF view of the expense report.  All Per Diem lines for a 

particular location will be summarized together on the report.  
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Expense Reports 

Once an expense report is submitted via WTE an expense report line will be created in the 

Expense Report table with the approval status “Submitted”.  When the expense report is approved 

or rejected in WTE the column will be updated to “Approved” or “Rejected”. 

 

To navigate to the Expense Reports: Role Center→Actions→Manage→Time and 

Expense→Expenses 

Best Practice: NAV user can set filters to view expense reports that are ready for processing. 

 

 
 

 

Once an expense report has been submitted and approved a purchase invoice can be created using 

the “Create Purchase Invoice” function in the ribbon when you have an expense report open and 

approved.  This function will create an unposted invoice AP entry.  The AP entry will then need 

to be posted and follow the normal AP invoice processing procedures.   

 

 
 

Once the purchase order is created the “PO No” field will be updated with the purchase invoice 

number on the expense report page and the status will be updated to transferred.  

 

Approvals 
More information on approvals can be found in the timesheet chapter.    
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Chapter 12 – Requisitions 
 

Navigate to: Role Center→Self Service→Requisitions 

 

 
 

 

Select New Requisition to open the new requisition.  Make your selections and click Save to 

create a new requisition request. 

 

 

Once the requisition has been created, the New Line function is used to create the lines. 

 

The comments, quantity, and amount fields can be updated once the lines have been added.  Save 

and Submit functions are found in the ribbon.  The Status field in the upper right hand corner 

will be updated accordingly. 
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Favorites 
Favorite Job/WBS codes can be saved using this function for quick population. 

Edit Header 
This function allows you to edit the header information for your requisition report.  This includes 

the start date, end date, and description. 

Set Delegate 
Select a resource that is approved to enter requisition requests on your behalf. 

Enter On Behalf Of 
This dropdown will display all employees that have selected you in the Set Delegate field.  Select 

the user you are entering a requisition request for.  All normal functionality will be accessible.  

 

Approvals 
More information on approvals can be found in the timesheet chapter.   
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Appendix I – Project Reports 
 

Job Setup 

Aged Job Receivable 

AR History By Job 

Bookings By Job  

Budget vs. Actual Labor Detail 

Cash Applied Job 

Funding Notification 

Job Detail with Billing 

Job Revenue Summary 

Job Status Report 

Job Billing Worksheet with Roll-Up 

Summary of Hours and Amount on TM 

Labor Utilization 

Labor Analysis 

Missing Time 

Employee Roster 

Employee Timesheet 

Timesheet History 

Contract Revenue Trend 

Outstanding Purchase Order by Job 

Unbilled Analysis 

Unbilled Trend 

Job Cost Transaction Detail 

Job List 

Job Register 
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Job Detail with Billing Report 
The Job Detail with Billing Report provides the ability to quickly view billing per 

contract, job, or task. 

 

Parameter Page Options 
Summary By: The report will be generated using the selected parameter.   

Options are: Contract, Job, or Task 

Job Filter: Allows the user to filter the report for a specific job.  

Accounting Period: Allows the user to filter the report for a specific accounting period.   

Starting Date: Pre-populated based on the accounting period selection but can be modified by 

the user to increase the date range of the report.   

Ending Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

Hide if Current Column is Zero: If selected, lines without billing in the current period will not 

display when the report is generated. 
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Job Revenue Summary 
The Job Revenue Summary Report displays the cost, profit, profit%, revenue, and percent 

complete by contract, job, or task.  Options for provision or actual burdens and to show 

billing as revenue are available on the parameter page. 

 

Parameter Page Options 
Summary By: The report will be generated using the selected parameter.   

Options are: Contract, Job, or Task 

Job Filter: Allows the user to filter the report for a specific job.  

Accounting Period: Allows the user to filter the report for a specific accounting period.   

Starting Date: Pre-populated based on the accounting period selection but can be modified by 

the user to increase the date range of the report.   

Ending Date: Pre-populated based on the accounting period selection but can be modified by the 
user to increase the date range of the report.   

Job Category Burden: The report is generated using the rate structure selected.   

Options are: Provisional or Actual 

Show Billing As Revenue: If selected, sales that have been invoiced but not paid will be 

included on the report. 

Hide if Current Column is Zero: If selected, lines without billing in the current period will not 

display when the report is generated. 
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Job Status Report 
The Job Status Report provides a detailed overview of the financial standing and charges 

toward a project.  
Note: The allocate cost periodic activity must be run for burdens to print on the report. 

 

Parameter Page Options 
Summary By: The report will be generated using the selected parameter.  Options are: Contract, 

Job, or Job Task 

Rate Type: The report uses the rate structure selected.  Options are: Provisional or Actual 

Accounting Period: Allows the user to filter the report for a specific accounting period.   

Start Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

End Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

Job Filter: Allows the user to filter the report for a specific job.  

Job Task Filter: Allows the user to filter the report for a specific task.  

Budget Version No: Allows the user to select the budget version that should be used. 

Hide if Current Column is Zero: If selected, lines without billing in the current period will not 

display when the report is generated. 
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Job Billing Worksheet with Roll-Up 
The Job Billing Worksheet with Roll-Up Report shows a breakdown of labor and non-

labor that can be invoiced by contract, job, or task.  This report may be used to identify 

projects that can be invoiced. 
Note: The report will not list fixed price jobs. 

 

Parameter Page Options 
Summary By: The report will be generated using the selected parameter.   

Options are: Contract, Job, or Job Task 

Rollup: The report displays at the level selected.  Options are: Blank, 1, 2, or 3. 

Accounting Period: Allows the user to filter the report for a specific accounting period.   

Start Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

End Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

Job Filter: Allows the user to filter the report for a specific job.  
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Total Cost By Job with Roll-up 
The Total Cost By Job with Roll-up Report shows labor hours/cost, ODC’s, and burdens 

by contract, job, or task. 
Note: The allocate cost periodic activity must be run for burdens to print on the report. 

 

Parameter Page Options 
Summary By: The report will be generated using the selected parameter.   

Options are: Contract, Job, or Job Task 

Level: The report displays at the level selected.  Options are: Blank, 1, 2, or 3. 

Show Only if Current Activity: If selected, the report will only display lines with activity in the 

current period. 

Column Info. To Print: Select the column parameter for the report.   

Options are: Cost or Billings 

Accounting Period: Allows the user to filter the report for a specific accounting period.   

Start Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

End Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

Job: Allows the user to filter the report for a specific job.  

Blocked: Identify if blocked jobs should display.  Options are Blank, Posting, or All 

Job Contract Type: Allows the user to filter for a specific contract type. 
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Summary of Hours and Amount on TM 
The Summary of Hours and Amount on TM Report shows hours and amounts that were 

billed.  The report also shows budgeted and budget remaining by contract, job, or task.   

 

Parameter Page Options 
Summary By: The report will be generated using the selected parameter.   

Options are: Contract, Job, or Job Task 

Accounting Period: Allows the user to filter the report for a specific accounting period.   

Starting Date: Pre-populated based on the accounting period selection but can be modified by 

the user to increase the date range of the report.   

Ending Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

Roll-up Level: The report displays at the level selected.  Options are: Blank, 1, 2, or 3. 

Job Filter: Allows the user to filter the report for a specific job.  

Job Task Filter: Allows the user to filter the report for a specific task.  

Budget Version No: Allows the user to select the budget version that should be used. 
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Labor Utilization 
The Labor Utilization Report gives the user the ability to analyze employee utilization by 

individual, labor category, or a combination of the two to explore utilization trends. 

 

Parameter Page Options 
Report Type: The report will be generated using the report layout selected.   

Options are: Utilization By Employee – The report will display utilization for each employee. 

Summary By Category – The report will display utilization for each labor category. 

Utilization Trend – The report will display utilization by labor category then employee. 

Accounting Period: Allows the user to filter the report for a specific accounting period.   

Starting Period: Pre-populated based on the accounting period selection but can be modified by 

the user to increase the date range of the report.   

Ending Period: Pre-populated based on the accounting period selection but can be modified by 

the user to increase the date range of the report.   

Summary Only: If selected, only summary lines will display on the report when generated. 

Resource No. Filter: Allows the user to filter the report for a specific resource. 

Labor Category Filter: Allows the user to filter the report for a specific labor category. 
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Labor Analysis 
The Labor Analysis Report provides an overview of labor hours, cost, spent, or billed.  Each time 

the report is printed the column order can be customized per the user’s parameter page selections. 

 

Parameter Page Options 
Trend: This allows the user to choose to view the report.  Options are: Weekly or monthly. 

Column Info. To Print: Allows the user to choose the report dimension.   

Options are: Hours, Cost, Spent, or Billed. 

Period: This field opens to the accounting period table to determine the period of the report 

Starting Date: This is the starting date of the report. Defaults from Period   

Ending Date: This is the ending date of the report. Defaults from Period     

Job Group Filter: This allows the user to filter the report by Project Group.   

Department Filter Resource: This allows the user to filter the report by department.   

Include Un-Posted Time: If selected, the report will include timesheet data that has not been 

posted. 

Layout:  The layout selection pre-populates the column fields, per your selection.  Column 

selections can then be modified by the user, if needed.  

Column 1, 2, 3, 4, 5: Allows the user to choose columns.  Options are: Resource, Job Contract 

Type, Job, Job Task, and Resource Department 
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Missing Time   
The Missing Time Report displays employees that have timesheets with missing hours or 

waiting on approval.  This report should be run and verified before importing time. 

 

Parameter Page Options 
Timesheet Period: This allows the user to filter the timesheet period type they are searching for.  

(Ex. Weekly, Semi Monthly) 

Starting Date: This field opens to the accounting period table to determine the starting period of 

the report.   

Ending Date: This field opens to the accounting period table to determine the ending period of 

the report.     

Floor Check Date:  If populated, a floor check report will print for the day selected. 

Run Report For:  Allows the user to generate the report for timesheets with missing hours or for 

those waiting for approval. 
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Employee Roster 
The Employee Roster Report displays a list of employees with their department, 

employment start date, and salary details. 

 

Parameter Page Option 
Show Pay Data: If selected, the report will print additional pay rate detail for hourly employees. 
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Employee Timesheet 
The Employee Timesheet Report can print employee timesheets with audit trail details 

and comments that were inputted by the employee upon submission. 

 

Parameter Page Option 
Date Filter: Allows the user to filter the report for specific dates. 

Include Audit Trail: If selected, Audit trail details will print on the report. 

Include Comments: If selected, timesheet comments that were entered when submitted will print 

on the report. 

Resource No. Filter: Allows the user to filter the report for a specific resource. 

Job Filter:  Allows the user to filter the report for a specific job. 
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Timesheet History 
The Timesheet History Report displays timesheet line details, hours, and cost.  A summary of the 

information can be selected to display at the end of the report.  
Note: Only posted time is displayed on the report. 

 

Parameter Page Option 
Print Transaction Detail: If selected, transaction details will print on the report. 

Print Transaction Summary: If selected, a transaction summary will print on the report. 

Project Filter: This allows the user to filter the report for a specific project. 

Wbs Filter: This allows the user to filter the report for a specific task. 

Labor Posting Group Filter: This allows the user to filter the report for a specific labor group. 

Hide Cost: If selected, cost will not print on the report. 
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Outstanding Purchase Order by Job 
The Outstanding Purchase Order by Job Report displays open purchase orders with details by job. 

 

 

  



118 
Revision 1.10 

Unbilled Analysis 
The Unbilled Analysis report allows you to see the difference billable due to a variance in your 

actual and billed burdens.  This report is similar to the “Job Billing Worksheet” but additionally 

includes the difference between your actual rate and billed burdens.   
Note: The allocate cost periodic activity must be run for burdens to print on the report.  Will not include fees. 
 

Parameter Page Option 
Summary By: The report will be generated using the selected parameter.   

Options are: Contract, Job, or Job Task 

Roll-up: The report displays at the level selected.  Options are: Blank, 1, 2, or 3. 

Accounting Period: Allows the user to filter the report for a specific accounting period.   

Start Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

End Date: Pre-populated based on the accounting period selection but can be modified by the 

user to increase the date range of the report.   

Job Filter: Allows the user to filter the report for a specific job.  
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Unbilled Trend 
The Unbilled Trend Report displays projects with unbilled amounts by month and project.  
Note: Burdens and fees will not be printed on the report.  Only direct costs are printed. 
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Job Cost Transaction Detail 
The Job Cost Transaction Detail Report shows total cost and price for each job. 
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Job List 
The Job List Report provides a quick view of all jobs, status, details, budgeted cost and 

budgeted price information. 

 

Parameter Page Option 
Budget Amounts Per: Allows the user to print the report using Schedule or Contract. 
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Job Register 
The Job Register Report  

 
Parameter Page Option 

Print Job Descriptions: If selected, job descriptions will print on the report. 
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Appendix II – Data Migration XML Ports 
 

XML ports are used to import historical data from your current system into Microsoft Dynamics NAV.  

Import files should be created as a tab delimited text file.   

 

Chart of Accounts  

Field Name 
Max 
Length Type Required/Optional Notes 

G/L Account Number (20)  Code Required  

Description (50)  Text Required  

Statement Type  Option Required 

Choices are: 
Balance Sheet 
Income Statement 

Account Type  Option Required 

Choices are: 
Posting 

Begin-Total 
End-Total 

Direct Posting  Boolean  

For transaction Posting: 
Posting Accounts = Yes 

Others = No 
 

 

Department  

Field Name 
Max 
Length Type Required/Optional 

Department Code  (20)  Code  

Department description (50)  Text  
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Vendor  

Field Name 
Max 
Length Type Required/Optional Notes 

Vendor No (20)  Code Required No special characters 

Name (50)  Text Required  

Address (50)  Text Required  

Address 2 (50)  Text   

City (30)  Text Required  

State (30)  Text Required  

Zip Code (20)  Code Required  

Country Code (10)  Code  

Only use for non-US 
Company Addresses 

A/P Contact (50)  Text Required  

Phone No. (30)  Text Required  

Fax No. (30)  Text   

E-Mail (80)  Text   

Payment Terms (10)  Code Required  

Federal ID No (30)  Text Required  

1099 Code (10)  Code  

Options are: 
MISC-07 

MISC-01 

Blank (Tax Exempt Vendors) 

Shipment Method (10)  Code  Leave blank 

Shipping Agent (10)  Code  Leave blank 

Vendor Posting Group (10)  Code Required Liability 

Gen. Bus. Posting Group (10)  Code Required  
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Our Account No. (20)  Text  

The Account No. your 
Vendor has given to you for 
printing on the Check Stub 

 

Customer  

Field Name 
Max 
Length Type Required/Optional Notes 

Customer No (20)  Code Required No special characters 

Name (50)  Text Required  

A/R Contact Name (50)  Text Required  

Contact Name 2 (50)  Text   

Address (50)  Text Required  

Address 2 (50)  Text   

City (30)  Text Required  

State (30)  Text Required  

Zip Code (20)  Code Required  

Country Code (10)  Code  

Only use for non-US Company 
Addresses 

Phone No. (30)  Text Required 

Parentheses and dashes must be 
included. 
Will not be formatted. 

Fax No. (30)  Text  

Parentheses and dashes must be 
included. 
Will not be formatted. 

E-Mail (80)  Text   

Payment Terms (10)  Code Required  

Shipment Method (10)  Code  Leave Blank 

Shipping Agent (10)  Code  Leave Blank 

Gen. Bus. Posting Group (10)  Code Required Income Statement  

Customer Posting Group (10)  Code Required Asset/Balance Sheet 

Credit Limit  Decimal  

Blank represents Unlimited (No 
Limit) 

Tax Liable  Boolean Required 

Sales Tax 

Options are: Yes or No 
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Tax Area Code (county) (20)  Code Required 

Enter Tax Area for Tax collection 
when Tax Liable = Yes 

Tax Exempt No. (30)  Text   

Location Code (10)  Code  

Used to designate default Location 
for Orders 

Customer Price Group Code (10)  Code  Assign Default Price Group 

No. of Copies  Integer  

How many copies of the Invoice to 
print in addition to the Original 

Salesperson Code (NOT NAME) (10)  Code   
 

Check 

Field Name 
Max 
Length Type Required/Optional Notes 

Check No  (20)  Code Required  

Check Date  Date Required  

Bank Account # (20)  Code Required Bank Record # in NAV 

Description (50)  Text Required  

Amount  Decimal Required (Negative) 
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Item  
Field Name Max Length Type Required/Optional 

No (20)  Code 

 
Description (50)  Text 

 
Base UOM (10)  Code 

 
Inventory Posting Group (10)  Code 

 
Gen Prod Posting Group (10)  Code 

 
Unit Cost 

 

Decimal 

 
Unit Price 

 

Decimal 

 
Vendor No (20)  Code 

 
Tax Group Code (10)  Code 

 
Location Code 

 

Text 

 
Bin Code 

 

Text 

 
Variant Code 

 

Text 

 
Inv Balance Txt 

 

Text 

 

Product Group Code (10)  Code 

 
Price 

 

Text 

 
Lot No 

 

Text 

 
Serial No 

 

Text 

 

Item Tracking Code (10)  Code 

 
 

Item Price 

Field Name Max Length Type Required/Optional 

No (20)  Code  
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Description (50)  Text  
Variant Code  Text  

Unit of Measure  Text  

Price  Text  

Sales Type  Text  

Sales Code  Text  
 

Item Purchase 

Field Name Max Length Type Required/Optional 

No (20)  Code  

Description (50)  Text  
Variant Code  Text  
Unit of Measure  Text  
Price   Text  
Vendor No  Text  
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Fixed Asset 

Field Name 
Max 
Length 

Type Required/Optional Notes 

Asset # (20 ) Code Required  

Description (50 ) Text Required  

FA Class Code (10 ) Code Required  

FA Subclass Code (10 ) Code   

FA Location Code (10 ) Code   

Depreciation Book Code (10 ) Text Required  

FA Posting Group (10 ) Text Required  

Depr Method (10 ) Text Required  

Depr Start Date  Text Required  

Num Depr Years  Text Required  

Acquisition Cost  Text Required  

Depr Booked As Of Date  Text Required 

Date that the depreciation has 
been calcualted through, 
usually the last day of the 
month on the old system. (Cut 
off date) 

Book Value  Text Required  

Department Code (20 ) Code Required  

 

 

Job Category 

Field Name 
Max 
Length 

Type Required/Optional 

Job Category Code (30)  Code Required 

Job Category Description (50)  Text Required 

Category Group Name (30)  Text  
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Resource  

Field Name 
Max 
Length 

Type Required/Optional Notes 

Resource Number (20)  Code Required 
Same as Employee Number. 
No special characters. 

Name (50)  Text Required  

Department (20)  Code Required 
Enter Default Department for Posting 
of Labor Costs 

Labor Category (20)  Code Required Assign Default Labor Category Code 

Social Security No. (30)  Text Optional  

Employment Date  Date Required  

Salaried  Field Required 
Salaried (Y) Yes or N (No) not 
Salaried  

Pay Amount  Text Required 

(Per Pay Period) 
Either Hourly Rate of Salary Amount 
per Pay period 

Address (50)  Text Optional  

Address 2 (50)  Text Optional  

City (30)  Text Optional  

State (30)  Text Optional  

Zip Code (20)  Code Optional  

Email (100)  Text   

Benefit Plan  Text   

Web Login  Text   

Time Zone  Text   

Time Period  Text   

Working Time Calendar Text   

Supervisor  Text   
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Job  

Field Name 
Max 
Length 

Type Required/Optional Notes 

Job No. (20)  Code Required 
No special 
characters 

Job Description (50)  Text Required  

Department Code (20)  Code Required 

Values should be 
from department 
listing provided to 
PVBS 

Project Manager (20)  Code Required 

Resource Code of 
Project Manager: 
Value = Employee 
or Resource No. 
from list provided 
to PVBS. 

Customer No. (20)  Code Required 

Value = Customer 
No. from list 
provided to PVBS. 

Job Type (50)  Text Required 

Options are: 
Time & Material 
Cost Plus Fixed Fee 

Firm Fixed Price 

B&P 

IR&D 

Primary Contract No. (20)  Code Required  

Other Contract No. (20)  Code Optional  

Not To Exceed Contract  Boolean Required  

Withhold Percent on Job (50)  Text Required  

Starting Date  Date Required  

Ending Date  Date Required  
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Fee Percent (50)  Text   

Fee Amount  Decimal   

Allow Time in Advance  Boolean   

LWOP  Boolean   

Benefits Code (20)  Code   

Job Group (50)  Text   

Job Account Group (50)  Text   

Revenue Formula (50)  Text   

Billing Formula (50)  Text   

Billing Pool Group (50)  Text   
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Job WBS  

Field Name 
Max 
Length 

Type Required/Optional Notes 

Project No. (20)  Code Required  

WBS Code (60)  Code Required No special characters 

WBS Description (50)  Text Required  

Visible On Timesheet  Boolean   

Visible On Expense  Boolean   

Membership Hierarchy (50)  Text   

Time Approval Hierarchy (50)  Text   

Expense Approval Hierarchy (50)  Text   

Time Approval Starts With (20)  Code   

Expense Approval Starts 
With 

(20)  Code   

Req Approval Starts With (20)  Code   

Contract Amount  Decimal   

Funded Amount  Decimal   

CLIN (20)  Code   

ACRN (80)  Code   
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Job Task  

Field Name 
Max 
Length 

Type Required/Optional Notes 

Job Number (20)  Code   

Job Wbs Code (60)  Code   

Task Description (50)  Text   

Department code (20)  Code   

Task Manager (20)  Code Required 
Resource Code of Project 
Manager 

Task Type (50)  Text Required  

Other Contract 
No. 

(20)  Code Optional  

Starting Date  Date Required  

Ending Date  Date Required  

Revenue Formula (50)  Text Optional  

Billing Formula (50)  Text   

Billing Pool Group (50)  Text   

Fee Percent Name (50)  Text   
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Job Modification Detail 

Field Name 
Max 
Length 

Type Required/Optional 

Job No (20)  code  

Job WBS Code (60)  code  

Description (50)  text  

Version No  Integer  

Skip    

Contract Amount  decimal  

Funded Amount  decimal  

Funded Fee  decimal  

Starting Date  date  

 

Resource Labor Category Default 

Field Name 
Max 
Length 

Type Required/Optional Notes 

Job No. (20)  Code Required  

Job WBS Code (60)  Code Optional  

Labor Category Code (20)  Text Required NOT DESCRIPTION 

Resource No. (20)  Text Required 
Same as Employee 
Number 
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Job Ledger  

Field Name 
Max 
Length 

Type Required/Optional 

Posting Date  date  

Job Number  Text  

Job Wbs Code  Text  

Amount  decimal  

Hours  decimal  

Billed Amount  decimal  

Billed Hours  decimal  

Department  Text  

Valid For  Text Options are ‘Labor’ or leave blank 

Description  Text  

Job Category Name  Text  

Resource Number  Text  

Pay Type  Text  

Item No  Text  

Billed  Boolean Yes/No 

Originating Account  Text If burden, supply direct cost account 

Originating Type  Text If burden, options are ‘Labor’, ‘NonLabor’ 

 

Wage Determination Location 

Field Name 
Max 
Length 

Type Required/Optional Notes 

Location code (20)  Code Required Used to identify wage location 

Job category name (50)  Text Required  

Unit Wage  Text Required  

Starting Date  Text   
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Customer AR 

Field Name 
Max 
Length 

Type Required Notes 

Customer No (20)  Code Required  

Document Type   Required 

Choices are: 
Invoice 
Credit Memo 
Payment 
Prepayment 
Refund 
Reminder 

Document No. (20)  Text Required  

Description (50)  Text   

Posting Date  Text Required Beginning Balance Conversion Date 

Document Date  Text Required Actual Document Date 

Due Date  Text Required If blank calculated from Terms 

Amount  Text Required Format: Number, no commas or $ signs 

Cust PO No (20)  Text   

Project (20)  Text Required  

Task (20)  Text  Only used if invoicing by task  

 

Vendor AP 

Field Name 
Max 
Length 

Type Required Notes 

Vendor No (20)  Code Required  

Type   Required 
Valid choices: 
Invoice, Credit Memo, Payment, Blank 

Document No. (20)   Required  

Description (50)     

Posting Date   Required  

Document Date   Required Actual Document Date 

Due Date   Required  

Amount   Required 
Invoice: Negative  
Credit memo: Positive 

Vendor Invoice No. (20)    Required Cannot duplicate per vendor 
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General Ledger  

Field Name 
Max 
Length 

Type Required/Optional Notes 

Period Posting 
Date 

 Date Required 
This is the date that will 
posted the transaction into 
the General Ledger 

GL Account No 20 Code Required GL Account number 

Department 20 Code Required* 
*Required for Income 
statement type accounts 

Trans Description 50 Text  Transaction description 

Amount   Required Transaction amount 

Document No 20 Text  

Document number to 
identify a transaction or 
group of transactions 

Projects 20 Code Required* 
Required for Direct accounts 
only 

WBS 20 Code Required* 
Required for Direct accounts 
only 

External Document 

No 
20 Text  

Used to identify an external 
reference number outside 
the system 

Source Type  Option  
Choices are customer or 
vendor 

Source No  Option  
Based on the source type, 
customer or vendor number 
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Appendix III – General NAV Shortcuts 
 

There are many keyboard shortcuts, filter, and common date formats available in Dynamics NAV; below 

is a listing of the most common shortcuts available.   

 

Shortcuts  
Although pull-down menus are provided throughout the system, using ShortCut keys makes using 

MICROSOFT DYNAMICS NAV faster and easier. 

The keys you will use the most are: 

Shortcut keys in Microsoft Dynamics NAV 

Press To 

Alt  Focus on the menu bar and display 

key tips. 

Alt + Arrow 

Down 

Open the lookup menu when focus is 

on a cell with a drop-down menu. 

Alt + Arrow Left Accelerator to move to the previous 

page in the navigation travel history. 

Alt + Arrow 

Right 

Accelerator to move to the next page 

in the navigation travel history. 

Alt + A Launch the Actions menu. 

Alt + I Launch the Related Information 

menu. 

Alt + M Launch the MS Dynamics NAV 

menu. 

Alt + P Focus on the first command in the 

Action pane. 

Alt + R Launch the Reports menu. 

Alt + Tab Switch between open items. 

Arrow Up Move to the field above in the same 

column. 

Arrow Down Move to the field below in the same 

column. 

In Edit mode: Create a new draft row 

when cursor is positioned in last row. 

Arrow Right In Edit mode: Move to next character 

position in a data field. The key has 

no effect if the cursor is positioned on 



 

 

 

Revision 1.10 

 

 

the last character. 

In View mode: Move to the next 

cell in a row until the last cell. 

When positioned in the last row in 

the data set, pressing right arrow has 

no effect. 

Arrow Left In Edit mode: Move to previous 

character position in a data field. The 

key has no effect if the cursor is 

positioned on the first character. 

In View mode: Move to the 

previous cell in a row until the first 

cell. When positioned in the first 

row in the dataset, pressing left 

arrow has no effect. 

Ctrl + + Insert new line (in a grid). 

Ctrl + A Select All (Copy). 

Ctrl + C Copy. 

Ctrl + D Delete. 

Ctrl + E Export to Excel. 

Ctrl + L Show Links. 

Ctrl + N Create New/Insert. 

Ctrl + O Open company. 

Ctrl + P Print. 

Ctrl + U Lookup information and select from 

another table. 

Ctrl + V Paste. 

Ctrl + W Export to Word. 

Ctrl + X Cut. 

Ctrl + Z Undo. 

Ctrl + Arrow Up Move the focus up while the selected 

line stays selected. 

Ctrl + Arrow 

Down 

Move the focus down while the 

selected line stays selected. 

Ctrl + Arrow 

Left 

Move focus to first cell in a row. 

Ctrl + Arrow 

Right 

Move focus to last cell in a row. 
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Ctrl + Delete Delete a filter in the filter pane. 

Ctrl + End Move to the last cell of the entire grid. 

Ctrl + Enter Save any pending changes to a Task 

page (equivalent to clicking OK). 

Ctrl + F1 Show extended tooltip on a validation 

error. 

Ctrl + F10 Turn on or off key tips in the Action 

pane. When you press the key tip 

number, that action gets carried out 

(first key selects a group and shows 

key tips within that group). 

Ctrl + Home Move to the first cell of the entire 

grid. 

Ctrl + Ins Add a filter in the filter pane. 

Ctrl + Shift + A Clear all filters to show all. 

Ctrl + Shift + C Open a new card. 

Ctrl + Shift + D Show dimensions. 

Ctrl + Shift + F Add a FlowFilter (Limit totals to) in 

the Filter pane. 

Ctrl + Shift + J Show Statistics. 

Ctrl + Shift + N Show ledger entries. 

Ctrl + Shift + R Release a document. 

Ctrl + Shift + T Add a Table filter (Show 

results/Advanced filter) in the Filter 

pane. 

Ctrl + Shift + V Open a card or a document in View 

mode. 

Ctrl + Shift + W Open a list in a List Task page, in a 

separate window, in View mode. 

Ctrl + Shift + X Exit the application. 

Ctrl + Shift + Z Reconcile. 

Ctrl + Shift + Y Apply Entries. 

Delete Clear selected text. 

End If text is selected: Move to the last 

field in a row or, if already in the last 

field, does not move. The text in the 

destination field is selected. 

If text is not selected: Move to the 



 

 

 

Revision 1.10 

 

 

last character position in the field or, 

if already in the last position, does 

not move. 

Enter Move forward to next field - like the 

Tab key - but skipping check mark 

fields and buttons. 

Esc Cancel/Close the current task or 

window, unless it is the main window 

for the application. 

F1 Display Help 

F3 Reserved for future use. 

F4 Open a dropdown menu. 

F5 Refresh the active window. 

F6 Move forward through screen 

elements such as panes or FastTabs, 

with focus on the first part of a pane. 

In a lookup: Move focus to the 

New/Advanced action. 

F9 Post a document. 

F10 Focus on the menu bar and display 

key tips. 

F11 Focus on the Address bar. 

F12 Focus on the Navigation pane. 

Home In view mode: Move to the first field 

in a row in focus or, if already in the 

first field, does not move. The text in 

the destination field gets selected. 

If text is not selected: Move to the 

first character position in the field or, 

if already in the first position, does 

not move. 

PageDown Move one screen down in a list or in 

lines. 

PageUp Move one screen up in a list or in 

lines. 

Shift + F3 Focus on the Quick filter in the filter 

pane. 

Shift + F6 Move backward through screen 
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elements such as panes or FastTabs, 

with focus on the first part of a pane. 

Shift + F9 Post & Print a document. 

Shift + Tab Move keyboard focus to the 

previous element in the tab 

sequence within a part. If the 

element is the last in the part, focus 

moves to the first element in the 

next part. 

Tab Move forward through elements 

within a part.  

The tab order skips the Action menu 

and the Collapse/Expand button on 

the FastTabs. 

If the element is the last in the part, 

focus moves to the first element in 

the next part. 
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Setting Filters 

 

Symbol Meaning 
Sample 

Expression 
Records Displayed 

= Equal to 377 Number 377. 

  BLUE 
Those with the BLUE code, for example, the 

BLUE warehouse code. 

  22 

A datetime: from 22-current month-current year 

0:00:00 to 22-current month-current year 

22:59:59. 

  22 10 An exact datetime: 22-01-01 10:00:00. 

.. Interval 1100..2100 Numbers 1100 through 2100. 

  ..2500 Up to and including 2500. 

  ..12 31 00 Dates up to and including 12 31 00. 

  P8.. Information for accounting period 8 and thereafter. 

  ..23 
From the beginning of time until 23-current 

month-current year 23:59:59. 

  23.. 
From 23-current month-current year 0:00:00 until 

the end of time. 

  22..23 
From 22-current month-current year 0:00:00 until 

23-current month-current year 23:59:59. 

| Either/or 1200|1300 Those with number 1200 or 1300. 

& And <2000&→1000 

Numbers that are less than 2000 and greater than 

1000. 

The ampersand (&) cannot be used by itself with 

numbers because no record can have two numbers. 

<→ Not equal to <→0 

All numbers except 0. 

The SQL Server Option allows you to combine 
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this symbol with a wild card expression. For 

example, <→A* meaning not equal to any texts 

that start with A. 

→ Greater than →1200 Numbers greater than 1200. 

→= 
Greater than or 

equal to 
→=1200 Numbers greater than or equal to 1200. 

< Less than <1200 Numbers less than 1200. 

<= Less than or equal to <=1200 Numbers less than or equal to 1200. 

* 

An indefinite 

number of unknown 

characters 

*Co* Texts that contain "Co". 

  *Co Texts that end with "Co". 

  Co* Texts that begin with "Co". 

? 
One unknown 

character 
Hans?n Texts such as Hansen or Hanson. 

 Calculate before rest 30|(→=10&<=20) 

Those with number 30 or with a number from 10 

through 20 (the result of the calculation within the 

parentheses). 

@ 

Ignore case (either 

uppercase or 

lowercase allowed) 

@location Texts such as LOCATION, location, or Location. 

 

5999|8100..8490 
Include any records with the number 5999 or a number from the interval 8100 through 

8490. 

..1299|1400.. 
Include records with a number less than or equal to 1299 or a number equal to 1400 or 

greater (all numbers except 1300 through 1399). 

→50&<100 
Include records with numbers that are greater than 50 and less than 100 (numbers 51 

through 99). 

*C*&*D* Texts containing both C and D. 
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@*co?* 

Texts containing co, CO, Co, cO, such as cot, cope, and incorporated. 

The text CO, cO, Co, or co must be present, followed by at least one character, but 

there can be an indefinite number of characters before and after these, and case is 

unimportant. 

 

Common Date Formats 
 

User Input Result 

w Work date entered in Tools > Work Date 

t Today's date 

c Closing date 

# Number of the day in the current work month 

Month-day-year 122502, 12 25 02, 12-25-02, 12/25/02 

Weekday-weeknumber-year Fr5202, fr 52 02, fr-52-02, fr/52/02 
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Training Workbook 
 

 

Application Setup 
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Exercise 1: Direct Labor  
In this exercise you will learn how to setup direct labor accounts so that they post to the correct G/L 

accounts. 

Setup Direct Labor Accounts 

 
You have the following G/L accounts:  

Direct Labor: 5100..5120 

IR&D: 8810 

 

1. Navigate to the Category Group Setup:  

Departments→Project Accounting→Category Group Setup→Category Group 

 

2. Create a Category Group “Labor”. 

Select the New icon at the top of the page. 

Enter the following information to create your Category Group. 
Name: Labor 

Description: Direct Labor 

Valid for: Labor 

Cost Account: 5100 

Click OK. 

 

3. Navigate to Job Group Setup: Departments→Project Accounting→Job Group Setup→Job Group 

 

4. Create a new Job Group “IR&D Internal research and development”. 

Select the New icon at the top of the page. 

This will open a blank Job Group Card 

Enter the following information to create your Job Group. 
Name: IRD 

Description: IR&D Internal research and development 

Cost Account: 8810 

Click OK. 

 

 

Why did we populate the “Cost Account” on the Job Group? 
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Exercise 2: Travel Expenses  

In this exercise you will learn how to setup travel expense categories & assign ledger accounts. 

 

Setup Travel Expenses 

You have the following G/L accounts:  

Direct Travel: 5200 

IR&D Travel: 8820 

 

1. Navigate to the Category Group Setup:  

Departments→Project Accounting→Category Group Setup→Category Group 

 

2. Create a Category Group “Travel”. 

Select the New icon at the top of the page. 

Enter the following information to create your Category Group. 
Name: Travel 

Description: Travel 

Valid for: Expense 

Cost Account: 5200 

Click OK. 

 

3. Click the Job Categories icon in the ribbon of the Category Group page. 

 

4. Create Job Categories for Per Diem, Lodging, Meals, Mileage, and Kilometers. 

Select the New icon at the top of the page. 

This will open a blank Job Category Card 

Enter the following information to create your Job Category. 
Name: Per Diem 

Description: Per Diem 

Category Group: Travel 

Valid for: Expense 

Cost Account: 5220 

(Repeat these steps for all Job Categories) 

Click OK. 

 

5. Navigate to the Job Account Group Setup:  

Departments→Project Accounting→Job Group Setup→Job Account Group 

 

6. Create a Job Account Group “IRD Travel”. 

Select the New icon at the top of the page. 

Enter the following information to create your Category Group. 
Name: IRD Travel 

Description: IR&D Travel 

Restrict to Expense Categories Listed: Select the Checkbox 

Click Details in the ribbon. 

Add the Job Categories created in step 4. 

 

7. Assign the cost G/L account IR&D Travel: 8820 to each Job Category. 
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Why did we create a Job Account Group? 
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Exercise 3: Timesheet Period 

In this exercise you will learn how to create a Timesheet Period for weekly time entry. 

 

Setup Timesheet Period 

1. Navigate to Timesheet Periods:  

Departments→Project Accounting→Web Setup→Timesheet Period 

 

2. Create a Timesheet Period “Weekly M-Th”. 

Select the New icon at the top of the page. 

Enter the following information to create your Timesheet Period. 
Name: Week M-Th 

Description: Weekly M-Th 

Period Frequency: Week 

Auto Split Week: Select the Checkbox 

Week Starting Date: 3/10/2014 

Weekday Start: 1 

Weekday End: 4  

Weekday Start Name: Monday 

Weekday End Name: Thursday 

Hours per Pay Period: 40 

 

3. Click the Periods icon in the ribbon of the Timesheet Period list page. 

This will open the Timesheet Period Dates Page. 

 

4. Click the Create Periods icon at the top of the page. 

Your timesheet periods will be populated on the lines. 

Click OK to close the page. 

  



 

 

 

Revision 1.10 

 

 

Exercise 4: Working Time Calendar 

In this exercise you will learn how to setup the Working Time Calendar.  The calendar will be used to 

control missing time notifications. 

 

Setup Working Time Calendar 

1. Navigate to Working Time Calendar:  

Departments→Project Accounting→Web Setup→Working Time Calendar 

 

2. Select the New icon at the top of the page. 

Enter the following information to create the Working Time Calendar “All". 
Name: All 

Description: All 

 

3. Click the Working Times icon in the ribbon of the Working Time Calendar list page. 

This will open the Working Time Calendar Dates Page. 

4. Click the Create Working Time icon at the top of the page. 

Enter the following information in the wizard to populate your Working Time lines. 
Starting Week Day: Monday 

Ending Week Day: Friday 

Click OK. 

Your Working Time Lines will be populated.  Adjustments for holidays can be updated via the 

control column by selecting Closed in the dropdown. 

 

Exercise 5: Time Zones 

In this exercise you will learn how to create Time Zones.  Time Zones are used with email notifications 

and the “Allow Time in Advance” functionality for timesheets. 

 

Setup Time Zones 

1. Navigate to Time Zones:  

Departments→Project Accounting→Web Setup→Time Zones 

 

2. Create a new Time Zone “Eastern Time Zone”. 

Select the Create Time Zones icon at the top of the page. 

The timesheet lines will be populated.  
Note: If time zones exist on this page highlight all the lines and select “Delete” before step 2. 

 

3. Select the line for UTC 05 and update the Name and Description columns to say “Eastern Time 

Zone”. 
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Exercise 6: Payroll Integration Setup 

In this exercise you will learn how to integrate timesheets with ADP/PayChex/NAV payroll Setups. 

 

Setup Payroll Integration 

1. Navigate to the Payroll Integration Setup:  

Departments→Project Accounting→Resource Setup→Payroll Integration Setup 

 

2. Create new Payroll Integration Codes to integrate timesheets to payroll. 

Select the New icon at the top of the page and setup the applicable fields needed for integration to 

your payroll provider. 

 

The following table gives sample codes that could be used for payroll integration.   

Fields would be populated per your payroll provider. 
 

Code Description 
ADP 

Hours 
Code 

ADP 
Rate 
Code 

ADP 
Other 

Option 

PayChex 
Earning 

Code 

Dynamics 
NAV 

Payroll 
Control 

REG Regular Hours  Blank Blank Blank R EARN REG 

OT 
Overtime 

Hours 
 Blank Blank Blank O EARN OT 

SICK Sick Hours S Blank Other 3 S EARN SICK 

VAC Vacation Hours V  Blank Other 3 V EARN VAC 

   

 

3. ADP Integration requires the following additional setups on the Resources Setup Page. 

Navigate to Resources Setup:  

Departments→Project Accounting→Resource Setup→Resources Setup 
 

Company Code: CO1 

Regular Hrs Field Name: Regular  

O/T Hrs Field Name: OT   
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Exercise 7: Pay Types 

In this exercise you will learn how to create Pay Types. 

 

Setup Pay Types 

1. Navigate to Pay Type: Departments→Project Accounting→Resource Setup→Pay Type 

 

2. Create new Pay Types “SP” and “SPOT”. 

Select the New icon at the top of the page. 
 

3. Enter the following information to create the following Pay Types. 

  

Name Description Base Type 

Overtime 
Multiplier 
Salaried 

Multiplier 
Hourly Default 

Payroll 
Integration 
Code 

SP Sea Pay Regular 0 1.2   OT 

SPOT Sea Pay Overtime Overtime 1.0 1.8   OT 
 

 

What kind of base type does Sea Pay Overtime have and why? 
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Exercise 1: Government Contractor Parameters 
In the exercise you will verify the setup of parameters that are useful for Job related activities.  

 

Enter Parameters in the General Tab 

1. Departments→Project Accounting→Setup→Government Contractor  

2. Verify the following Setups are accurate on the Government Contractor Parameters page: 

• Fee Category: Fee 

• Award Fee Category: Fee Award 

• Incentive Fee Category: Fee Incentive 

• Wages Payable Account No: 2100 

• Post to Wages Payable In Detail: Leave blank 
Note: If checked this will disaggregate the wages to job/task/department. 

• Withholding Account No: 2110 

• Override Blocked Projects for User: Leave blank 

• Override Expiration Date: Leave blank 
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Exercise 2: Web Setup 

In this Setup we determine the basic setup and rules for Web Time & Expense. 

1. Navigate to Setup: Departments→Project Accounting→Web Setup→Web Setup 

2. Make the following selection on the Web Setup Page: 

Email Notification: Select the Checkbox 

Send Daily Reminder: Select the Checkbox 

 

Exercise 3: Resources Setup  

In this Setup you will review the basic setup and rules for Resources. 

1. Navigate to Resources Setup:  

Departments→Project Accounting→Resource Setup→Resources Setup 

 

2. Verify the following Setups are accurate on the Resources Setup page: 

• Resource Nos field is for a series, if you want to automatically generate a resource number 

when a resource is created.  Enter ‘RES’ 

• Email Domain: pvbs.net  
Note: This is set up when you wish for an email domain to automatically be created for a user.  

• Email Format: First Initial + Last Name  
Note: The system will create an email based on the default but this can be edited. 

• Windows Domain: PVBS 

• Benefit Earned Calc. Method: Fixed Rate 

• Benefit Calc. Recurring Frequency: 1 M 
Where Used: These setups are used to populate the lines in the benefit batch when the “Calculate Benefits 

Accrual” function is run in the Benefit Journal.  Last accrual date on the resource card must be entered. 

• Labor Dist. Calc. Method: Average Cost   
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Exercise 4: Benefit Accrual 
In this exercise you will learn how to create a benefit accrual for employees.  
Note: If benefit accrual codes exist on this page highlight all the lines and select “Delete” before continuing with the exercise. 

 

1. Navigate to Benefit Accrual:  

Departments→Project Accounting→Resource Setup→Benefit Accrual 

 

2. This brings up the Benefit Accrual List Page. 

Select New in the ribbon to create a new Benefit Accrual. 

 

Code Description Accrues 

Benefits 

Exclude 

From 

Benefits 

Earned 

Calculation 

Accrual 

Account 

No 

Expense 

Account 

No 

Exclude 

from 

Labor 

Statistical 

Payroll 

Integration 

Code 

COMP Compensated Time             

HOL Holiday     2410  6200 Yes HOL 

SICK Sick Yes Yes 2410  6200 Yes SICK 

VAC Vacation Yes Yes 2410  6200 Yes VAC 

 

Exercise 5: Benefit Plan 

In this exercise you will learn how to create a benefit plan for employees.  

1. Navigate to Benefit Plan: Departments→Project Accounting→Resource Setup→Benefit Plan 

 

2. This brings up the Benefit Plan List Page. 

Select New in the ribbon to open a new Benefit Plan Setup Card. 
Name: PTO 

Description: Paid Time Off 

 

3. Complete the Benefit Plan Subform with the following: 
 

No. of 
Months Code 

Hours 
Earned  

Max 
Earned  

5 Sick 5   

5 Vac 8   

0 Hol     
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Exercise 6: Setting up Job Categories 

In this exercise you will setup Job Category. Job Category are used to assign the G/L Account to time 

entered and posted. 

Setting Up a Job Category  

1. Navigate to Job Category:  

Departments→Project Accounting→Category Group Setup→Job Category 

 

2. Click New in the ribbon. 
Name: Cloud Hosting 

Description: Cloud Computing Time 

Category Group: Other 

Valid for: Expense  

Note: The Valid for field is defaulted from the selection on the Category Group Setup. 

 

3. Cost and Revenue Accounts are intended as an override of the G/L account mapping in the 

Category Group.  For example, if there is a different account for cloud hosting, you could put it 

here.  Leave it blank for now.  

 

Creating a Labor/Job Category  

We need job specific Labor/Job Categories as defined in the contract. A Labor Category is a type of Job 

Category that is automatically created when a Job Category of type labor is created.  Below we walk 

through an example. 

 

1. Navigate to Job Category:  

Departments→Project Accounting→Category Group Setup→Job Category 

 

2. Click on the New icon in the ribbon.  A new Job Category page is displayed. 

Enter the following information to create your Job Category. 
Name: ENG II  

Description: Engineer Level Two (This is what will show on the invoice) 

Category Group: Labor 

Valid for: Labor 

Note: Valid for is defaulted from the Category Group and is not editable. 

Note: This generates a Labor Category record behind the scenes that will be available for selection in 

timesheets, time journal, and for subcontract labor on PO’s. 

 

3. Click Edit in the ribbon.  This will open the Job Category Card.  Notice that there are blank Cost 

Account and Revenue Account fields.  These fields are used only as an override of the Category 

Group account setups. See Posting Group Hierarchy for more information. 

 

4. Leave these blank and select OK. 
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Exercise 1: Create a Resource 

In this exercise you will setup a new resource in the system.  Once a resource card is created (along with 

their vendor card), we will setup their timesheet user card to give them access to WTE and designate their 

appropriate time and expense approvers. 

Creating a New Resource Card  

1. Navigate to the resource list: Departments→Project Accounting→General→Resources. 

 

2. Click New in the ribbon to open a new resource card. 

 

3. Enter the following information to create your resource. 
No: 100 (Employee’s file #) 

Name: William Carter First Name Last Name (no comma) 

Type: Person. 

Base Unit of Measure: Hour 

 

4. Subcontractor: Leave Blank. (Optional) 

Consultant: Leave Blank. (Optional)  
Note: This is used when processing Subcontract or Consultant Labor at the Resource level. 

 

5. Vendor No: May automatically populate depending on if the option was selected on the Resource 

Setup.  Alternatively, you can create a new vendor card and enter it in this field.   This field is 

only necessary if you expect to pay this resource, as a consultant or subcontractor, or reimburse 

the resource for expenses.   

 

6. Labor Category Code: Project Management.  The G/L account can be used by default from the 

resource.  This can be overridden by the Resource Labor Category setup on the Job Card.   

 

7. Class Code: Part Time.  This is also known as the Resource Class, this field defines the 

resource’s class, such as client site, subcontractor, or consultant.  
Note: Serves as a mapping to the labor account on the income statement if it is set up on the Category Group code as a 

Category Group Resource Class page.   

 

8. Wage Determination Location: NYC.  This is set as a default, but is normally used on a T&M job 

with a SCA requirement for wage determination.  

 

9. Enter the following information on the Invoicing tab of the resource card: 
Costs and Price fields are never used. Leave blank.   

Tax fields are never used. Leave blank.   

General Product Posting Group: Services.  This is required by posting routines in base NAV, but is for 

informational purposes only.  In base NAV this field is used to determine the G/L account for posting the 

resource cost, but in NAV for GC, the G/L account is determined by the project posting expense.  

Department Code Dimension: 001-01.  This is mandatory when posting because the department is used in 

costing. It is good practice to add a value in this field. 
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10. Enter the following information on the personal data tab of the resource card: 
Employment Date: 010114  

Where Used: This is used by the benefit accrual calculation 

ADP/PayChex Employee No: 323 (Required only if your system is integrated with ADP/PayChex.   

Salaried Employee: Yes (In the next step we will enter pay period salary amount).  

 

11. On the home tab of the ribbon, select Pay Rates. 
 

12. Enter the following information on the line: 
Effective Date: 010114 

Salaried Pay Cycle Amount: 5000 

 

13. Click Ok.   

Note: Pay Rates on a CPFF job determine a resource’s cost during labor distribution on the time journal.  If hourly, this 

can be overridden by set ups on a Job Card.  For example, if the job is set up with an SCA requirement that will take or 

a specific cost for a resource is declared.  These overrides are the Resource Cost page which is described in more detail 

below.   
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Exercise 2:  Setting Up Resources  
1. Navigate to the resource list: Departments→Project Accounting→General→Resources. 

 

2. Find the 100 resource created above and highlight that line. 

 

3. Click edit on the ribbon and the Edit Resource Card opens for that resource. 

 

4. Tab down to the Web Login Name and verify it is first initial last name (all capitalized). 

 

5. Web Login Password is used by the resource when logging into the Time Entry or Expense Entry 

system. Leave blank for now. 

 

6. The Email field is used for notifications related to time entry.  This should be pre-populated. 

 

7. Time Zone: Leave blank for now.  The Time Zone is for the user.  This is so that due dates for 

time entry are generated based on the location of the resource. 

 

8. Timesheet Period Name: Semi Mo.  This field is used to setup the timesheet period for time 

entry. (ie. Weekly, Semi Mo, Monthly, etc.)  This field is required for time entry.  

 

9. Working Time Calendar: USA.  This field is used to set up holiday time and work weeks so that 

due dates for time entry don’t fall on holidays or weekends. 

 

10. Daily Overtime: Leave it blank.  

 

11. Delegate Entry Resource No: Leave it blank. This field is used to designate a person that will 

enter time or expenses in your absence. 

 

12. Delegate Approval Resource No: Leave it blank.  This field is used to designate a person that 

will approve time or expenses you are responsible for approving in your absence. 

 

13. Select the Benefit Plan Name Golden. 

 

14. Enter the Last Benefit Accrual Date on the resource card: 010114 
 

 

 

 

 

 

 



 

 

 

Revision 1.10 
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Exercise 3: Adding Labor Categories to a Job 

Assign Resource Labor Categories to the Job Task Order 

The Resource Labor Categories list allows you to assign resources to a job per labor category that will 

drive their unit price if this is a T&M job.  The Labor Category using the job category “cost account” and 

“revenue account” fields can also determine the account that the resource transactions will post to.  If the 

resource has a different labor category depending on the task, then the Job WBS Code field is filled in.  A 

resource cannot have multiple Labor Categories for one task. 

 

1. Navigate to the Job Card for 4002, which is our time and materials job set up in the Job Setup 
Workbook. 

Departments→Project Accounting→General→Jobs→Open Job Card 4002  

 

2. Select Resource Labor Category from the Home tab of the ribbon. 

 

3. Select Resource No. 180.  Notice that the DEVELOPER I is the Labor Category.  This is the 

default that came from the resource.  This can be changed.   

 

4. Tab until you get to a new line.  Notice the name of the Resource now appears. 

 

5. On the next row enter 181.   
Note: The labor category defaults to Project MGMT from the resource card. 

6. On the next row enter 182.  Select the Labor Category Trainer III.   
Note: The labor category defaults to Senior Consultant from the resource card. 

   

Exercise 4: General Labor Category 
The General Labor Category is used in Call Center scenarios where there are too many employees to 

make it manageable to set them up.  Instead of using the Labor Resource Category setup, the General 

Labor Category lines are created which are set to resource labor categories.  When a resource is entered 

toward the job, it looks at the labor category on the resource card and matches it to a record in this page to 

find a match.  
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Exercise 5: Resource pricing for a T&M project  
Typically the Resource Pricing page is only used when creating prices for a time and materials project. 

Prices can be set for a resource based on the Labor Category for the Resource. 

 

Assign T&M Prices 

Assign the Pricing (Billing Rates) for each Labor Category. 

 

1. Open the Edit Job Card screen for Job 4002.   

Departments→Project Accounting→General→Jobs→Open Job Card 4002 

 

2. Click the Resource Price on the Action tab of the ribbon. 

The Job Resource Prices page opens. 

 

3. Click in Type field and select Labor Category Code. 

 

4. Click in the Code field and type Trainer III. 

 

5. Click in the Starting Date field and Type a starting date of 02/01/14. 

 

6. Click in the Unit Price field and type 145.00. 

 

7. Continue with the other Labor Category Codes, use a rate of 175 for the DEVELOPER 1 and 

225 for PROJECT MGMT. 

 

8. Verify the information and close OK to close the page. 

Note: You can build your Resource Prices for the length of the contract by creating additional lines with differing 

starting dates. 

The pricing for this job is by labor category across all Job Tasks/WBS Codes. You have the ability to assign prices by 

labor category per task by assigning job task numbers in the Job Task No. field.  

Note: SCA (Exercise 7) requires the Labor Category, but if you are not using SCA then an individual resource could be 

assigned a price.  If you have both a resource and a labor category in your Resource Price list and the resource is in that 

labor category, then the price you have listed for the resource is the one used for T&M.  
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Exercise 6: Creating Membership Hierarchies  

This exercise will walk you through assigning a Resource (Employee) or subcontractor to a Job.  Then we 

will assign the Membership Setup to a Job WBS Line. There are three resources assigned to Labor 

Categories Developer I, Consultant I, and Project Mgmt.  These three resources are assigned to a 

Membership Hierarchy Project 4002 team.  Membership is a resource list or “Project 4002 Team” applied 

to a Job WBS Line. 

Assign Resources to Membership Detail  

1. Navigate to Membership: Departments→Project Accounting→Web Setup→Membership 

 

2. Select the New button and create a new Membership Hierarchy called “Project 4002 Team”. 

 

3. Select Details in the ribbon. 

 

4. Edit the Effective Date: 7/1/2014. This is the earliest date this membership can be used. 

 

5. Enter the Job No 4002 for the Resource.  Add the Job WBS Code if only for a specific WBS.  

Note: A higher level Job WB Code you apply to a resource will filter down to the lower levels automatically.  

Resource No. 100 

Visible From: 8/1/14.  This is earliest date that user can enter time for a WBS. 

Visible To is the last date a user can enter time for a WBS.  Leave this blank. 

 

6. Create two more lines, one for Resource No. 180 and the other for 181. 

 

7. Click OK. 
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Approval Hierarchy 

 

Approval Hierarchies are used for time, expense, and requisition approvals.  You can setup as many as 

you wish and then assign them per task. The hierarchies can be set up so a resource must have two levels 

of approvals (one for finance and one for their department) or different approvers on different tasks.  

 

1. Navigate to Approval Hierarchy:  

Departments→Project Accounting→Web Setup→Approval Hierarchy 

 

2. Select New in the Ribbon of the Edit – Approval Hierarchy page. 

 

3. Enter My Company as the name. 

Enter 2 in the Number of Approval Levels field. 

 

4. In the Hierarchy Type, leave the default of Organizational.  This option is typically for PTO type 

projects where each person has a supervisor. The Project option means that the Approval 

Hierarchy is only intended for a specific project and the “Approval Starts With” field is used. 

 

5. Select Details in the Ribbon of the New – Approval Hierarchy page.  

a. On the first line, enter Resource No. 100 and Approver No: 180.  

Note: the alternate time approver for 180 is on the Delegate Approval Resource No. on the Resource Card for 180.  

 

6. Enter a second line of 180 Resource and 181 Approver.  This is the second level of approval. 

 

7. Enter a third line of 181 Resource and Blank Approver.  This is the third level of approval. 

 

8. Run the Build Hierarchy function to populate the level in hierarchy column. 

 

9. Select OK to return to the Approval Hierarchy page. 
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Assign Resources (Membership) to Job WBS Lines 

 

1. Open the Edit Job Card screen for Job 4002.   

Departments→Project Accounting→General→Jobs→Open Job Card 4002 

 

2. Select Work Breakdown Structure from the Ribbon in the Job Card. 

 

3. Select the ‘Plus’ next to the 001 line to open the next level, and repeat for the next level. 

 

4. You should be on the Job Work Breakdown Structure for 4002.  On the 001 line enter Project 

4002 Team in the Membership Hierarchy field. 

 

5. Select the task line for 001 and click Copy Down in the ribbon. 
Note: Membership selection should be copied down to all sub tasks. 

 

 

 Applying an Approval Hierarchy to a Job WBS Line 

  

1. Open the Edit Job Card screen for Job 4002.   

Departments→Project Accounting→General→Jobs→Open Job Card 4002 

 

2. Select Work Breakdown Structure from the Ribbon in the Job Card. 

 

3. Select the ‘Plus’ next to the 001 line to open the next level, and repeat for the next level. 

 

4. On the 001 line, enter Blue in the Time Approval Hierarchy field. 
Note: Notice that the expense and requisition approval hierarchy fields are defaulted with your selection in the time 

approval hierarchy selection. 

 

5. In the Time Approval Starts With field, select “Joyce”.  
Note: Notice that the expense and requisition approval starts with fields are defaulted with your selection in the time 

approval starts with selection. 

 

6. On the 001 line, enter Green in the Expense Approval Hierarchy and Requisition Approval 

Hierarchy fields.  In time approval starts with select William. 
Note: Notice that the requisition approval hierarchy field is defaulted with your selection in the expense approval 

hierarchy selections. 

 

7. Select the task line for 001 and click Copy Down in the ribbon. 
Note: Approval Hierarchy selections should be copied down to all sub tasks. 
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Exercise 7: Service Contract Acts Job Setup 

This exercise will walk you through the steps necessary for setting up a service contract act (SCA) 

requirement.  Each job that falls under the service contract act must be marked as a SCA and the job can 

be setup with specific resource costs by labor category, by resource class, by location, and by task.       

Wage Determination Location 

Wage Determination Location is used to determine a resources cost based on his/her location.  A 

resources location is added directly to the Resource Card, so it is assumed that a resource will be working 

in only one location under SCA. 

 

1. Navigate to the Wage Determination Location list:  

Departments→Project Accounting→Resource Setup→ Wage Determination Location 

 

2. Click New and enter the following information: 

a. Code: WV 

b. Description: West Virginia 

 

3. Navigate to the Resource List and select resource 179.   

Departments→Project Accounting→General→Resources 

 

4. In the Wage Determination Location Code add WV for West Virginia. 

 

 

Job Card  

1. Navigate to the job list: Departments→Project Accounting→General→Jobs 

 

2. Select Job No. 4002 

 

3. Under the posting tab, place a check next to service contract act if it isn’t already 

 

Resource Cost  

The more common use of resource costs is for hourly employees on jobs with service contract act 

requirements.  

 

1. With Job no. 4002 still open, select Resource Cost on the Navigate tab of the ribbon. 
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2. Click New on the ribbon. 

 

3. Enter the following information into the table: 

 

a. Type: Labor Category Code (The service contract act table specifies the cost for a labor 

category code and are not resource specific.  Don’t use the resource option as a type.  The 

resources working on the job must be assigned to the job using Resource Labor Category 

and the Job WBS Line/task using Membership Hierarchy they are working on with the 

same labor category code specified on the resource cost table). 

b. Code: PROJECT MGMT 

c. Wage Determination Location: NYC 

d. Starting Date: 1/1/2014 (same functionality as an employees pay rate.  The system will 

pull the cost from the table based on the date the labor is being posted for). 

e. Unit cost: 45.00  

f. You can enter an optional Class Code, if costs for the Labor Category differ.  
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Exercise 8: Adding Resource Cost to a Job 
Resource Costs will override the Pay Rate costs if set up.  The Resource Costs is intended for use with a 

Service Contract Act (SCA) requirement.   

 

1. Open job card 4002. 

 

2. Verify that the Service Contract Act checkbox is selected on the General tab. 

 

3. In the ribbon, select the Navigate tab and then Resource Cost. 

 

4. Create a line with the following: 

Type = Labor Category Code, Code = DEVELOPER I, and Unit Cost = $60. 

 

5. Create another line with the following: 

Type = Labor Category code, Code = Trainer III, and Unit Cost = $50. 

 

6. Select Ok when finished. 

 

Note: The Resource Cost type of Resource would be used very rarely.  This would be if a CPFF call for a specific resource 

to have a specific rate that would override their hourly rate on the resource card.  It is suggested to only do this on the Task 

level, where SCA can be setup up to read the resource cost table. 

 

Note: The Resource Cost class can be used to determine different unit costs for different work types like full time vs. part 

time.  Hazard zone vs. non hazard. Or regular time vs. overtime.  If more than one class type is needed, like full time and 

overtime, then the distinction has to be flushed out at the task level.  For example, one task for part time and one for full 

time.  Then set up the regular vs. overtime for the resource costs at the task level. 
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Exercise 1: Labor Processing 

In this exercise you will import timesheets for a given pay period into the time journal.  Labor distribution 

will be run to correctly distribute costs and reports will be run to verify hours and costs are being captured 

correctly.  Once complete, labor will be posted into the system.   

Weekly Pay Period with Salary Change 

In this exercise we will import timesheets for employees on a weekly pay cycle, run labor distribution, 

and verify a salary change mid-period. 

1. Navigate to the Time Journal: From the Role Center, select the Journals Activity Group.  Next, 

select Time Journals.   

 

2. Before importing time for a given time period the Missing Time Report should be run from the 

ribbon under the home tab.  This is used to verify that all time has been submitted and approved. 

Enter the following information on the selection page for this report: 
Timesheet Period: Weekly 

Starting Date: 01/06/14 

Ending Date: Auto Populates 

Run Report for: Missing Hours 

Click Preview and verify that all time has been submitted and approved. 

 

3. Run the Import Timesheet function in the ribbon of the Time Journal Batch list. 

Enter the following information on the options page: 
Timesheet Period: Weekly 

Start Date: 01/06/14 

Resource Filter: Leave this blank 

Department Filter: Leave this blank 

Timesheet Correction: Leave this Unchecked 

Click Ok.  Timesheet lines are imported into the Time Journal. 

 

4. Run the Calc. Comp Time Entries function in the ribbon of the Time Journal Batch list. 

Enter the following on the option screens and click Ok. 

Compensated Time Accrued At: 40 

Hours in Pay cycle: This will pre-populate the number of hours in the pay period from the Timesheet Period setup. 

 

5. Select Calc. Labor Distribution in the ribbon of the Time Journal Batch list. 

Click OK.  The time journal lines are updated with the unit cost for T&M and CPFF job related 

time.  CPFF jobs will take the unit costs from the resource costs table if the job requires SCA, 

otherwise the unit costs come from the pay rate table on the resource cards. 

 

6. Select the time journal for Kevin Brebner and select Edit Journal in the ribbon. 
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Note the labor distribution calculations for Kevin Brebner. 

Unit Cost 1: 

Unit Cost 2: 

7. Navigate to Resources: Departments→Project Accounting→General→Resources 

Open the resource card 184 – Kevin Brebner and select Pay Rates in the ribbon. 

 

8. Notice the salary increase effective mid period.   

 

9. Verify the labor distribution calculations are accurate. 

 

Comp Time 

1. Select the time journal for Tom Clancy and select Edit Journal in the ribbon. 

 

2. Note the timesheet lines created for the hours over the normal amount of hours for this pay 

period__________. 

 

Overtime with SCA for Hourly Employee 

1. Select the time journal for James Dutehs and select Edit Journal in the ribbon. 

 

2. Verify the timesheet line using the pay type of S2OT.  The resource hourly rate of $36/hour 

should be calculated at 1.75 per hour for a rate of $63/hour. 

 

3. Verify the SCA rate table was utilized and the regular hourly rate for James Dutehs labor 

category “Trainer 3” was used for an hourly rate of $50/hour instead of his regular pay rate of 

$36/hour. 

 

Semi-Monthly Pay Period with PTO 

In this exercise we will import timesheets for employees on a semi-monthly pay cycle, run labor 

distribution, and verify that the benefit accrual code from the job pulls into the timesheet line. 

1. Navigate to the Time Journal: From the Role Center, select the Journals Activity Group.  Next, 

select Time Journals.   

 

2. Run the Import Timesheet function in the ribbon of the home tab. 

Enter the following information on the options page: 
Timesheet Period: Semi Mo 

Start Date: 1/1/2014 

Resource Filter: Leave this blank 

Department Filter: Leave this blank 

Timesheet Correction: Leave this Unchecked 

Click Ok.  Timesheet lines are imported into the Time Journal. 
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3. Select Calculate Labor Distribution in the ribbon of the home tab. 

Click OK.  The time journal lines are updated with unit cost and price for T&M and CPFF job 

related time.  CPFF jobs will grab the unit costs from the resource costs table if the job requires 

SCA, otherwise the unit costs come from the pay rate table on the resource cards. 

 

4. Select the time journal for Andrew Simmons and select Edit Journal in the ribbon. 

 

5. Note the benefit accrual code on the timesheet line that uses the job “PTO”.  This should match 

the benefit accrual code from the job card.   

 

Was the G/L Account number on job PTO selected correctly?  Why or why not? 

 

Weekly Pay Period with Month End 

In this exercise we will import timesheets for employees on a weekly with month end pay cycle, verify 

the auto split week function creates two timesheets, and calculate labor distribution.  

1. Navigate to the Time Journal: From the Role Center, select the Journals Activity Group.  Next, 

select Time Journals.   

 

2. Run the Import Timesheet function in the ribbon of the home tab. 

Enter the following information on the options page: 
Timesheet Period: Weekly w Mo End 

Start Date: 12/30/2013 

Resource Filter: Leave this blank 

Department Filter: Leave this blank 

Timesheet Correction: Leave this Unchecked 

Click Ok.  Timesheet lines are imported into the Time Journal. 

 

3. Run the Import Timesheet function in the ribbon of the home tab. 

Enter the following information on the options page: 
Timesheet Period: Weekly w Mo End 

Start Date: 1/1/2014 

Resource Filter: Leave this blank 

Department Filter: Leave this blank 

Timesheet Correction: Leave this Unchecked 

Click Ok.  Timesheet lines are imported into the Time Journal. 

 

4. Verify that Carter Williams has two timesheets populate.  One timesheet for the period 

12/30/13-12/31/13 and another for 1/1/14-1/5/14. 

 

5. Select Calculate Labor Distribution in the ribbon of the home tab. 

Click OK.  The time journal lines are updated with unit cost and price for T&M and CPFF job 

related time.  CPFF jobs will grab the unit costs from the resource costs table if the job requires 

SCA, otherwise the unit costs come from the pay rate table on the resource cards. 

 

6. Navigate to Timesheet Periods to verify the timesheet period schedule is consistent. 

Departments→Project Accounting→Web Setup→Timesheet Period 
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Exercise 2: Verification 

Verify and Post the Time Journal 

1. To review all labor distribution calculations, select Time Journal Summary Report in the ribbon 

of the home tab. 

 

2. To identify potential posting errors, select Time Journal Errors report in the ribbon of the home 

tab. 

 

3. Click Preview. 
 

4. Verify the labor costs were calculated correctly. 

 

5. If your system is integrated with ADP/PayChex, run the exports to export hours/costs to the 

payroll company.  It is important that you run the Time Journal Errors report before exporting 

hours/costs to ensure the lines you are exporting will post with no errors. 

 

6. Right click on the Period From field in your first batch and select Filter to this Value.  

 

7. Post the labor by selecting Post on the ribbon under the home tab.   

 

Exercise 3: Corrections to Labor 

Get Correction Timesheets 

1. Navigate to the Time Journal: Journals→Time Journal 

2. Timesheet period: Weekly 

3. Period Start: 1/5/14 

4. Select “Timesheet Correction.” 

5. Press OK 

6. Verify that the time journal was populated with all correction timesheets from period specified. 

7. Run labor distribution. 

8. Open each Time Journal batch separately. 

9. Select “Reverse Timesheet” from the ribbon. 

10. Post the correction batch. 

Exercise 4: ADP Export 

Creating upload file for ADP  

1. Click ADP Export Hours and Earnings in the ribbon. 

 

2. Batch ID: 1 

Select Ok 
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3. Save as a .CSV file. 

 

4. Verify the information in the file is accurate. 

 

5. Upload to ADP. 
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Exercise 1: Creating a New Job (T&M Example) 

In this exercise you will create a T&M Job.  The total contract value is for $1,000,000.00.  The funded 

Value is for $250,000.00.   

Job Overview 

During this exercise you will learn the process of creating a job card and understand the fields that are 

needed for job card creation. 

Create a New Job Record 

Your company has been awarded a new contract.  The contract type is T&M.  The Job is made up of the 

base year and 1 option year.  The Contract value is 1,000,000.00. The funded Amount is 250,000.00.  

Now let’s create this Job inside Dynamics NAV.   

 

1.  Navigate to Jobs: Departments→Project Accounting→General→Jobs 

2. Click on the New icon  under the Home tab of the ribbon.  A blank Job Card is displayed.   

 

3. Enter the New Job Number SPWAR and press tab.   

 

4. Enter the Description of the job as TM Example. 

 

5. Click in the Client No. field.  This is a Lookup field that will give you a list to choose from in the 

Customer List.  Click the Lookup button or F4. Click on the Name column and ensure your 

cursor is in the Name column. Type Army C. 

Your cursor is on the Line for Customer 3106. Press Enter to select the Customer. 

 

6. Click in the Client Type field and select Federal Govt. from the Options. 

Options: Commercial, Federal Government, State Government or Local Government. 

 

7. The status field defaults to Order.  You do not need to edit this field.  

The status options are: 

Planning 

The job is in planning. When a job has the status of planned, you can undertake preliminary 

calculations and set up the job's structure. Job schedules can be used to estimate resources, items 

or general ledger accounts. 

Quote 
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A special kind of sales quote. When a job has the status of quote, you can make preliminary 

calculations. The job is offered to a customer. You can set up or change the job's structure and 

schedule. 

Order 

A special kind of sales order. Every control feature can be maintained. You can use sales invoices 

and credit memos to customers for various posted job entries and to invoice the cost. 

Completed 

The job is done. When a job is completed, you use this status to close the job. You can use the 

statistics on a completed job for comparison purposes and for the planning of future jobs. The 

actual costs of the completed job can be compared to the scheduled figures. Be sure to keep this 

information not only for comparison, but also for use as a guideline or template for future jobs. 

Note: The status is not changed from Order to Completed until after the close out has been 

completed for the Job. Once marked as completed no transactions can be posted to a Job. 

 

8. Click in the Project Manager No. field and Type 179.  

This field uses the Resource table.  The Project Manager is the Resource who is responsible for 

the entire Job. The Project Manager will default as the manager for all Tasks but can be changed 

by the user per task.  

 

9. Click in the Job Contract Type field then Click the Drilldown button or F4 to determine your 

options. Select the Type TM. The job contract types are user defined.  This field is used for 

filtering reports and pages. 

 

10. Next Enter the contract period of performance. In the Starting Date field Type 06/01/13 and in the 

Ending Date field Type 05/30/15. 

 

11. Click in the Certification Code field then Click on the Lookup button or F4 to select Certification 

Text to be printed on the Billing Invoice. Select TE.  The Look-up is into the Standard Text 

Codes Table. You have the ability to create unlimited Certification Text Codes.  

Certification Codes allow you the ability to determine text that will print on Invoices generated 

for the Job. This allows you the ability to customize individual Terms and conditions for each job. 

 

12. Click in the Invoice Nos. field then press the Assist button.  

The suggested Invoice No. Series is displayed in the next page.  Click OK. 

A Number Series is created for invoices which will start with - the Job No. followed by ‘–001’.  

You can modify the Number Series to reflect the next Invoice No. This is helpful when you 

generate Invoices for the first time in NAV since you will want to maintain the number of 

invoices for the Job. 

 

13. If the job falls under the Service Contract Act (Wage Determination Act), click in the Service 

Contract Act field so the Job is marked as an SCA Job and then Contracted Pay Rates must be 

assigned by Labor Category.  Do not click Yes for this exercise.  

Note: If a Labor Category is assigned to a resource on the Resource Card then it will be superseded by the Labor 

Category that is used when that resource enters time. 
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14. Select the Subcontractors Allowed checkbox. This field is for information only.   

 

15. The Blocked field is used if you wish to block the Job from transactions being processed against 

it. The options are: Posting or All.  

Posting: Transactions can be created against the Job but not posted (used to accumulate 

commitments). 

All: Transactions cannot be created against the Job and transactions that have already been 

created cannot be posted. 

Leave this field blank. 

 

16. Click in the Department Code Dimension field and select 001-01.  The department code 

dimension is mandatory for cost pooling. 

 

17. Click in the Job Posting Group Default field and Enter ALL.  

 

18. Click in the Job Group field and select ALL.  

 

19. Click in the Job Account Group and select Direct All.  This field allows you to set restrictions for 

labor categories and expense categories specific to the job in WTE. 

 

20. Revenue Recognition, Billing, and Fee fields.  These are reviewed in the Billing and Revenue 

Workbook.  If there is a Revenue Recognition Formula, there must be a Billing Formula.  Enter 

EBAR for the Revenue Recognition and LLR for the Billing Formula 

  

21.  Click in Primary Contract No. field and Enter W9133P-04-P003. 

This is the Contract No. that will print on the Billing Invoice. 

 

 

22. Since the Primary Contract No. does not exist (error message above) in the Contract list, you 

must create a new Contract Card.  Click F4 to Lookup into the Primary Contract No. field and 

then select Advanced. 

The Contract List is displayed. 

23. Click the NEW icon.  to bring up the Contract Card. 

 

24. Type W9133P-04-P003 in the No. field. 

 

25. Next, enter the Description for the contract. 
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26. Next, select a Program Manager. The Program Manager has visibility into all Jobs assigned this 

Contract No. as the Primary Contract No. 

 

27. Next, select a Contracting Office if applicable.  The remainder of the fields are explained in the 

Contract Setup section. 

 

28. Escape back to the Job Card and Type W9133P-04-P003 in the Primary Contract No. field.  

This is the Contract No. that will print on the Billing Invoice. 

 

29. In the Other Contract No. field you can enter an additional number such as a Requisition No. or 

Delivery Order No.  Leave this blank. 

 

30. Click in the Paying Office No. field and Type 3116 (DFAS).  

This field uses the Customer file.  If the Paying Office does not exist you will need to create a 

new Customer Card.   
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Exercise 2: Creating WBS and Task Orders 

This exercise will walk you through the steps necessary for creating the WBS Codes and Task cards.  The 

user should have a good understanding of the fields that need to be populated by the completion of this 

exercise. We will continue with the Job just created: SPWAR. 

Creating the WBS Codes 

 

1. Click the Work Breakdown Structure link in the ribbon of the job card. 

The Job WBS page opens.  

 

2. Select the Add button and a line with 001 will be added. Select Add again.  A line with 002 

will appear.  Now modify the 002 to 001-001 and select Add.  Notice that 001-002 is 

generated. 

WBS’s are created with multiple segments. Segments are separated by the “-“ in this 

exercise. These levels are used for posting expense, recognizing revenue, billing, budgeting, 

and funding. 

Note: When you select the Add button, a line will be created for the next number in the 

sequence.  If you are on 001 it will create 002, or 001-001 then 001-002 etc. 

 

3. Click in the Job WBS Code field on the first Line  

 

4. Click in the Description field and type Jet Fighter Defense System Year 1. 

 

5. Select Add and a 002 line will appear. Enter the description Jet Fighter Defense System 

Year 2. 

 

6. Skip the Hierarchy fields. We will be explaining them in a future section. 

 

7. With your cursor on the first line, click Modification Detail and the Job Funding Change 

Tacking page opens. 

 

8. Click in the Description field and enter Award Funding. 

 

9. Click in the Starting Date field and enter the Starting Date of 06/01/13. 

 

10. Enter the Contract Amount for this WBS as $500,000 and the Funded as $250,000. 

 

11. Press OK to return to the Job Work Breakdown Structure Page. 
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12. Click in the Job WBS Code line 001-002 and select Add. 

 

13. Edit the Job WBS Code field with 001-001-01. You are creating a new WBS level. Press tab. 

 

14. Enter the Description Phase I Design - Labor. 

 

15. Click on Visible On Timesheet, because we want users to enter their time to this task line.  

Enter Blue in the Membership field, Time Approval Hierarchy and Expense Approval 

Hierarchy. 

 

16. Click in the Job WBS Code line 001-001-01 and select Add. 

 

17. Job WBS Code 001-001-02 will be created and the lines resorted. Press tab. 

 

18. Enter the Description Phase I Design – ODC’s. 

 

21. Click the checkbox for Visible On Expense and Requisition so that expense submissions can 

be assigned to this task line.  To establish how expenses are approved, enter Blue in the 

Expense Approval Hierarchy field. Also enter Blue in the Requisition Approval Hierarchy. 

 

22. Repeat steps 13-21 for Job WBS 002-001, Jet Fighter Defense System Year 2. Since Year 2 

has not been funded leave the funded amount blank. 

 

23. Close the page by clicking OK. 

 

Review and Add to the Job Task Card 

When the WBS was entered a Job Task Line was automatically created. 

 

1. From the Job Work Breakdown Structure in SPWAR, select the line for 001-001-01.  Then on the 

Actions tab in the ribbon select Task Detail. 

 

2. The Edit - Job Task Card opens. 

 

3. The Job No. and Job WBS Code are already populated for you.  Notice that a Job Task No has 

been auto generated.  

 

4. The Job Task Card 001-001-01 needs to have a different manager than the manager assigned on 

the SPWAR Job Card. Click in the manager field and Enter 310. 
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5. Expand the Posting Tab. The Task Card has an override Department Code Dimension field. This 

allows the user the ability to assign a Department Code to the Task to be used when posting costs 

to the Task.  Leave this field blank. 

An example of when to use the override Department Code Dimension is when labor performed 

for the task is performed at the client’s site as opposed to the company site. 

 

6. Revenue Recognition and Billing calculations at the job task level can also override the rules on 

the Job Card.  Leave these fields blank. 

 

7. Expand the Contract Tab. Here you can enter Other Contract No. if there is a unique contract or 

child contract.  You can also add the Contract and Funded amounts for this child contract.  Leave 

this field blank. 

 

8. Click in the Not to Exceed field to prevent billings and revenue from exceeding the task’s funded 

amount. 

 

9. Verify the information and click OK to close the page. 
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Exercise 3: Verify Job Setups 

Practices and Patterns Report 

Return to the Job card to review the Job setups. 

1. From the job card, select the actions tab on the ribbon and click on Practices and Patterns and 

click Preview. 
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Exercise 4: Creating a Cost Plus Fixed Fee Job 

In this exercise you will create a Cost Plus Fixed Fee (CPFF) Job and learn which fields are required.  

The total contract value is for $100,000.00 and the Job will be fully funded.   

Create a New Job Record 

Your company has been awarded a contract from the US Department of State.  The contract type is CPFF.  

The contract is for nine months beginning on September 25, 2013.  The contract value is 100,000.00 and 

it has been fully funded.  Now let’s create this job inside Dynamics NAV.  The Job No. is 20120025. 

 

1. Navigate to Jobs: Departments→Project Accounting→General→Jobs  

2. Click on the New icon  under the Home tab of the ribbon.  A blank Job Card is displayed.   

 

3. Enter the New Job Number CPFF and press tab. 

 

4. Enter the Description of the Job as CPFF Example. 

 

5. Select the Client No. field and click F4 to drilldown into the customer table.  Click on the name 

column and ensure your cursor is in the name column and type “dep”.   

You have identified multiple customer records that begin in dep.  In this case we are going to 

select 3362 “Department of State”. 

 

6. Click in the Client Type field and select Federal Govt. from the Options. 

Options: Commercial, Federal Government, State Government or Local Government. 

 

7. The status field defaults to Order.  You do not need to edit this field.  

 

8. Click in the Project Manager No. field and Type 310 for Kevin Mims.  

 

9. Click in the Job Contract Type field then Click the Drilldown button or F4 to determine your 

options. Select the Type CPFF.  

 

10. Next Enter the contract period of performance. In the Starting Date field Type 09/25/13 and in the 

Ending Date field Type 06/24/14. 

 

11. Select the Service Contract Act checkbox to indicate that the SCA rates apply to this job. 
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12. Click in the Certification Code field then Click on the Lookup button or F4 to select SC for 

shipping charge.   

 

13. Click in the Invoice Nos. field then press the Assist button.  

The suggested Invoice No. Series is displayed in the next page.  Click OK. 

 

14. Select the Subcontractors Allowed checkbox. This field is for information only.   

 

15. You have now completed the setups required in the General Fasttab of the job card.  Navigate 

down to the Posting Fasttab. 

 

16. Leave the blocked field blank. 

 

17. Click in the Department Code Dimension field and select 001-01.  The department code 

dimension is mandatory for cost pooling. 

 

18. Select ALL for the Job Posting Group. 

 

19. Enter ALL in the Job Group field. 

 

20. Enter DIRECT ALL in the Job Account Group field. 

 

21. Select CPF in the Revenue Recognition Formula field.  This indicates that revenue recognition 

for the job will be at cost plus fee. 

  

22. Select CPF in the Billing Formula field.  This indicates that billing will be the same as the 

revenue recognized.  Drill into the CPF to see if the non-labor is at cost.  (This is assuming the 

contract allows for billing of ODC’s)  

Note: All direct jobs must have a revenue and billing formula. 

 

23. Click in the Billing Pool Group field and select Comp 1.  This indicates how the burdens are 

calculated on labor.  This is mandatory if billing and/or revenue recognition formulas call for 

burdens. 

 

24. Click in the Fee Percent field and then select Advanced. 

 

25. Select New to create a new Fee Setup. 

 

26. Enter a name of 4Fees and a description and select the Details button. 

 

27. In the Fee Setup Detail enter Direct Labor in the Account Set Name and enter a Fee Percent of 8. 
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NAV will calculate a Fee of 8% on labor and its burdens (i.e. fringe, overhead and G&A).  

 

28. On the next line enter Direct Travel and Enter 6.  Click Ok twice to return back to the Job Card.  

 

29. Click in Primary Contract No. field and Enter W9133P-04-P003. 

This is the Contract No. that will print on the Billing Invoice. 

 

30. In the Other Contract No. field you can enter an additional number such as a Requisition No. or 

Delivery Order No.  Enter DO# 0003. 

 

31. Click in the Paying Office No. field and Type 3116 (DFAS).  

This field uses the Customer file.  If the Paying Office does not exist you will need to create a 

new Customer Card.  
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Exercise 5: Creating a Firm Fixed Price Job 

In this exercise you will create a Firm Fixed Price (FFP) Job and learn which fields are required.  The 

total contract value is for $75,000.00and it is fully funded.   

Create a New Job Record 

Your company has been awarded a contract from the US Department of Defense.  The contract type is 

FFP.  The contract is for six months beginning on January 1, 2014.  The contract value is 75,000.00 and it 

has been fully funded.  Now let’s create this job inside Dynamics NAV.   

1. Navigate to Jobs: Departments→Project Accounting→General→Jobs  

2. Click on the New icon  under the Home tab of the ribbon.  A blank job card is displayed.   

 

3. In the No. field, enter the job number FFP and then tab to the next field. 

 

4. Enter FFP Job Example in the Description field. 

 

5. Select the Client No. field and click F4 to drilldown into the customer table.  Click on the name 

column and ensure your cursor is in the name column and type “dep”.   

You have identified multiple customer records that begin in dep.  In this case we are going to 

select 3001 “Department of Defense”. 

 

6. Click in the Client Type field and select Federal Govt. from the Options. 

 

7. The status field defaults to Order.  You do not need to edit this field.  

 

8. Click in the Project Manager No. field and Type 310 for Kevin Mims.  

 

9. Click in the Job Contract Type field then Click the Drilldown button or F4 to determine your 

options. Select the Type FFP.  

 

10. Next Enter the contract period of performance. In the Starting Date field Type 01/01/14 and in the 

Ending Date field Type 06/30/14. 

 

11. Select the Service Contract Act checkbox to indicate that the SCA rates apply to this job. 

 

12. Click in the Certification Code field then Click on the Lookup button or F4 to select SC for 

shipping charge.   
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13. Click in the Invoice Nos. field then press the Assist button.  

The suggested Invoice No. Series is displayed in the next page.  Click OK. 

 

14. Select the Subcontractors Allowed checkbox. This field is for information only. 

 

15. You have now completed the setups required in the General Fasttab of the job card.  Navigate 

down to the Posting Fasttab. 

   

16. Leave the blocked field blank. 

 

17. Click in the Department Code Dimension field and select 001-01.  The department code 

dimension is mandatory for cost pooling. 

 

18. Select ALL for the Job Posting Group. 

 

19. Enter ALL in the Job Group field. 

 

20. Enter DIRECT ALL in the Job Account Group field. 

 

21. Select FFP in the Revenue Recognition Formula field.  This indicates the basis for calculating the 

costs to the FFP job, including fees. 

  

22. Select FFP in the Billing Formula field.  This is different than the revenue recognition formula 

because FFP jobs ordinarily do not bill out the labor costs.  Labor billings are calculated from the 

invoice worksheet or the ETC worksheet. 

Note: All direct jobs must have a revenue and billing formula. 

 

23. Click in the Billing Pool Group field and select Comp 1.  This indicates how the burdens are 

calculated on labor.  This is mandatory if billing and/or revenue recognition formulas call for 

burdens. 

 

24. Select 5pct in the Fee Percent field since we are recognizing this fee percentage in our revenue 

recognition formula. 

 

25. Click in Primary Contract No. field and Enter W9133P-04-P003. 

This is the Contract No. that will print on the Billing Invoice. 

 

26. In the Other Contract No. field you can enter an additional number such as a Requisition No. or 

Delivery Order No.  Enter DO# 0006. 

 

27. Click in the Paying Office No. field and Type 3116 (DFAS).  



 

 

 

Revision 1.10 

 

 

This field uses the Customer file.  If the Paying Office does not exist you will need to create a 

new Customer Card.  
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Exercise 6: Creating an Indirect Job 

In this exercise you will create an indirect job to capture and budget costs.   You will also learn which 

fields are used to set up this type of job. 

Create a New Job Record 

Your company has decided to capture and budget costs by posting to an indirect job.   

 

1. Navigate to Jobs: Departments→Project Accounting→General→Jobs  

2. Click on the New icon  under the Home tab of the ribbon.  A blank Job Card is displayed.  

 

3. In the No. field, enter the job number 8001 and then tab to the next field. 

 

4. Enter Indirect Job Example in the Description field. 

 

5. Select the Client No. field and click F4 to drilldown into the customer table.  Click on the name 

column and ensure your cursor is in the name column and type “PVBS”.   

This company name is to represent your company, not a client.  This is for internal transactions. 

 

6. The status field defaults to Order.  You do not need to edit this field.  

 

7. Click in the Project Manager No. field and Type 520 for John Still the HR Manager.  

 

8. Click in the Job Contract Type field then Click the Drilldown button or F4 to determine your 

options. Select the Type Fringe.  This is for informational purposes only.  

 

9. Leave the Starting Date and Ending Date fields blank.   

 

10. The SCA, Certification Code, and Invoice Nos fields are not applicable. 

 

11. You have now completed the setups required in the General Fasttab of the job card.  Navigate 

down to the Posting Fasttab. 

 

12. Leave the blocked field blank. 

 

13. Click in the Department Code Dimension field and select 001-01.  The department code 

dimension is mandatory for cost pooling. 
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14. Select ALL for the Job Posting Group. 

 

15. Enter Indirect in the Job Group field. 

 

16. Enter OH the Job Account Group field.   

 

17. Billing and Revenue does not apply to indirect jobs, but enter “Do Not Compute” (DNC) in the 

Revenue and Billing Formula fields.  This is recommended to remind the user that indirect jobs 

are not for billing and revenue. 

 

18. Click in the Billing Pool Group field and select Comp 1.  This indicates how the burdens are 
calculated on labor.  This is mandatory if billing and/or revenue recognition formulas call for 

burdens. 

 

19. Leave the remaining Revenue Recognition and Billing fields blank. 

 

20. The Contract Tab is not used when the Job is Indirect. 

 

You will create WBS codes, Tasks and assign resources to Indirect Jobs. 
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Exercise 7: Revenue Recognition & Billing Formulas 

In this exercise you will review the job card setups related to billing and revenue recognition.  You will 

walkthrough setups that apply to all jobs and setups that are job type specific (FFP, T&M, and CPFF). 

 

How Revenue Recognition and Billing Formulas Work 

All jobs must have revenue recognition and billing formulas to recognize revenue and then bill it.  This is 

true for T&M projects, although the recognized revenue is immediately reversed.  For indirect jobs it is 

advised that you set the formulas to DNC (Do Not Compute). 

 

1. Expense posting:  Posting expense from a Time Journal, Job Journal, or Purchase Order creates 

job ledger entries and job planning lines if the Billing Formula calls for it.  Think of the job 

ledger and the planning lines as essential for recognizing revenue and billing. 

 

2. Recognize revenue. At the end of an accounting cycle, revenue is recognized using the Recognize 

Revenue function.  This posts to the unbilled G/L accounts as specified in the Job Posting Group 

by looking at the job ledger entries and applying the rules in the Revenue Recognition Formula.   

 

3. Creating additional planning lines. Planning lines are created by the Billing Formula rules, but 

there are exceptions. FFP jobs can use some of the costs from expense posting, but not all.  For 

example, they will have fixed billings for labor. Planning lines are therefore created using the 

Invoice Worksheet function or the ETC Worksheet function. Any job can have a planning line 

manually entered if a user wants to bill something.  These exceptions do not use the Billing 

Formula. 

 

4. Billing.  After the revenue is recognized and the planning lines are complete, the invoices are 

billed.  The Create Invoice function is used to create the billings.  The lines of the Sales Orders 

that are created are based on the job planning lines that were created using one of the methods 

above.  Posting the billings will reverse the revenue recognition from an unbilled account to an 

AR account. And correct revenue recognition if different from actual revenue in the income 

statement. 

 

Setting up rules to calculate the burdens for revenue and billing 

The Billing Pool Group on the Job Card is a setup that mirrors a cost pool setup but is much simpler.  The 

Billing Pool Group establishes how the fringe, OH, and GA cost cascade during the calculation of 

revenue recognition and billing.  This is commonly used in CPFF projects. 

1. Navigate to the Billing Pool Setup: Departments>Project Accounting>Billing & Revenue 

Setup>Billing Pool Setup. 
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2. In the “Company one pool” group the Setup equals cost pool is checked.  This means that it is a 

billing pool that calculates the same as the cost pool.  

3. Select Details in the ribbon.  This brings up the Billing Pool page. A sequence of cost types are 

listed.  This is the order in which the indirect cost will calculate the billing. The first in the 

sequence is Fringe, etc.   

4. Select the Department Set Name and the options.  This equates to the departments dimension 

setups that are on the resource and job cards. Fringe is set to All, which means that all the fringe 

will be loaded.  

5. The Cost Pool for Provisional Rate field is a link to the general Cost Pool setup and allows the 

system to grab the provisional rate for the sequence step.  This is not used if the billing rate on the 

job card is set to Budgeted. 

6. Select Base Formula from the ribbon.  The Billing Pool Formula page appears and it shows that 

the value in the fringe accounts will be distributed as burdens across the direct labor accounts.  

7. Select OK.  

8. Select the Overhead Company Site.  This has a Department Set Name of ‘Company Site,’ which 

means only the company overhead is to be used in this step of the sequence.  

9. Now select Base Formula from the ribbon.  The first line indicates that overhead costs will be 

distributed across the billing pool accounts 1 (fringe accounts) and then the direct labor accounts. 

10. The 3rd and 4th steps in the sequence distribute across the earlier steps.  

11. Click OK and Ok.  You should now have “Comp 1” in the Billing Pool Group on the Job Card.  

Clear this value.  We will enter it later. 

12. In the Billing Rate field enter Provisional.  This is the rate that will be used to calculate the billing 

for indirects.  The rate can be found in Cost Pool Setups.  If Budgeted was selected, it would take 

the budgeted rate set up on the job. 
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Exercise 8: Recognition & Billing Formulas 

Cost Plus Fixed Fee (CPFF) Type Setup 

To set up the unbilled method for revenue recognition, you need to enter two fields.  The first is the Job 

Posting Group which tells the system which unbilled G/L account to post to.  The other is the Revenue 

Recognition Formula, which tells the system how to calculate the revenue to recognize. 

 

1. Navigate to Jobs: Departments→Project Accounting→General→Jobs 

2. Open Job No. CPFF. 

3. Under the posting tab, click the drop down button on the job posting group default field and select 

advanced.   

4. The Job Posting Group page opens.  Job CPFF is assigned a project posting group default of 

ALL.  An unbilled receivable account and unbilled revenue account, sometimes known as accrual 

accounts, are assigned in the ALL posting group.   

5. Select the Revenue Recognition Formula and then enter CPF. 

6. Select the Billing Formula and then enter CPF. 

Firm Fixed Price (FFP) Type Job Setup 

1.  Return to the job list, Open Job No. FFP. 

2. Under the Posting Tab, select the Revenue Recognition Formula and enter FFP. With this 

selection, revenue will be recognized on labor, non-labor, burdens, and fees. 

3. In the Billing Formula field enter FFP Billing– With this selection, billing include non-labor 

costs, but other amount to bill we be determined by the ETC Worksheet for progress billings, or 

the Invoice Worksheet for incremental billings. 

 

Time and Materials (T&M) Type Job Setup 

1. Return to the job list, select job no. SPWAR and click edit on the ribbon to open the job card. 

2. Under the Posting Tab, select the Revenue Recognition Formula and enter EBAR.  With this 

selection, revenue recognition will be based on the amount billed. The revenue recognition 

function will use this for calculation.  

3. In the Billing Formula field enter LLR.  With this selection, billing of labor costs will be based on 

Sales Price.  The sales prices it is referring to are set up on the job card under Resource Prices.  

This is discussed further in the Labor and WTE Workbook. 
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Withholding on Revenue Recognition and Billings 

Withholding always applies to both revenue recognition and billings. 

 

1. With job no. CPFF’s job card still open, navigate down to the Posting Fasttab. 

2. Click in the Withholding Setup Name field and hit F4 to drilldown into the table.  Click 

Advanced to open the Job Withholding table.  Click New on the ribbon and enter a Name of 15 

Percent. 

3. Select the Withhold Percent on Job and enter 15.  This field represents the billing percentage 

withheld for the project. 

4. Other withholding options available: 

a. On Labor field represents the withholdings from billing of labor only. 

b. On Fee field represents the withholdings from billing of fees only. This applies to Cost 

Plus Fixed Fee (CPFF) type jobs.  
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Exercise 9: Setting up Fees 

Fees can be set up to calculate on labor, non-labor, both labor and non-labor, based on labor hours , or 

monthly, yearly, or since the inception of the project. 

 

Setting up Fees for Billing – CPFF Type Job 

1. Return to the job list, select job no. CPFF and click Edit on the ribbon to open the job card. 

 

2. Selections made on the job card will default to all new tasks. Navigate down to the Posting tab 

and locate the Revenue Recognition and Billing section.  Make sure there is a Revenue 

Recognition Formula.  If not, enter CPF.   

 

3. Next drilldown on the Billing Formula and select Advanced.  This will bring up the Formula List.  

Notice the Fee column.  If the fee option is None then the fee won’t calculate a fee.  CPF is set for 

Both which means that we will calculate fees based on the labor and non-labor.   
 

4. Enter CPF in the Billing Revenue field. 

 

5. CPF for both revenue recognition and billing formulas, we will be recognizing the fee and billing 

the fee based on the same calculation parameters. 

Note: There must be a revenue and billing formula before a fee can be calculated on top of it. 

 

6. Next we will set up the Fee Percent.  One fee applicable to a CPFF type job is the percent on 

labor (labor + fringe + OH) fee that is to be billed. To set this up, drilldown on the Fee Percent 

field and select Advanced.  The Fee Setup List will appear.  Select the ribbon and Details.  The 

Fee Setup Detail Page appears. Enter the Direct Labor as the Account Set Name and the Fee of 

5%.  On the next line enter Fringe Accounts and a Fee Percent of 5%. 

 

7. Other direct costs can be added to the Fee Setup Detail Percent on ODC represents the fee 

amount to be billed on ODC’s. 

a. Select New from the Fee Setup List and add 5pct ODC and a description. 

b. While on the new record select the Detail icon under the Process Pane in the Ribbon. 

c. Select the Account Set Name field drilldown and select Advanced.   

d. Notice that this takes you to the Account Set. 

e. Select Direct Cost Accounts and then Details from the Ribbon of the Cost Pool Account 

Set. 

f. Notice how Direct Cost Accounts represents a range of G/L Accounts. 

g. Create a ODC Account Set by first entering the Name ODC. 

h. Next add from Account 5200 To Account 5600 and OK.  

i. Select OK again and the new Account Set Name will insert into the Fee Setup Detail.  

Now add a Fee Percent of 5.  
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9. The same step can be repeated to add fee amount to be billed on subcontractor billings, material 

ODC’s, or travel billings. 

 

10. Now let’s change the fee to be based on hours. Select the drilldown on the Billing Formula and 

click Advanced. This brings up the Revenue Formula List page.   

 

11. Select New and enter CPFH as the Name. Description of Cost plus fee on hours. Control of 

formula. Labor and Non-Labor are Cost. Burden is Both and Fee is Amount on Hours. Amount on 

hours represents the additional amount to be billed per hour. Note: A job can be billed as either 

percent on labor or amount on hours not both.  Select OK. 

 

12. You should be on the Job Card CPFF now.  For fee by hour we populate the Fee Amount field.  

Add 100 to this field.  This means that for every hour $100 fee will be calculated. 
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Appendix 1: Posting Groups Hierarchy 

The G/L cost and revenue accounts declarations (Posting Groups) are in many areas.  The revenue 

accounts are used during the revenue recognition process. This section gives a brief overview of the 

locations and the order in which the system determines which account to use. 

 

1. Job Card G/L Cost and Revenue Accounts fields.  This is the highest level.  If these fields 

have G/L Accounts then any posting to these Jobs will go to these accounts.  This is used for 

fringe jobs like PTO and holiday. 

 

2. Job Group on the Job Card is 2nd in priority.  The G/L accounts are specified on the Job 

Group Card.  Drilldown on the Job Group and select Advanced.  Select any record from the 

Job Group List and then Detail in the ribbon. 

 

3. Job Account Groups on the Job Card is 3rd in priority.  The G/L accounts are specified on the 

Job Account Group Detail page.  Drilldown on the Job Account Group field and select 

Advanced. From the Job Account Group List select any record and then details in the ribbon.  

These can be left blank so the Job Category G/L accounts will work in the next level. Remain 

on the Job Account Group Detail page for instruction on the next level of priority. 

 

4. Job Category which can be found on the Job Account Group or selected when transacting, 

shares in the 4th level of priority.  The G/L accounts are specified in the Job Category Card.  

These accounts are not intended for setting up labor G/L Accounts. But is very important to 

create Labor Categories which classify the work performed in a transaction.  When a Job 

Category is created with a type of labor, a Labor Category is automatically created also.  If a 

labor G/L account mapping is desired then refer to step 6.  From the Job Account Group 

Detail page, drilldown on the Job Category and select Advanced. Select a record and then 

Details in the ribbon. These can be left blank so the Category Group G/L accounts can be 

used in the next level of priority.  Remain on the Job Category Card to following the 

instructions for the next level of priority. 

 

5. Category Group on the Job Category Card is 5th in priority. The G/L accounts are located on 

the Category Group List page.  From the Job Category Card, drilldown on the Category 

Group and select Advanced.   

 

6. On the Category Group page, select the record for labor and then Resource Class from the 

ribbon. Category Group Resource Class shares in the 4th level of priority and is intended for 

labor related G/L accounts.  These classes are applied to a Resource card.  Navigate to a 

Resource Card, select the Class Code field, drilldown, and select. The class code provides 

the flexibility to post a regular employee to different G/L accounts than a subcontractor or 

consultant.   
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Appendix 2: Posting Group Controls 

In addition to the Posting Group Hierarchy, there are controls on the posting groups to prevent or restrict 

posting to certain types of transactions. 

1. On the cost and revenue accounts on the Job Card have no restrictions. 

2. On the Job Account Group List, you can flag that labor postings using the Restrict to Labor 

Category field.  The Job Account Group is a collection of Job Categories.  If we set the restrict to 

labor category, we are entering a condition that labor can only be posted to the Job Categories 

that are valid for labor in this Job Account Group   

3. On the Job Category List, you will see a Valid for column.  That means only expenses or revenue 

that are Valid for Labor, Expense, Fee or Burden (depending on selection) can be posted to that 

job category. Expense is a direct non-labor expense and Burden is non-labor indirect expense. 
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Exercise 1: Job Budgeting 

This exercise will walk you through setting up a job specific budget by manually entering the budget into 

NAV and using Excel to build job budgets.     

 

Budgeting Labor against a Job 

We know which resources will be on a job for the remainder of the year and want to budget their expected 

hours against a job.   

1. Navigate to Jobs: Departments→Project Accounting→General→Jobs 

2. Select Job No. SPWAR0001. 

3. Select Budgeting & Forecasting in the Ribbon.  The Edit Job Budget screen opens.   

4. Under the General Tab, enter the following information: 

a. View By should be set to month for data entry.    

b. Select Job Task 001-001 to enter hours against. 

5. Click Add Resource under the Home tab of the Ribbon and select resource no. 232.  A line for 

Project Manager II is added to the Budget Matrix. 

6. Budget hours for the next 12 months by manually typing the hours in the fields and tabbing 

through. 160,176, 176, 184, 168, 160, 160, 160, 176, 176, 168, 168.   

 Note: The budget matrix view is for 12 months with the first month being the current month.  This view can be changed 

using the date filter under the Filter Tab or by clicking the navigation arrows in the ribbon. 

7. Click Re-calculate Totals in the ribbon.  

Indirect Costs, Total Cost, Total revenue and Profit Percent at the bottom will update for each 

month in which labor hours are entered. 

 

To view the job budget entry lines you have just created, select a field and drill down using F4.  This 

will show you the detailed entry including the G/L account, Labor Category, Hours, Budgeted Cost 

and Budgeted Revenue. 

 

1. In the Budget Matrix, on the line for Frederick Sanger, click in the field under July. 

2. Click F4 to drill down and the Job Budget Entry Lines appear. 

 

The Billing Rate is increased each year. Enter the same hours per month for Project Manager II for 

the second contract year. 

 

1. Click the Next Set option in the ribbon. 

Note: The column headings are for the next contract year. 

2. Enter the same hours per month for Project Manager II. 

3. Click the Re-Calculate Totals icon in the ribbon. 

Note: The Total Cost has not increased but the Total Revenue has. 
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1. Add Resources 229 and 246. 

2. Click in the first month for Fredericks Robbin and hit F8.  

3. Tab to the next field and hit F8. Repeat one more time. 

Note that you have entered hours for the incorrect contract year.  

4. Zero out the hours that you copied. 

5. Drilldown on one of columns for Federick Robbins. 

Note: a negative entry was created to zero out the entry. 

6. Click the Previous Set icon to return to the first contract year. 

7. Enter hours per month for each of the additional resources. 

8. Recalculate the totals. 

 

Budgeting ODCs against a Job Task/WBS  

We want to budget all non-labor costs against a job for the remainder of the year at a high level 

(excluding indirects which will be in a later exercise).     

1. With the Job Budget page for Job No. SPWAR0001 still open, there are lines in the matrix for 

travel costs, material costs, and other direct costs.  If these fields are not available on the budget 

matrix, click Add Account in the ribbon. 

2. Select the travel costs line and enter 1500 for each month in the contract year. 

3. Click on the line for Material and enter 500 for each month in the contract year. 

4. Click recalculate cost in the ribbon. 

5. Total costs and revenue budgeted for ODC’s appear under costs and revenue total at the bottom 

of the Budget Matrix. 

 

Budgeting ODCs against a Job (G/L Account Level) 

We want to budget all non-labor costs against a job for the remainder of the year for each g/l account 

(excluding indirects which will be in a later exercise exercise).     

1. With the Job Budget page for Job No. SPWAR0001 still open, delete the travel and material 

budget entries entered in the previous exercise by drilling down into the job budget entry page 

and deleting each entry. 

2. Once all previous entries for ODCs are deleted, select Add Account on the ribbon.  The G/L chart 

of accounts list opens and it is filtered on all ODCs. 

3. Select account no. 52110 (Hotel) and click ok.  A new line for Hotel costs is added to the budget 

matrix.  WBS code 001-000 is defaults from the header down to the line. 

4. On the hotel line, enter 2000 for each month in the contract year. 

5. Click recalculate cost in the ribbon. 

6. Total costs and revenue budgeted for the hotel appear under total travel costs, total costs, and 

revenue total at the bottom of the Budget Matrix. 

7. Repeat steps 2-5 for the direct material and other fees g/l accounts. 
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Export Budget to Excel 

A standard Job Budgeting template can be exported to Excel for easy budgeting data entry.   

1. With the Job Budget page for Job No. SPWAR0001 open, select Export to Excel under the Home 

tab of the Ribbon. 

2. Enter date range of 070112..063013 and select a Report Type of Budget and click OK.   

Note: the data range doesn’t limit which data you can enter on the excel spreadsheet.  It limits 

which data is exported out of NAV from the Job Budget. 

 

Import Budget from Excel 

A standard Job Budgeting template can be imported from Excel for easy budgeting data entry.   

1. With the Job Budget page for Job No. SPWAR0001 open, select Import from Excel under the 

Home tab of the Ribbon. 

2. Click the Assist Button next to Workbook Name and then select the excel file to import. 

3. Click the Assist Button next to Worksheet Name and then select the worksheet from the 

previously selected file you wish to import. 

4. Under the Import Options Tab, select the option to Append Entries, a report type of Budget and 

place a check mark in the header row field. 

a. The option field allows the user to append entries or replace entries.  Appending entries 

will add the budget lines to the current budget.  Replacing entries will erase the current 

budget lines and add the new ones. 

b. The header row field lets NAV know if the first row on the file is a header. 
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Exercise 2: Copying Budget to G/L Budget 

Copy Job Budget to G/L Budget 

The Job budget that you have created can now be copied to the G/L Budget to negate the need for double 

entry.   

1. With the Job Budget page for Job No. SPWAR0001 open, click the Navigate tab.  

2. Select the Copy to G/L Budget option in the ribbon. 

The option page for the Copy function is displayed. 

3. Click in the Budget Name field and select the appropriate budget to copy the entries into: 

FY2012. 

4. On the Job Tab click in the No. field and select the Job you are currently working on: 

SPWAR00001. 

5. Click in the Posting Date Filter field and enter the period of time for the Budget that you are 

copying to the G/L Budget: 0101..1231. 

NAV has created G/L Budget entries for based upon the Budget you created in Job SPWAR0001 

6. Navigate to Financial Management, General Ledger, G/L Budgets and select Budget: FY2012. 

7. On the General Tab set the value for View by to month. 

8. On the filters Tab set the Date Filter value to be the date range for this Budget: 0101..1231. 

9. In the G/L Account Filter set to value to the G/L Accounts that you wish to review: 

40000..99999. 

10. Review the G/L Budget entries. 

. 
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Exercise 3: Indirect Job Budgeting 

This exercise will walk you through setting up a budget for an Indirect Job.     

Budgeting for an Indirect Job 

We want to create a budget for the Indirect Job, HR so that we can copy the Budget to the G/L.   

1. Click Jobs on the Role Center list. 

2. Select Job No. HR. 

3. Under the Home tab of the Ribbon, select Budgeting.  The Edit Job Budget screen opens.   

4. Under the General Tab, enter the following information: 

a. View By should be set to month for data entry.    

b. Select Job Task 001 to enter costs against. 

5. Click in the Total Cost cell for September 2012 then click on the button with 3 dots. 

6. Click in the G/L account field and enter 61100 (OH Labor).  

7. Enter the budgeted Labor cost for Task 001 for OH Labor in the Budgeted cost field.  

8. Click on the next line and enter the G/L Account for O/H Supplies: 62800 in the G/L Account 

No. field. 

9. Enter 250 in the Budgeted Cost field. 

10. Escape back to the Job Budget page and hit the F5 key (Refresh). 

11.   Copy the Budget entries for September and paste them into October. Remember to change the 

Starting Date. 

12. Escape back to the Job Budget page and hit the F5 key (Refresh). 
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Exercise 1: Purchase Orders, Receipts, and Invoicing 

In this exercise you will create a new purchase order for sub-contractor labor in NAV.  The purchase 

order will apply to a job.  Next you will receive the purchase order and create the purchase invoice against 

the vendor record. 

Create a New Purchase Order for subcontract labor 

1. Navigate to the Orders List: Departments→Project Accounting→Purchase→Orders  

The purchase order list is displayed. 

2. On the ribbon, select the New icon.  A New Purchase Order page is displayed. 

3. Click enter to auto-generate a purchase order no. per your no. series setup selection.  A new 

purchase order is created after a number is assigned to it. 

4. Select vendor no. V00190 ALC003 – Alcorp. 

5. Navigate to the purchase lines and right click on the Type field and select Choose Columns. 

Add the following fields to the purchase lines: 
• Department Code Dimension 

• Quantity Received 

• Quantity Invoiced 

Click OK. 

6. Enter the following information on the 1st line: 
Type: G/L Account  

Job No.: 2002 

Job WBS Code: 001-001-01 

Job Category Name: Technician II 

Resource No: 810 – Samuel Morse  

Quantity: 10  

Direct Unit Cost Excl. VAT: $300.00 

 The department code dimension will default to the department selected on the job card. If it is 

blank, it is because there is no department on the Job Card. Notice the quantity to receive and 

quantity to invoice are auto-populated.  These fields will be updated to record receipt and 

invoice quantities (The quantity to invoice cannot be higher than the total amount received). 

7. Click the Release button in the ribbon.  The status field is updated to Released. 
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Receive Purchase Order Line 

1. With the previously created purchase order open, update the posting date (financial date) to a new 

date.  This just simulates that you may be posting to a different date than the one originally 

entered, because you might order on Tuesday and receive on Friday. 

2. Navigate down to quantity to receive field on the lines.   

3. Enter 6 in quantity to receive field and tab to the quantity to invoice field. 

4. Enter 0 in the quantity to invoice field.   

5. Click Post on the ribbon.   

Select Receive on the option page and click OK.   

Notice the quantity received field updates to 6 and the quantity to receive updates to 4.   

6. To view the posted receipt, click Receipts in the ribbon of the navigate tab. 

 

Invoice Purchase Order Line 

1. Return to the Purchase Order previously received. 

2. Update the posting date to be the financial date of this expense. 

3. Update the document date (Vendor Invoice Date) for this invoice. 

4. Click in the Vendor Invoice No. field and enter 12345. 

5. On the line, enter the Quantity to Invoice, 5.  Blank out the value in Qty. to Receive. 

6. On the Action tab of the ribbon, select Test Report.  

Check the Receive/Ship and Invoice check boxes and then select the Preview button. 

7. The test report will open.  Ensure there are no warnings and that the amount to be invoiced agrees 

with the Vendor’s Invoice. If a warning exists, it will state, “Warning!” on the report.   

Escape once finished reviewing. 

8. Click Post on the home tab of the ribbon. 

Select Invoice on the option page and click OK.  Notice the quantity invoiced field updates to 5.   

9. To view the posted invoice, Click Invoices in the ribbon under the navigate tab.    
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Exercise 2: Subcontracts  

In this exercise you will create a new subcontract in NAV and it will be approved by the project manager 

of the job using MS SharePoint.  Once approved, a purchase order is generated from the subcontract. 

Create New Subcontract 

1. From the Home Menu, select Subcontracts.  The sub contract list is displayed. 

You can also use this path: Departments→Project Accounting→Purchase→Subcontracts 

2. Click the New icon on the ribbon. 
No: SUB1 

Select Job No. 1002 

Select Job Task No. 002-001 

Buy-from Vendor No. ALC003 (subcontractor’s vendor card).  

Description: The description will populate based on the vendor selection. 

Subcontract Type: Time & Material 

Starting Date: 010114 (Informational purposes only). 

Ending Date: 123114 (Informational purposes only). 

Contract Is for: Job Task (This will default from the job and task no. being entered in the previous fields).   

Funding By Category Groups: Select this checkbox.   

This allows the user to break out funding by labor, material and travel versus entering one funding line.  It 

also restricts purchase lines from exceeding the funded amount by category group as indicated on the 

Subcontract Line. 

Expended:  

3. Navigate down to the subcontract lines. 

4. Enter a line to record funding for Travel.  
Category Group: Travel 

Job Category Name: Travel  

G/L Account will default as 5200 (Direct travel account) 

Funded Amount: $10,000 

5. Press F5 to refresh the page. 

The Funded Amount field on the general tab shows $10,000. 

6. Click Send for Approval on the ribbon under the home tab (the subcontract is sent out for 

approval using the SharePoint integration). 

Note: When not using SharePoint integration the Status field will automatically change to Approved. 

 

Create New Purchase Order for Materials 

1. Navigate to the Orders List: Departments→Project Accounting→Purchase→Orders  

The purchase order list page is displayed. 

2. On the ribbon, select New.  A new purchase order page is displayed. 

3. Click enter to auto-generate a purchase order no. per your no. series setup selection.  A new 

purchase order is created after a number is assigned to it. 

4. Select vendor no.  

5. Navigate down to the purchase lines. 

6. Enter the following information on the line. 
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Type: G/L Account 

No.: 5300 

Job No.: 1002 

Job WBS Code: 001-001-02 

Job Category Name: Materials 

Subcontract No.: SUB (number from previous exercise). 

Quantity: 5 

Direct Unit Cost Excl. VAT: $200 

7. Click Release in the ribbon of the purchase order under the home tab. 

8. Navigate back to the previously created subcontract card.  The obligated amount against the 

subcontract card is $1000 (the amount of the purchase order). 

9. Once this purchase order is fully received and invoiced, the expended amount on the header of 

the subcontract will update with the amount of funding spent.  
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Exercise 1: Billing Group 
In this exercise you will learn how to create a billing group and add tasks.  

 

Create a Billing Group  

1. Navigate to the job card: Departments→Project Accounting→General→Jobs→Job card 2025 

 

2. Select the Billing Group link in the ribbon of the job card. 

 

3. Select the Billing Group drop down to open the billing group list page. 

Choose the Monthly billing group and click OK. 

 

4. Select the Job WBS Codes using the Range function at the bottom of the billing group lines page.  

Type 001-001..001-99 and select the Add Range function in the ribbon.   

 

5. Notice that the Job Task No. and the Job Task Description auto-populate based on your work 

breakdown structure setup. 
 

Exercise 2: Generating Multiple Invoices  
In this exercise you will learn how to generate multiple invoices for one job using billing groups 

Scenario: 

Need 3 invoices for one job.  Create 3 billing groups and check multi-select. 

 

Multiple Invoices  

1. Navigate to the job: Departments→Project Accounting→General→Jobs→Job card 1002 

 

2. Select the Billing Group link in the ribbon of the job card. 

 

3. Select the Billing Group drop down to open the billing group list page and select Edit List. 

 

4. Choose the multi-select checkbox for the Support Plan billing group.  Select two existing Billing 

Groups and make sure the multi-select checkbox is selected for both and click OK.  Multiple 

invoices will now be generated for this job at once.   

 

5. Select the Create Invoice function in the ribbon of the job card. 

Enter the following information to create your invoice. 
Job No: 1002 

Billing Group Name: Support Plan 

Multi-Select: Select the checkbox 

Period From: 1/1/2014 

Period To: 1/31/2014 

Click OK. 



 

 

 

Revision 1.10 

 

 

 

6. Select the Invoice Proposals link in the ribbon to view the invoices. 

 

7. When multiple billing groups are utilized to invoice a job, the Contract Type, Contract 

Amount, and Funded Amounts displaying on the GC Sales Invoice report will be based on the 

first listed task in the billing group. 

Exercise 3: Billing Pool Group 

Subcontract & Material Handling 

1. To navigate to the Billing Pool Group Setup:  
Departments→Project Accounting→Billing & Revenue Setup→ Billing Pool Group 

 

2. Select the New icon in the ribbon of the Billing Pool Group list page. 

Enter the following information to create your billing pool group. 
Name: Job 2025 with SMH 

Description: Fringe, OH, SMH, G&A 

Setup equals cost pool: Do not select the checkbox. 

 

3. Select Details in the ribbon.  

 

4. Enter the following information on the lines to create your billing pool group. 

Sequence Name 
Department 

Set 

Cost pool for 

provisional 

Job Category 

Name 

1 Fringe All 1 Blank 

2 OH Company Site 2 Blank 

3 OHCS Client Site 2 Blank 

4 SMH Client Site 3 

Subcontract 

Provisional 

5 GA All 4 Blank 

 
Note: The sequence number is auto-generated so it may not match the example. 

Note: If the Subcontract Provisional Job Category doesn’t exist create it. 

Departments→Project Accounting→Category Group Setup→Job Category 

Name: Sub Contract Provisional 

Description: Subcontract to project provisional  

Category Group: Sub 

Cost Account: 9750 

 

5. Highlight each line and select Base Formula in the ribbon.   Populate the billing formula tables 

with the following data. 
 

Sequence Name Name Code 

1 Fringe Account Set Direct Labor 

2 OH Billing Pool 

Account Set 

1 

Direct Labor 

3 OHCS 
Billing Pool 

Account Set 

1 

Direct Labor 

4 SMH Account Set Direct Subcontract and Material 
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5 GA 

Billing Pool 

Billing Pool 

Billing Pool 

Billing Pool 

Account Set 

9 

10 

11 

12 

GA without Sub & Mat Accts 
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6. Open Job 2025: Departments→Project Accounting→General→Jobs→Job Card 2025 

Select the Billing Pool Group Job 2025 with SMH on the posting tab of the job card. 

Select Work Breakdown Structure in the ribbon on the home tab of the job card. 

Select the Job WBS Code  and select Task Detail in the ribbon to open the task card. 

Select the Billing Pool Group Job 2025 with SMH on the posting tab of the task card. 

 

7. Select Create Invoice to generate an invoice. 

 

8. Select Invoice Proposals to verify and post invoices. 
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Exercise 4: Creating and Posting an Invoice Worksheet  

In this exercise you will create a sales invoice worksheet for a T&M type job using the functions located 

in the project accounting module.  NAV creates an invoice worksheet from the billable usage entries of 

expense and labor in the project ledger. 

Determine Which Jobs to Invoice 

1. From the Role Center Activities click on Invoices Due – Not Created. 

2. The list of jobs with billable usage entries overdue for invoicing is displayed. 

 

Creating an Invoice Worksheet – Create Sales Invoice Multiple  

1. Click on job SPWAR0001, right click and select edit.   

2. Select Create Invoice in the Process tab of the Action Pane. 

3. Enter the applicable billing period in the date filter: 0801..0831 

4. Other options available: 

a. Job WBS allows the user to filter on specific task(s)  to invoice. 

b. Invoice by Task will create a separate invoice per task. 

5. This function creates the invoice worksheet with all required information.  The worksheet is 

divided into two sections, the header and line entries, which are reviewed below. 

 

Header  

Here you see the Billing information about the customer. 

1. Open the job card for job no. SPWAR0001 and select invoice worksheet on the ribbon. 

2. The sales invoice worksheet list opens filtered to show only the unposted sales invoices for job 

no. SPWAR0001. 

3. Select the most recently generated invoice and click edit on the ribbon to view the sales invoice 

worksheet. 

4. Under the general tab, the following information is displayed: 

a. The No. field is the system generated (internal) worksheet number. 

b. In the Sell-to Customer No. field is the job’d client information. 

c. The Posting Date and Document Date are automatically updated as the last Date selected 

in the Date Filter when the Create Function is run. 

5. Under the invoicing tab, the following information is found: 

a. The bill-to customer is the payment office specified on the job card. 

b. The Posting No. field allows the user to manually specify what to use as the document 

no. for the resulting invoice. 

c. The payment terms code defaults from the customer card.  Change the code to net 30. 
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d. The due date is calculated as the document date plus the number of days the payment 

terms specified above (it changed when the payment terms code was updated). 

Lines 
 

1. Here are the billings such as direct labor, other direct costs (broken out by subtype), indirects, 

fees and withholdings. 

2. The Invoice Worksheet is created from open Planning Lines for the selected Billing Date range.  

Other lines such as Fees, Overhead, and Withholdings are added to the Invoice Worksheet based 

on the Job Card’s set up. 

 

Printing the Invoice Worksheet 

After the invoice worksheet is created, you can print a sample invoice worksheet prior to posting the 

invoice.  Printing can be done in multiple formats and can include specific billing details depending on 

the options selected. 

1. Click Print Invoice Worksheet on the ribbon.  

2. The invoice options page appears. 

3. Select the appropriate Options for this Invoice Worksheet based off of your customer’s 

requirements or internal policies. 

a. Choose Invoice Format 

i. By Labor Category 

ii. By Resource 

b. To Date Option 

i. Inception to Date 

ii. Year to Date 

c. Line Print Option 

i. Print WBS Code 

ii. Print CLIN 

iii. Print ACRN 

d. Roll-up 

i. Level 1, 2, or 3 

e. Task Breakout 

f. Print Company Address 

g. Print Payment Office Address 

h. Roll Indirect into Direct 

i. Show Billing Period 

j. Show Period of Performance 

k. Show Non Labor Sections 

l. Show Sub Labor as D/L 

m. Show Indirect Detail 
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n. Show Fee Detail 

o. Show Certification Lines 

p. Task Filter for Amount to Date 
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Ignore for Billing – Job Planning Lines 

After reviewing the Invoice Worksheet you may determine that something should not be invoiced in this 

period. On the job planning lines, we have the ability to mark Usage Entries as Ignore for Billing so that 

they will not be included on a Billing Invoice.  

1. Delete the Invoice Worksheet. 

2. Click Job Planning lines from the ribbon. 

3. Place your curser on the line that you do not wish to bill for at this time.  

4. Click on the Actions tab in the ribbon and select Ignore for Billing. 

a. A checkmark is placed in the Ignore for Billing field on the Planning Line (far right 
column).  

b. When you recreate the sales invoice this entry will be ignored. You will need to repeat 

the process to uncheck the entry when you are ready to bill it. 

5. Recreate the invoice and review the lines.  You will notice the total amount of the sales invoice 

worksheet generated has decreased by the items(s) set to ignore and any applicable G&A. 

  

Posting the Sales Invoice 

Post the Invoice Worksheet after reviewing the printed worksheet.  

1. Validate that the posting and document dates are correct. 

a. Posting Date is the financial date for the sale. 

b. Document Date is the invoice date. Document date is used to calculate the due date 

based upon payment terms. 

2. Click Post on the ribbon. 

a. A message appears verifying if you want to post the invoice. 

b. Once the invoice is posted, the transaction cannot be reverse unless a credit memo is 

generated from the job planning lines and applied against the posted invoice. 

3. Once an invoice worksheet is posted it is stored under posted sales invoice (departments, 

project accounting, processing, history, sales, posted invoices). 

The Posted Invoice button in the ribbon of the job card lists all posted invoices for the job. 

 

Printing the Posted the Sales Invoice 

After the sales invoice has been posted, it is ready to be printed and sent to your client.  NAV has a few 

base government contractor invoice formats, along with required government invoicing forms.   

1. Select Jobs from the home menu. 

2. Select Job No. 1907 from the list and open the job card. 

3. On the ribbon, select Posted Invoice. 

4. Double click on the invoice you wish to print. 

5. The ribbon contains the different invoice formats available in NAV: 
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a. Invoice Current Column 

b. Invoice with YTD/ITD Columns (in addition to current) 

c. ODC Backup 

d. On the actions tab you have additional priting choices: 

e. Forms 

i. DD250 

ii. SF 1034 

iii. SF 1035 

f. Product Invoice (if using the Product Contracts Module) 
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Exercise 5: Create a Sales Credit Memo 

In order to generate a sales credit memo and apply the credit against a posted invoice, a sales credit memo 

must be generated from the Job Planning Lines. 

 

Create Sales Credit Memo 
 

1. From the home menu select jobs. 

2. Click on Job No. 1907 and open the job card. 

3. Select Job Planning Lines from the ribbon and the planning lines open. 

4. Select Create Sales Credit Memo and the Job Transfer to Credit Memo page is displayed. 

5. Enter the Posting Date for the credit memo you wish to create. 

6. In the Applies-to Invoice No. field, drill down and you will see all the Posted Sales Invoices. 

7. Select the invoice you wish to create a credit memo against (this will apply the credit memo to the 

invoice). 

8. Click Ok to return to the Job Transfer to Credit Memo page. 

9. Click Ok to generate the Sales Credit Memo. 

10. Navigate to the Sales Credit Memo list, Departments, Project Accouting, Processing, Sales, 

Credit Memo. 

11. Double click on the Sales Credit Memo just created.   

12. Review, ensuring the Posting Date and document date are correct. The Create Credit Memo 

function defaults to the `current system date. 

Do not run the create credit memo function a second time for the job without first deleting the 

first Credt Memo.  

13.  Click post in the ribbon. 

The Credit Memo has been applied to the Invoice. You are now able to regenerate the invoice 

(after making necessary adjustments – set ignore for billing, labor adjustments, additional ODC’s. 
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Exercise 6: Billing for FFP Jobs 

By definition, Usage entries for Firm Fixed Price Jobs are not associated with a Price unless the contract 

allows for the billing of ODC’s. In this exercise you will learn how to create Planning Lines for Billing of 

Firm fixed Price Jobs.  Once these lines are created, the invoice generation process is the same as the 

previous exercise.  

 

Create Job Planning Lines 
 

1. From the home menu select jobs. 

2. Click on Job No. 1902 and open the job card. 

3. Click Job Planning Lines in the ribbon, and the job planning lines are displayed. 

4. Click New.  

5. Enter 0805 in the Planning Date field. 

6. Enter Fee in the Document No. field. 

7. Enter 001-000 in the Job WBS Code field. 

8. Select G/L Account in the Type field. 

9. Enter Fee in the Job Category Name field. 

10. Enter “Services rendered for period” in the Description field. 

11. Enter 1 in the Quantity field. 

12. Enter 25000 in the Unit Price field. 

13. Select Fee in the Sub Type field (should default). 

14. Press Ok. 

15. Repeat 3 – 14 substituting 002-000 as the Job WBS Code and 1500 as the Unit Price.  

 

Copy Planning Lines 
 

Many FFP billings are for a specified dollar amount over a period of time. The copy planning lines 

function allows the user to create planning lines for billing for multiple periods into the future. 

1. With your curser in the Planning Line created above click on the Navigate tab and select Copy 

Planning lines. 

2. Enter number of Copies. 

3. Enter Starting planning Date. 

4. Enter an Increment by value, i.e. 1M (every month), 2W (every 2 Weeks). 

5. Press OK. 

6. Planning Lines have been created as specified. 

7. You can now modify the Amount or Planning Date on one or all of the Planning Lines just 

created. 
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Create Invoice Worksheet for FFP Jobs 
 

1. Return to the job card for job 1902 and run the create invoice function. 

2. Click on the Invoice Worksheet button, using 0801..0831 as the Date filter. 

3. Double click on the invoice worksheet in the list. 

4. Review the invoice worksheet by selecting the print invoice worksheet button. 

5. Place a checkmark in the option to Show Fee Detail.  

This will print the Description that you entered on the planning lines. 
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Exercise 7: Billing for CPFF or T&M Jobs 

On the job card, you can setup the job to bill using the provisional or job specific budgeted rates for a 

CPFF job.  The provisional rates apply to the entire company and are assigned in the cost pool setup. 

 

Viewing Provisional Rates 
 

1. Navigate to the cost pool setup, Departments, Project Accounting, Setup, Cost Pool Setup. 

2. Select a pool and click Rate Setup on the ribbon. The provisional rates will be used when the 

invoice is generated. 

 

Create Invoice Worksheet – CPFF/T&M Job Type 
 

1. Select Jobs from the Home Menu. 

2. Select Job No. 1001 and open the job card. 

3. Select Create Invoice on the ribbon. 

4. Enter a date range of 1001..1031 and click ok to generate the invoice worksheet. 

5. Select Invoice Worksheet from the ribbon and the sales invoice worksheet list opens. 

6. Select the invoice just generated and click edit to view. 

7. You will notice the lines generated capture all billable costs including the indirect rates applied to 

them.   

The cost pool setup for this company rolls the fringe into the overhead thus there isn’t a separate 

line for fringe. 

8. Review and post. 
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Exercise 8: Project Accounting Reports 

In this exercise you will generate Project Accounting Reports related to billing and revenue.  

 

Aged Project Receivable Report 
 

1. Navigate to Aged Project Receivable Report, Departments>Project Accounting>Reports>Aged 

Project Receivable  

2. Type 103112 in the Aged as of field. 

3. Select Document Date in the Aged by field 

Selections in this field will determine if the aging will be calculated from the due date, posting 

date, or document date 

4. The length of aging periods allows the user to customize the the number of days in each aging 

bucket. 

5. Place a checkmark in the Print detail field. 

6. Press Preview.  

NAV generates the aged AR report by job as opposed to by customer. 

Filters can be set to print the Aged project Receivable Report for a specific job, division project 

manager or job type. Or any combination. 

 

AR History by Project  
 

1. Navigate to the AR History by Project Report, Departments>Project Accounting>Reports>AR 

History by Project. 

2. Select Project 7002 in the Project Filter 

3. Press Preview 

The report lists all AR transactions for the job. 
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Project Detail with Billing 
 

1. Navigate to the Project Detail with Billing Report, Departments>Project 

Accounting>Reports>Project Detail with Billing 

2. Place a checkmark in the Show By Task option. 

3. Enter 1907 in the No. filter. 

4. Enter in 1001..103112 in the Posting Date Filter.  

5. Press Preview 

   

Project Revenue Summary 
 

1. Navigate to the Project Revenue Summary Report, Departments>Project 

Accounting>Reports>Project Revenue Summary. 

2. Select Provisional-Caculated in the Rate Type field.  

This option will allow you to report on costs with indirects prior to run the cost allocation 

process.  

Beware that calculations of indirect costs are being performed and can affect system performance. 

a. Other options available:  

i. Provisional-Posted – default selection 

ii. Actual-Posted 

3. Type 100112..103112 in the Posting Date Filter 

4. Press Preview 

   

Unbilled Analysis  
 

1. Navigate to the Unbilled Analysis Report: Departments>Project Accounting>Reports>Unbilled 

Analysis. 

2. Enter 13360 in the Unbilled Account Field 

3. Type 1001..1031 in the Posting Date filter 

4. Press Preview 

 

Unbilled Trend 
1. Navigate to the Unbilled Trend Report, Departments>Project Accounting>Reports>Unbilled 

Trend  

2. Press Preview. 
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Cost Allocation 
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Exercise 1: Cost Pool 
In this exercise you will learn how to create a Cost Pool for a company using 4 pools: “Fringe”, “OH 

Company Site”, “OH Client Site”, and “G&A”.    

 

Create a Cost Pool  

1. Navigate to Cost Pool:  

Departments→Project Accounting→Cost Pool & FCCOM Setup→Cost Pool 

 

2. Select the New link in the ribbon of the cost pool setup screen to create a new cost pool line and 

name the first cost pool “Fringe”.   

 

3. Click Pool Cost & Base in the ribbon, enter the following in the setup table, and click OK.  

 

 

 

 

 

  

 

4. Click Account Set in the ribbon.  Select the line for Direct Labor and click Details in the ribbon. 

The range for Direct Labor is 5100-5120. 

 

5. Add a second line for G/L Account 8810 – IR&D Direct Labor and click OK. 

 

6. Repeat steps 2-5 for the following pools. 

 

Name Pool Cost & Base Account Set 

OH Company 
Site 

 

Direct Labor w Fringe Applied: 5100-5120 
Add Direct Labor w Fringe Applied Actual: 9610 
Add Direct Labor w Fringe Applied Provisional: 
9630 
 
  

OH Client Site 

 

The account set is the same as the OH Company 
Site Pool account set. 
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G & A 

 

GA Base Accounts: 5000-5600 
Add the following: 9610, 9670, 9710 

 

Exercise 2: Allocate Costs 
In this exercise you will learn how to run the “Allocate Cost” periodic activity.    

 

Allocate Costs  

1. Navigate to Allocate Costs:  

Departments→Project Accounting→Periodic Activities→Allocate Costs 

 

2. Enter the Accounting Period: 1/1/14 and click OK to calculate the allocations. 

 

3. Navigate to Job Card 2025 and verify the ledger entries that were created are accurate. 

 

Actual Rate 

1. Navigate back to your cost pool setup to view the actual rates calculated. 

Departments→Project Accounting→Cost Pool & FCCOM Setup→Cost Pool 

 

2. Select the cost pool line that you would like to see the actual rate for and click Actual Rate in the 

ribbon of the list page.  The actual rate will be displayed. 
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Revenue Recognition 
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Exercise 1: Recognize Revenue  

When your Company recognizes Revenue based upon the unbilled method you must run the Revenue 

Recognition function in order to recognize revenue.  

 

Calculate Revenue  

1. Navigate to Calculate Revenue Accrual:  

Departments→Project Accounting→Periodic Activities→Calculate Revenue Accrual 

 

2. Enter Accounting Period: 1/1/14 and click OK. 
Note: Revenue will be calculated for all tasks within the selection. 

 

3. Navigate to Review and Post Revenue Accrual: 

Departments→Project Accounting→Periodic Activities→Review and Post Revenue Accrual 

 

4. Do not select the checkbox for Post and click Preview. 

 

5. Verify that the calculations are correct. 

 

6. Run the Review and Post Revenue Accrual again selecting the Post checkbox to post revenue. 
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Exercise 2: Estimate to Complete for FFP 

Estimate to complete is a revenue recognition methodology used for fixed price tasks.  It uses the actual 

cost incurred (a cost budget) to calculate a percent complete and funding on the task to calculate the 

revenue accrual (Actual Cost/Cost Budget x Funded Amount).  The estimate to complete worksheet can 

be found on the job card. 

 

Create an ETC Worksheet 

1. From the Home Menu select Jobs. 

2. Select Job No. 3002 and open the job card. 

3. Select Fixed Price ETC Wkst from the ribbon.  A blank worksheet opens (unless used before). 

4. Enter 1031 in the Planning Date field. 

5. Click Import Tasks on the ribbon.  All tasks for the job are brought into the worksheet with the 

following information: 

a. Previously Recognized Revenue 

b. Funded Amount 

c. Budgeted Cost 

d. Spent to Date 

e. Percent Complete 

f. Billing this Period (if invoices previously generate, it will show a negative total amount 

for these invoices). 

6. If the PM decides that the percent complete is actually different from what has been calculated 

you have the ability to change the percent complete to generate a more accurate billing amount. 

7. Click Update Amount Due on the ribbon (the line calculates the percent complete). 

8. Click Update Amount Due on the ribbon (the amount due to the contractor amount updates with 

the amount that can be invoiced this period based on the percent complete and the amount 

previously invoiced). 

9. Click Create Planning Lines on the ribbon to generate planning lines to invoice based on the 

amount complete.  You can invoice from this screen as well by selecting Create Invoice. 

10. Click Revenue Recognition on the ribbon.  The system will generate Job G/L Journal Lines 

11. Review and post the journal lines. 
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Time, Expense, and Requisition 
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Exercise 1: Timesheet Entry 

In this exercise you will enter time for a pay period and submit it for approval.  After it is submitted, all 

required approvers will approve the timesheet.   

Membership 
In order to charge time to a WBS code, the resource must be included in the membership detail of the 

membership code assigned to the WBS code.   Perform the following steps to ensure that Carl Simmons is 

assigned to the applicable WBS codes for jobs GA and 4002. 

 

1. Launch NAV and navigate to Departments > Project Accounting > General > Jobs. 

2. Open Job 4002 and select Work Breakdown Structure on the Home tab of the job card.  

3. Locate WBS code 001-001-01 and ensure that the membership code Project 4002 Team is selected 

in the Membership field. 

4. Remain on the Membership field and drill into the drop down list of membership codes.  Click 

Advanced to open the membership table.  

5. Highlight Project 4002 Team and click Details.   

6. Ensure that the list of resources includes Carl Simmons (Resource No. = 181).   If the list does not 

include this resource, add this resource to the list.  

7. For this exercise, ensure that the Job No is set to 4002 and the Job WBS Code fields is blank. 

8. Repeat Steps 1-5 for WBS code 001 under job GA.   

9. Ensure that the list of resources includes Carl Simmons (Resource No. = 181).   If the list does not 

include this resource, add this resource to the list.  

10. For this exercise, ensure that the Job No is blank and the Job WBS Code fields is blank. 

 

Accessing Timesheet Entry 

1. Login to WTE using the following user credentials 

a. Login name: pvbs\csimmons 

b. Password: password 

2. The application will open to the Timesheet tab. 

 

Creating a Timesheet Line for Indirect Time 

1. Under the Timesheet Tab click Add Timesheet. 

2. Select the Timesheet Period for November 10, 2014.   You will automatically be directed to your 

timesheet for that period.  

3. Navigate to the first timesheet line and click on the Edit icon in the Actions field. The Add/Edit 

Timesheet Line window should appear.  

4. In the Job field select GA – General and Administrative Labor Job. 
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5. Select 001 as the Job WBS code. 

6. Leave Project Management as the Job Category Code. 

7. Leave Regular as the Pay Type. 

8. Leave Destination blank and click Save.   

9. In the line created, place your cursor in the cell for November 10. Enter 8 hours and hit Tab to exit the 

cell. 

10. Click on the cell with the hours just entered and click Enter Comment. 

11. Enter a comment and click OK. 

12. Click Save on the Actions group of the Timesheet tab to save your entry.  If you were to close your 

timesheet without clicking save, the entry would not be saved. 

 

Entering Time against a Direct Job  

1. Click Add Line under the New group of Timesheet tab. The Add/Edit Timesheet Line window 

should appear.  

2. In the Job field select Job 4002. 

3. Select 001-001-01 as the Job WBS code. 

4. Leave Project Management as the Job Category Code. 

5. Leave Regular as the Pay Type. 

6. Leave Destination blank and click Save.  The timesheet line is created.  

7. In the line created, place your cursor in the cell for November 11. Enter 8 hours and hit Tab to exit the 

cell. 

8. Click on the cell with the hours just entered and click Enter Comment. 

9. Enter a comment and click OK. 

10. On each of the remaining weekdays of the period, enter 8 hours on this timesheet line.  

11. Click Save on the Actions group of the Timesheet tab to save your entry. 

12. Click Submit on the Actions group of the Timesheet tab. You will receive the following prompt. 

  

 

 

13. Click OK and the status of the timesheet will be updated from draft to submitted. 

14. Close both Internet Explorer windows to escape from WTE. 
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Approving Employee Timesheet 

1. To view the list of approvals required for a submitted timesheet open NAV and navigate to 

Departments > Project Accounting > Web > Timesheet.  Locate the timesheet you wish to open 

using the time period and the resource number.  Double click on the timesheet.  When the timesheet 

opens click on Approval in the Process group of the Home tab.  

2. Return to the WTE website and login as the first timesheet approver. 

a. Login name: pvbs\vhugo 

b. Password: password 

3. Select the Approval tab. 

4. On the left panel of the screen select the timesheet for Carl Simmons for the period starting on 

November 10. The timesheet for Carl Simmons should appear. 

5. Click Approve under the Actions group of the Approval tab.  

6. The timesheet should disappear from the list of timesheets to approve on the left panel. 

7. Close WTE. 

8. Return to the WTE website and login as the second timesheet approver. 

a. Login name: pvbs\mgibson 

b. Password: password 

9. Select the Approval tab. 

10. On the left panel of the screen select the timesheet for Carl Simmons for the period starting on 

November 10. The timesheet for Carl Simmons should appear. 

11. Click Approve under the Actions group of the Approval tab.  

12. The timesheet should disappear from the list of timesheets to approve on the left panel. 

13. Close WTE. 

14. Return to the WTE website and login as the third timesheet approver. 

a. Login name: pvbs\tclancy 

b. Password: password 

15. Select the Approve tab. 

16. On the left panel of the screen select the timesheet for Carl Simmons for the period starting on 

November 10. The timesheet for Carl Simmons should appear. 

17. Click Approve under the Actions group of the Approval tab.  

18. The timesheet should disappear from the list of timesheets to approve on the left panel. 

19. Close WTE. 
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Exercise 2: Expense Report Entry 

In this exercise you will create a new expense report and submit it for approval to your.  Once approved, 

it will be reviewed by accounts payable in NAV and an expense invoice will be generated. 

Create New Expense Report 

1. Login to WTE using the following user credentials: 

a. Login name: pvbs\csimmons 

b. Password: password 

2. The Web Time and Expense application will default to the Timesheet tab upon opening.  Click on the 

Expense tab to enter the expense module. 

3. Click Add Expense under the New group on the Expense Tab.  The Add/Edit Expense Header 

window opens. 

4. Enter November 10 as the start date.  Click on the Start Date field to bring up the calendar. 

5. Enter November 13 as the end date.  Click on the End Date field to bring up the calendar. 

6. In the Description field enter “Project Expense”. 

7. Leave the Advance field blank and click Save.  The description of the expense report should appear 

on the left panel.   

 

Enter Expense Lines 

1. To enter lines on the expense report header, select the Project Materials expense report on the left 

panel and click Add Line under the New group of the Expense tab. The Add Expense Entry window 

appears, enter the following values: 

a. Job = 4002 

b. Job WBS = 001-001-01 

c. Job Category = Materials 

d. Currency = Blank (this field is optional) 

e. Paid by = Employee 

f. Date = November 10 

g. Distance = 0 

h. Amount = 100.00 

i. Add More Lines = Unchecked 

2. Click Save to create the expense report line. 

3. Click Save under the Actions group of the expense tab to save the expense report.  

 

Enter Per Diem Rates 

1. To claim per diem for your travels on your expense report, click Per Diem on the ribbon under the 

Process group.  The Per Diem Wizard opens. 
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2. Enter the following information into the wizard: 

a. State/Country: GA. 

b. Destination: Atlanta. 

c. County: FULTON COUNTY 

3. Click Next. 

4. Enter the following information into the wizard: 

a. Start Date: 11/10/2014 (Start and End Dates should be within the date range specified on 

the expense report header) 

b. End Date: 11/13/2014 (Start and End Dates should be within the date range specified on 

the expense report header) 

c. Job = 4002 

d. WBS = 001-001-01 

e. Lodging = Lodging (this is the job category that lodging expenses will be charged too) 

f. Meals = Per Diem (this is the job category that meals will be charged too) 

5. Click Next. 

6. The next screen allows you to claim or not claim lodging, certain meals, and incidentals for each day.  

For example, if you hotel provides breakfast each morning, deselect breakfast for each day.   

7. Click Next. 

8. Enter $110.00 as the Daily Room Rate and $5.00 as the Daily Room Tax. 

9. Click Finish and the lines are created on your expense report.  It is important to note that the meals 

and incidentals for the first and last day of travel are calculated at 75%.  

10. Once complete, click Save on the ribbon under the actions tab.   

11. Click Submit on the ribbon under the actions tab.  

12. Click OK.  The status of the expense report is updated from un-submitted to submitted. 

 

Approving Employee Expense Report 

1. To view the list of approvals required for a submitted expense report open NAV and navigate to 

Departments > Project Accounting > Web > Expense.  Locate the expense report you wish to view 

and click on Approvals in the Process group of the Home tab. 

2. Return to the WTE website and login as the first expense approver. 

a. Login name: pvbs\vhugo 

b. Password: password 

3. Select the Approval tab. 

4. On the left panel of the screen select the expense report for Carl Simmons. The expense report should 

appear. 

5. Click Approve under the Actions group of the Approval tab.  

6. The expense report should disappear from the list of expense reports on the left panel. 

7. Return to the WTE website and login as the second expense approver. 

a. Login name: pvbs\mgibson 

b. Password: password 
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8. Select the Approve tab. 

9. On the left panel of the screen select the expense report for Carl Simmons. The report should appear. 

10. Click Approve under the Actions group of the Approval tab.  

11. The expense report should disappear from the list of expense reports on the left panel. 

 

Exercise 3: Expense Report Processing 

In this exercise you will review approved expense reports in NAV and create purchase invoices.  Once 

purchase invoices are created, payments can be suggested and processed to your employees. 

Creating Purchase Invoice 

 

1. Navigate to the expense report list in NAV, Departments>Project Accounting>Web >Expense 

Report. 

2. Select the expense report you wish to process.  Expense reports must be marked as Approved and the 

post status must be Not Transferred. 

3. Double click on the expense report you wish to open. 

4. Validate the expense report header and lines. 

5. Click Create Purchase Invoice.  Click Ok to create purchase invoice. 

6. The purchase invoice number should now be populated in the PO No. field. 
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Exercise 4: Web Requisition Entry  

In this exercise you will create a new requisition on the web.  The requisition will be for an item 

purchased to a job.  After the requisition is submitted, it will go through the standard approval process 

before being converted into a purchase order. 

Create New Web Requisition Worksheet 

1. Login to WTE using the following user credentials: 

a. Login name: pvbs\csimmons 

b. Password: password 

2. The Web Time and Expense application will default to the Timesheet tab upon opening.  Click on the 

Requisition tab to enter the Requisition module. 

3. Click Add Requisition under the New group on the Requisition Tab.  The Add/Edit Requisition 

Header window opens. 

4. Enter November 10 as the start date.  Click on the Start Date field to bring up the calendar. 

5. Enter November 10 as the end date.  Click on the End Date field to bring up the calendar. 

6. In the Description field enter “Project Req”. 

 

Create New Requisition Lines and Submit Requisition 

1. To enter lines on the requisition header, select the “ Project Req” requisition on the left panel and 

click Add Line under the New group of the requisition tab. The Add Requisition Entry window 

appears, enter the following values: 

a. Job = 4002 

b. Job WBS = 001-001-01 

c. Project Category = Materials 

d. Currency = Blank (this field is optional) 

e. Paid by = Employee 

f. Date = November 10 

g. Add More Lines = Unchecked 

2. Click Save to create the requisition line. 

3. Navigate to the requisition line created and enter a Quantity of 10 and a Unit Cost of $10.00 

4. Click Save under the Actions group of the requisition tab to save the requisition header.  

5. Click Submit on the ribbon, under the actions group, to submit the requisition for approval. 

 

Requisition Approval 
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1. To view the list of approvals required for a submitted requisition open NAV and navigate to 

Departments > Project Accounting > Web > Requisition.  Locate the requisition you wish to view 

and click on Approvals in the Process group of the Home tab. 

2. Return to the WTE website and login as the first requisition approver. 

a. Login name: pvbs\vhugo 

b. Password: password 

3. Select the Approve tab. 

4. On the left panel of the screen select the requisition for Carl Simmons. The requisition should appear. 

5. Click Approve under the Actions group of the Approval tab.  

6. The requisition should disappear from the list of requisitions on the left panel. 

7. Return to the WTE website and login as the second requisition approver. 

a. Login name: pvbs\mgibson 

b. Password: password 

8. Select the Approve tab. 

9. On the left panel of the screen select the requisition for Carl Simmons. The requisition should appear. 

10. Click Approve under the Actions group of the Approval tab.  

11. The requisition should disappear from the list of requisition on the left panel. 

 

Create Purchase Order from Requisition 

1. Navigate to the requisition list in NAV, Departments>Project Accounting>Web >Requisition. 

2. Select the requisition you wish to process.  Requisitions must be marked as Approved and the post 

status must be Not Transferred. 

3. Double click on the requisition report you just submitted. 

4. On all requisition lines enter MS0001 as the vendor and check the Accepted check box. 

5. Click Create Purchase Order.  Click Ok to create purchase Order. 

 

 


	Chapter 1 – Application Setup
	General Setups
	Category Group
	Category Group Resource Class
	Job Category
	Government Contractor Setup
	Report Layout
	Job Queue Category List
	Job Queue Scheduler
	Job Queue

	Resource Setups
	Timesheet Period
	Working Time Calendar
	Time Zones
	Benefit Accrual
	Benefit Plan
	Pay Type
	Payroll Integration Setup
	Resources Setup
	Resource Class
	Wage Determination Location

	Job Setups
	Contract Type
	Job Group
	Job Group Resource Class
	Job Account Group
	Job Posting
	Account Set
	Department Set
	Billing & Revenue Formulas
	Billing Pool Group
	Fee Percent
	Withholding
	Jobs Setup


	Chapter 2 – Resource Card
	Resource List
	Resource Card
	Pay Rates

	Chapter 3 – Job Card
	Job Card
	Work Breakdown Structure
	Job Task Card
	Modification Detail
	Funding Limits
	Membership
	Approval Hierarchy
	Budgeting & Forecasting
	Billing Group

	Chapter 4 – Labor Processing
	Resource Card
	Benefit Accrual
	Government Contractor Parameters
	Allowances
	Allowance Detail
	Pay Rates
	Service Contract Act (SCA)
	Job Category
	Time Journal
	Missing Time Report
	Calculate Compensated Time (Optional)
	Calculate Labor Distribution
	ADP Export Hours Only
	ADP Export Hours and Earnings
	PayChex Export
	Create Sub Cont. Invoice
	Calc. Allowance Entries
	Time Journal Errors Report

	Corrections to Labor
	Importing Timesheet Corrections and Reversing Prior Timesheets
	TM Retro Billing Adjustment

	Verification
	Time Journal Summary
	Time Journal Errors
	Missing Time
	Posting

	Labor Reports
	Labor Utilization
	Labor Analysis
	Timesheet History


	Chapter 5 – Purchasing
	Purchase Orders
	Purchase Credit Memos
	Subcontracts

	Chapter 6 – Billing
	Job Card
	Billing Group
	Billing Formula
	Invoicing
	Create, Post, and Print Invoices
	Invoice Proposals
	Invoice Printing Options
	Credit Memos


	Chapter 7 – Cost Allocation
	Account Setups
	Cost Pool Account Set
	Cost Pool Department Set
	Pool Setups

	Allocate Costs

	Chapter 8 – Revenue Recognition
	Revenue Recognition Setups
	Periodic Activities
	Calculate Revenue Accrual
	Review and Post Revenue Accrual


	Chapter 9 – Job Budgeting & Forecasting
	Add Resource
	Add Other
	Forecast Pool
	Re-Calculate Totals
	Forecasting
	Allocate Forecast
	Forecast Rate
	Billing Pool Formula & Group

	Chapter 10 – Timesheets
	Web Setup
	Additional Setup
	Benefit Accrual Setup
	Timesheet Period
	Time Zones
	Working Time Calendar
	Membership
	Approval

	Reports
	PTO Balance Report
	Leave Accrual Verification

	Per Diem Setup
	Per Diem Rate Imports
	Work Breakdown Structure

	Timesheet Entry
	Favorites
	Set Delegate
	Enter On Behalf Of
	Save/Submit
	Correction

	Approvals

	Chapter 11 – Expense Reports
	Expense Entry
	Per Diem Entry
	Favorites
	Edit Header
	Set Delegate
	Enter On Behalf Of
	Expense Report
	Expense Reports

	Approvals

	Chapter 12 – Requisitions
	Favorites
	Edit Header
	Set Delegate
	Enter On Behalf Of
	Approvals

	Appendix I – Project Reports
	Job Detail with Billing Report
	Job Revenue Summary
	Job Status Report
	Job Billing Worksheet with Roll-Up
	Summary of Hours and Amount on TM
	Labor Utilization
	Labor Analysis
	Missing Time
	Employee Roster
	Employee Timesheet
	Timesheet History
	Outstanding Purchase Order by Job
	Unbilled Analysis
	Unbilled Trend
	Job Cost Transaction Detail
	Job List
	Job Register

	Appendix II – Data Migration XML Ports
	Chart of Accounts
	Department
	Vendor
	Customer
	Check
	Item
	Item Price
	Item Purchase
	Fixed Asset
	Job Category
	Resource
	Job
	Job WBS
	Job Task
	Job Modification Detail
	Resource Labor Category Default
	Job Ledger
	Wage Determination Location
	Customer AR
	Vendor AP
	General Ledger

	Appendix III – General NAV Shortcuts
	Shortcuts
	Shortcut keys in Microsoft Dynamics NAV

	Setting Filters
	Common Date Formats

	Exercise 1: Direct Labor
	Exercise 2: Travel Expenses
	Exercise 3: Timesheet Period
	Exercise 4: Working Time Calendar
	Exercise 5: Time Zones
	Exercise 6: Payroll Integration Setup
	Exercise 7: Pay Types
	Exercise 1: Government Contractor Parameters
	Exercise 2: Web Setup
	Exercise 3: Resources Setup
	Exercise 4: Benefit Accrual
	Exercise 5: Benefit Plan
	Exercise 6: Setting up Job Categories
	Exercise 1: Create a Resource
	Exercise 2:  Setting Up Resources
	Exercise 3: Adding Labor Categories to a Job
	Exercise 4: General Labor Category
	Exercise 5: Resource pricing for a T&M project
	Exercise 6: Creating Membership Hierarchies
	Exercise 7: Service Contract Acts Job Setup
	Exercise 8: Adding Resource Cost to a Job
	Exercise 1: Labor Processing
	Exercise 2: Verification
	Exercise 3: Corrections to Labor
	Exercise 4: ADP Export
	Exercise 1: Creating a New Job (T&M Example)
	Exercise 2: Creating WBS and Task Orders
	Exercise 3: Verify Job Setups
	Exercise 4: Creating a Cost Plus Fixed Fee Job
	Exercise 5: Creating a Firm Fixed Price Job
	Exercise 6: Creating an Indirect Job
	Exercise 7: Revenue Recognition & Billing Formulas
	Exercise 8: Recognition & Billing Formulas
	Exercise 9: Setting up Fees
	Appendix 1: Posting Groups Hierarchy
	Appendix 2: Posting Group Controls
	Exercise 1: Job Budgeting
	Exercise 2: Copying Budget to G/L Budget
	Exercise 3: Indirect Job Budgeting
	Exercise 1: Purchase Orders, Receipts, and Invoicing
	Exercise 2: Subcontracts
	Exercise 1: Billing Group
	Exercise 2: Generating Multiple Invoices
	Exercise 3: Billing Pool Group
	Exercise 4: Creating and Posting an Invoice Worksheet
	Exercise 5: Create a Sales Credit Memo
	Exercise 6: Billing for FFP Jobs
	Exercise 7: Billing for CPFF or T&M Jobs
	Exercise 8: Project Accounting Reports
	Exercise 1: Cost Pool
	Exercise 2: Allocate Costs
	Exercise 1: Recognize Revenue
	Exercise 2: Estimate to Complete for FFP
	Exercise 1: Timesheet Entry
	Exercise 3: Expense Report Processing
	Exercise 4: Web Requisition Entry

